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DatalLab, Release 0.11.0

DatalLab is an open-source platform for scientific and technical data processing and visualization with unique
features designed to meet industrial requirements, extendable with Plugins and working seamlessly with your IDE or
Jupyter notebooks, ... (see our Tutorials for illustrated examples).

Datal.ab leverages the richness of the scientific Python ecosystem (NumPy, SciPy, scikit-image, OpenCV, PlotPyS-
tack,...) and Qt graphical user interfaces.
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Fig. 1: Signal and image visualization in DatalLab

With its user-friendly experience and versatile Usage modes, DatalLab enables efficient development of your data pro-
cessing and visualization applications while benefiting from an industrial-grade technological platform.

Poweredty ({Rj) PlotPyStack

Fig. 2: DatalLab is powered by PlotPyStack, the scientific Python-Qt visualization and graphical user interface stack.
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CHAPTER
ONE

GETTING STARTED

Datal.ab is an open platform for signal and image processing. Its functional scope is intentionally broad. With its
many functions, some of them technically advanced, Datalab enables the processing and visualization of all types of
scientific data. As a result, scientific, industrial, and innovation stakeholders can have access to an easy-to-use tool that
is simple to adapt and offers the reliability of industrial-grade software.

1.1 Installation

1.1.1 How to install

Datalab is available in several forms:
* As a Python package, which can be installed using the Package manager pip.

* Windows As a stand-alone application, which does not require any Python distribution to be installed. Just run
the All-in-one installer and you’re good to go!

* As aprecompiled Wheel package, which can be installed using pip.
* As a Source package, which can be installed using pip or manually.
See also:

Impatient to try the next version of DatalLab? You can also install the latest development version of DatalLab from the
master branch of the Git repository. See Development version for more information.

Package manager pip

GNU/Linux Windows macOS

Datalab’s package cdl is available on the Python Package Index (PyPI) on the following URL: https://pypi.python.
org/pypi/cdl.

Installing DatalLab from PyPI is as simple as running this command:

[$ pip install cdl

Note: If you already have a previous version of Datalab installed, you can upgrade it by running the same command
with the --upgrade option:

[$ pip install --upgrade cdl ]



https://pypi.python.org/pypi/cdl
https://pypi.python.org/pypi/cdl
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All-in-one installer

Windows

DatalLab is available as a stand-alone application for Windows, which does not require any Python distribution to be
installed. Just run the installer and you’re good to go!
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Fig. 1: Datalab all-in-one installer for Windows

The installer package is available in the Releases section. It supports automatic uninstall and upgrade feature (no need
to uninstall DatalLab before runinng the installer of another version of the application).

Warning: Datal.ab Windows installer is available for Windows 8, 10 and 11 (main release, based on Python 3.11)
and also for Windows 7 SP1 (Python 3.8 based release, see file ending with -Win7.exe).

On Windows 7 SP1, before running DatalLab (or any other Python 3 application), you must install Microsoft Update
KB2533623 (Windows6.1-KB2533623-x64.msu) and also may need to install Microsoft Visual C++ 2015-2022
Redistribuable package.

Wheel package

GNU/Linux Windows macOS

On any operating system, using pip and the Wheel package is the easiest way to install DatalLab on an existing Python
distribution:

[$ pip install --upgrade Datalab-0.11.1-py2.py3-none-any.whl J

Source package

GNU/Linux Windows macOS

Installing DatalLab directly from the source package may be done using pip:

[$ pip install --upgrade cdl-0.11.1.tar.gz ]

Or, if you prefer, you can install it manually by running the following command from the root directory of the source
package:

[$ pip install --upgrade . ]
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Finally, you can also build your own Wheel package and install it using pip, by running the following command from
the root directory of the source package (this requires the build and wheel packages to be installed):

$ pip install build wheel # Install build and wheel packages (if needed)
$ python -m build # Build the wheel package
$ pip install --upgrade dist/cdl-0.11.1-py2.py3-none-any.whl # Install the wheel package

Development version

GNU/Linux Windows macOS

If you want to try the latest development version of Datalab, you can install it directly from the master branch of the
Git repository.

The first time you install DatalLab from the Git repository, enter the following command:

[$ pip install git+https://github.com/Codra-Ingenierie-Informatique/Datalab.git J

Then, if at some point you want to upgrade to the latest version of Datal.ab, just run the same command with options
to force the reinstall of the package without handling dependencies (because it would reinstall all dependencies):

$ pip install --force-reinstall --no-deps git+https://github.com/Codra-Ingenierie-
. Informatique/Datalab.git

Note: If dependencies have changed, you may need to execute the same command as above, but without the --no-deps
option.

1.1.2 Dependencies

Note: The Datalab all-in-one installer already include all those required libraries as well as Python itself.

The cd1 package requires the following Python modules:

Name Version ~ Summary
Python >=3.8, <4

h5py >=3.0

NumPy >=1.21

SciPy >=1.7

scikit-image >=0.18
opencv-python-headless >=4.5

PyWavelets >=1.1

psutil >=5.5

guidata >=3.2

PlotPy >=2.0

QtPy >=1.9

PyQt5 >=5.11 Python bindings for the Qt cross platform application toolkit

Optional modules for development:

1.1. Installation 5
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Name Version Summary

black The uncompromising code formatter.

isort A Python utility / library to sort Python imports.
pylint python code static checker

Coverage Code coverage measurement for Python

pyinstaller >=6.0

PylInstaller bundles a Python application and all its dependencies into a single package.

Optional modules for building the documentation:

Name Ver- Summary

sion
PyQt5 Python bindings for the Qt cross platform application toolkit
sphinx Python documentation generator

sphinx_intl
myst_parser
sphinx_design

pydata-sphinx-
theme

Sphinx utility that make it easy to translate and to apply translation.

An extended [CommonMark](https://spec.commonmark.org/) compliant parser,
A sphinx extension for designing beautiful, view size responsive web compo-
nents.

Bootstrap-based Sphinx theme from the PyData community

Note: Python 3.11 and PyQt5 are the reference for production release

1.2 Use cases, main features and key strengths

Datal ab is a platform for data processing and visualization (signals or images) that includes many functions. Developed
in Python, it benefits from the richness of the associated ecosystem in terms of scientific and technical libraries.

1.2.1 What are the applications for Datalab?

Real world examples

A few concrete and specific examples illustrate the nature of the work that can be carried out with Datal.ab:

* Processing of experimental signals acquired on a scientific facility

* Automatic detection laser spot positions in a scene

* Instrument alignment through image processing

* Automatic pattern detection and geometric corrections

Chapter 1. Getting started
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Usage modes

Depending on the application, DatalLab can be used in three different modes:

 Stand-alone mode: Datal.ab is a full-fledged processing application that can be adapted to the client’s needs
through the addition of industry-specific plugins.

* Embedded mode: Datal.ab is integrated into your application to provide the necessary processing and visual-
ization features.

* Remote-controlled mode: Datal.ab communicates with your application, allowing it to benefit from its func-
tionality without disrupting the user experience.

Use cases

See also:
For practical examples of use cases, see the Tuforials section.
Datalab is a versatile tool that can be used in different contexts:

* Data processing: Datalab is a powerful tool for processing signals and images. It can be used to develop
complex algorithms, or to quickly prototype a processing chain.

* Companion tool for scientific/technical work: Datal.ab can be used as a companion tool for scientific/technical
work. It allows you to visualize and process data, and to share your results with your colleagues. It can easily
be adapted to your needs through the addition of plugins, and it may even be used together with your every day
tools (e.g., Visual Studio Code, Spyder, ... or Jupyter notebooks).

* Prototyping a data processing application: Datal.ab can be used to quickly prototype a data processing appli-
cation. It can then be used as a basis for the development of a full-fledged application.

* Debugging a data processing application: Datal.ab can be used as an advanced debugging tool for your data
processing applications, independently from the development environment or the language used (Python, C#,
C++, ...). All you need is to be able to communicate with DatalLab via its remote control interface (standard
XML-RPC protocol). This allows you to send data to Datalab (signals, images or even geometric shapes),
visualize the data at each step of the processing chain, manipulate them to better understand the behavior of your
algorithms, and even modify them to test the robustness of your code.

Note: DatalLab can also be controlled from your familiar development environment (e.g., Visual Studio Code, Spyder,
...) or from a Jupyter notebook, in order to perform calculations using your processing functions while leveraging the
advanced features of Datalab.

With its user-friendly experience and versatile usage modes, DatalLab enables efficient development of your data pro-
cessing and visualization applications while benefiting from an industrial-grade technological platform.

1.2.2 Main features

The main technical features of DatalLab include:
* Support for numerous standard and proprietary data formats

* Opening an arbitrary number of objects (signals or images) for batch processing, with the possibility of defining
groups of objects

 Simultaneous viewing of multiple objects with annotation support

* Standard operations and processing on signals and images

1.2. Use cases, main features and key strengths 7
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* Advanced image processing (restoration, morphology, edge detection, etc.)
* Management of multiple regions of interest (calculations, extractions)
* Macro-command editor

¢ Remote-controllable API

Embedded interactive Python console

1.2.3 Key strengths

DatalLab highlights four key strengths:

1. Extensibility: The DatalLab plugin system makes it easy to code new features (specific processing, specific file
formats, custom graphical interfaces). It can also be used as a customizable platform.

2. Interoperability: DatalLab can also be embedded in your own application. For example, within data processing
software, machine-level control systems, or test bench applications.

3. Automation: a high-level public API allows for full remote control of DatalLab to open and process data.

4. Maintainability and testability: Datal.ab is an industrial-grade scientific and technical processing software.
The built-in automated tests in DataLLab cover 90% of its features, which is significant for software with graphical
interfaces and helps mitigate regression risks.

Researchers, engineers, scientists, you will undoubtedly benefit from the capabilities of Datalab. Its open-source
software model will also allow you to reinvest your achievements in the open-source community, of which any reputable
publisher should be an active member.

1.3 Key features

This page presents briefly DataLLab key features.

1.3.1 Data visualization

Signal Image Feature

v Screenshots (save, copy)
Lin/log scales

Data table editing

Statistics on user-defined ROI
Markers

Aspect ratio (1:1, custom)
50+ available colormaps

X/Y raw/averaged profiles
Annotations

Persistance of settings in workspace
Distribute images on a grid

ENENENENEN
N
ol
=

N
&N < BN < BN < BN <
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‘ £, Datalab® - O X
Eile Edit Operations Processing Computing Plugins View 7
DR e s BEHESSQE®mnB®E-bx 7 R0
Image panel g x @ signals & 1mages
v 2 g0t
B8 i001: Test image with peaks

B i002: roberts(i001)
@ i003: extract_single_roi(i002)px=102:410,y=127:385

in /Pixel spacing ~ Titles /Units ~ Computing parame * P

DatalLab

@ floatss

100

_5
Light mode

= Metallt

=---Dark mode

Plugins: 1 XML-RPC: 1312 Memory: 6478

Curve panel Image panel Macro manager

Fig. 2: Datalab supports dark and light mode depending on your platform settings (this is handled by the guidata
package, and may be overridden by setting the QT_COLOR_MODE environment variable to dark or light).
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1.3.2 Data processing

Signal Image Feature

Process isolation for running computations
Remote control from Jupyter, Spyder or any IDE
Remote control from a third-party application
Sum, average, difference, product, ...

ROI extraction, Swap X/Y axes
Semi-automatic multi-peak detection
Convolution

Flat-field correction

Rotation (flip, rotate), resize, ...

Intensity profiles (line, average, radial)

Pixel binning

Normalize, derivative, integral

Linear calibration

Thresholding, clipping

Gaussian filter, Wiener filter

Moving average, moving median

FFT, inverse FFT

Interpolation, resampling

Detrending

Interactive fit: Gauss, Lorenzt, Voigt, polynomial
Interactive multigaussian fit

Butterworth filter

Exposure correction (gamma, log, ...)
Restauration (Total Variation, Bilateral, ...)
Morphology (erosion, dilation, ...)

Edges detection (Roberts, Sobel, ...)
Computing on custom ROI

FWHM, FW @ 1/e?

Centroid (robust method w/r noise)
Minimum enclosing circle center

2D peak detection

Contour detection

Circle Hough transform

Blob detection (OpenCV, Laplacian of Gaussian, ...)

BN < BN < BN < I
BN < BN <

N < BN <BN BN < BN <

B < BN < BN < BN BN <

\
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1.4 Tutorials

1.4.1 Video Tutorials

DatalLab video tutorials intend to provide a complementary material to the documentation and other tutorials available
here.
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Quick demo

In this first video, we will quickly go through the main features of DatalLab, and show how to do some basic signal and
image processing.

Warning: This video is intentionally short and does not cover all the features of DatalLab. It is meant to give you
a quick overview of the software. For a more detailed description of the features, please watch the other videos or
read the documentation.

1.4. Tutorials 11


https://www.youtube.com/watch?v=MBMes_MlQQ4

DatalLab, Release 0.11.0

Add your own features

In this tutorial, we will show how to add your own features to DatalLab using three different approaches:
1. Macro-commands, using the integrated macro manager
2. Remote control of DatalLab from an external IDE (e.g. Spyder) or a Jupyter notebook
3. Plugins

The first common point between these three approaches is that they all rely on DatalLab’s high-level API, which al-
low to interact with almost every aspect of the software. This API is here accessed using Python scripts, but it may
also be accessed using any other language when using the remote control approach (because it relies on a standard
communication protocol, XML-RPC).

The second common point is that they all use Python code, and compatible proxy objects, so that the same code can be
at least partially reused in the three approaches.

12 Chapter 1. Getting started
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1.4.2 Other Tutorials

The following tutorials are detailed step-by-step guides to perform specific tasks with Datal.ab, or to illustrate features
of the software in the context of a scientific or technical problem. Each tutorial focuses on a specific aspect of the
software and is intended to be self-contained.

Processing a spectrum

This example shows how to process a spectrum with Datalab:
* Read the spectrum from a file
* Apply a filter to the spectrum
 Extract a region of interest
* Fit a model to the spectrum
* Save the workspace to a file

First, we open DatalLab and read the spectrum from a file.

£, Datalab = O >
File Edit Operations Processing Computing  Plugins  View 7

[ New signal... Ctrl+ N % = O

[ =

¥ FTOOROD

& X [ signals B3 Images

Open signal... Ctrl+0Q

m  Savesignal.. Ctrl+5

=  Open HDF5 files...
Save to HDF3 file...
Browse HDF5 file...

Drag files here to open

L E

Settings...

X Cuit Properties

Fig. 3: Open the spectrum file with “File > Open...” , or with the button in the toolbar, or by dragging and dropping
the file into DatalLab (on the panel on the right).

Here, we are actually generating the signal from a test data file (using “Plugins > Test data > Load spectrum of parac-
etamol”), but the principle is the same.

L, Datalab = O X

File Edit Operations Processing Computing  Plugins  View 7

= '-:I a T @ 7 % < Test data  * Add noise to signal "™ ™ = @
Curve panel Load spectrum of paracetamol
Create noisy signal |
1000 ¥ sig ‘
S ] | | |

Fig. 4: Using the “Test data” plugin is a convenient way to generate test data for tutorials, but it is not necessary to use
it in real life. You can use any file containing a spectrum, such as a spectrum from a real experiment.
The spectrum is displayed in the main window.

Now, let’s process this spectrum by applying a filter to it. We will use a Wiener filter, which is a filter that can be used
to remove noise from a signal, even if this is not absolutely necessary in this case.

1.4. Tutorials 13
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£ Datalab* = O k4

ey n SS00Qt®nmkkik 6o n0d

Curve panel g x @ signals B Images
N curve_formats\paracetamol.txt v 2 g0t
[ s001: curve_formats\paracetamol.bxt

7 — curve_formats'paracetamol. txt

00

H | Properties
=

3_.‘.500 n Data and metadata ~ Titlesand units ~ Compu ;P :
§

3

= Data
L ] ﬂ |

400 — | 1 999x2 W floatsd i

ket ] H ‘ ||‘ || | ‘ ||I‘ | 1 s5.000, 55.981
i | ' T 54900, 997.449
2 =L WU TR
tt : e NI et ‘\_J 'U Mr | | al Metadata
W
= 1::1I 30 40*’]”50"‘”
] Wave Numbers (cm-1) m_éshow results «# Apply
Curve panel Image panel Macro manager

& Plugins: 1 oo XML-RPC: 50554 =8 Memory: 64%

Fig. 5: The spectrum is a 1D signal, so it is displayed as a curve. The horizontal axis is the energy axis, and the vertical
axis is the intensity axis.

€, Datalab® — m] X 1

File Edit Operations Processing Computing  Plugins  View 7

”Q@ Mormalize Eooqlfﬁ_;ﬁ:[ﬁo—*—bﬂ _’Fl:pl* ‘()ﬁ

Derivative
Curve panel g X [ signals B Images |
Integral s |
v 001:
5 Thresholding racetamol.txt g
. @ s001: curve formats\paracetamol txt
[ q Clipping curve_formatsiparacetamol. bt

Linear calibration

AY 800 — Gaussian filter
@ 7 Moving average
. : Moving median Properties
=
};‘_600 = Wiener filter i Data and metadata ~ Tilesand units ~ Compu 4 ;P :
E | FFT
" £ | Inwerse FFT Data
400 Interpolation : || 1 0992 & foats4 L
: 7 Resamplin |
+id ] piing 4 s5.000, 55.981
Detrending | |
g . | ! T 54900, 997.449
200 — Fitting r | |
1. AU

Fig. 6: Open the filter window with “Processing > Wiener filter”.
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& Datalab* = O >

File Edit Operations Processing Computing  Plugins  View 7
FRAe ¢ BFPEASS00QtahBi-bk FOo0R0OH
& %X [@signals B Images

v 2 gD0t:
[ s001: curve_formats\paracetamol.bxt
@ s002: wiener(s001)

Curve panel

wiener(s001)

T wiener(s001)

&7

=Y
Properties
b ;
..................... Dataandmetadats | Tifesandunits | Compu 4 [P
Data
L
15 g9gx2 W floated o,
b4 1 s5.000, 45,813
=] T 54900, 933.49%6
B | Metadata
= 0 A SO O W S A .
g 10 0 0 40 50 [ 1show results < Apply
Curve panel Image panel Macro manager

& Plugins: 1 oo XML-RPC: 50554 B8 Memory: 64%

Fig. 7: The result of the filter is displayed in the main window.
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If we want to analyze a specific region of the spectrum, we can extract it from the spectrum using the “ROI extraction”
feature from the “Operations” menu.

L, Datalab® = O ®
File Edit Operations Processing Computing  Plugins  View 7
T3 <> <> = _ - —
= SS00L T ®Dm[[b Kk 3 L JIOX)
Average
Curve panel ) ? g x @ signals B Images
Difference =
v E gl0n:
b Quadratic difference ener(s[l[]l) g
Prod [0 =001: curve_formats'\paracetamol.bxt
[ . i it ;
:@ o wiener(s001) @ =002: wiener(s001)
Division
v 300 Absolute value
&) Real part
| ; Froperties I
Ee 3 maginary part |
500 Data and metadata ~ Tilesand units ~ Compu ¥ ;P
Convert data type
Log10(y) Bala
-] =
400 15 g99x2 W floates L

h-lr[ Peak detection
" 4 5.000, 45.813

Convolution
1 54.900, 983.496

&0

200 ¥ RO extraction

(3 Swap X/Y axes { el Metadats

Fig. 8: Open the ROI extraction window with “Operations > ROI extraction”.
Let’s try to fit a model to the spectrum. We will use a Gaussian model, which is a model that can be used to fit a peak
in a spectrum.
To demonstrate another processing feature, we can also try to detrend the spectrum.

When analyzing a spectrum, it can be useful to try to identify the peaks in the spectrum. We can do this by fitting a
multi-Gaussian model to the spectrum, using the “Processing > Fitting > Multi-Gaussian fit” feature.

We also could have used the “Peak detection” feature from the “Operations” menu to detect the peaks in the spectrum.

Finally, we can save the workspace to a file. The workspace contains all the signals that were loaded in Datalab, as
well as the processing results. It also contains the visualization settings (curve colors, etc.).

If you want to load the workspace again, you can use the “File > Open HDFS5 file...” (or the button in the toolbar) to
load the whole workspace, or the “File > Browse HDFS5 file...” (or the button in the toolbar) to load only a selection
of data sets from the workspace.

Detecting blobs on an image
This example shows how to detect blobs on an image with DatalLab, and also covers other features such as the plugin
system:

* Add a new plugin to DatalLab

* Denoise an image

* Detect blobs on an image

» Save the workspace to a file
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a Regions of interest - wiener(s001) - Datalab
|

- ROIOO: 35.540330153321975 = ¥ = 41.34403168654173

|

[

‘ - Regions of interest
BUU _.- .............................. 3

| 500

| 400

200

4 add region of interest [] Extract all regions of interest into a single signal object

0K Cancel

Fig. 9: The “Regions of interest” dialog box is displayed. Click on “Add region of interest” and resize the horizontal

window to select the area. Then, click on “OK”.

1.4. Tutorials
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& Datalab* = O >
File Edit Operations Processing Computing  Plugins  View 7
= o= = o o -
FEHe & BPRPEASS00tTahii bk FOOROD
Curve panel g x| [ signals B tmages
v 2 gD0t:
% 00 4 [ s001: curve_formats\paracetamol.bxt
aF @ s002: wiener(sD01)
 3mp J @ s003: extract_single_roi(s002)|indexes=611:727
Q, i
- 300 Properti
b roperties
= ]
] Data and metadata  Tiles andunits ~ Compu 4 ;P :
250 —
]
i Data
= 0]
] i 117x2 @ floates o,
b ] + 35,550, 62,016
| T 41350, 403.315
[®) . R
B 100 | Metadata
=
¥ [ 1show results <7 Apply
Curve panel Image panel Macro manager
& Plugins: 1 oo XML-RPC: 50554 #8 Memory: 66%

Fig. 10: The region of interest is displayed in the main window.
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Plugins  View 7

L, Datalab®
File Edit Operations Processing Computing
= ﬁ Q ) Mormalize
Derivative
Curve panel
Integral
% ext Threshelding
400 —
'@: ] Clipping
o ] Linear calibration
350 — . .
% ] Gaussian filter
® ] Maving average
500 7 Mowving median
- 7 Wiener filter
250
] FFT
q - Inverse FFT
200 Interpolation
b4 E Resampling
150 — Detrending
= 1 Fitting »
. ] TR il
B w0 o
B N S -
Ih.l 4
= —— T
¥ 30 37 33
Curve panel Image panel Macro manager

Gaussian fit
Lorentzian fit
Voigt fit
Polynomial fit

Multi-Gaussian fit

F OO0 0L f &

lindexes=611:727

nale_roi(s002) indexes=611:727

= a X

b FrE FOOROD
ESignaIs
v 2 gD0t:

[ s001: curve_formats\paracetamol.bxt

[ =002: wiener(s0D1)

E s003: extract_single_roi(s002)|indexes=611:727

g x & Images

Properties |
Data and metadata ~ Titlesandunits ~ Compu ;P : |
Data
5 117x2 @ floatss o)
4 35,550, 62,016
T 41350, 903,315
| Metadata
r 8
1 EU |Show results < apply

& Plugins: 1 oo XML-RPC: 50554 #8 Memory: 66%

Fig. 11: Open the model fitting window with “Processing > Fitting > Gaussian fit”.
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%, Gaussian fit = O x

IE;EEJE».@\...L,H:@}{ﬁ:ﬁSJ [ = |

| 400
Data
350 _
s Rk
300
| 250
200
| 150
| 100 Ty ;
: T T T T T T T T T T T T T T T T T T T T T T T T T T T T T
36 37 338 39 40 41
Automatic fit Fit parameters
< Run Amplitude 173,334 I &
Std-dev (o) 0.230 I &k
i Settings
. Mean (n)  38.402 I o
#24Bounds Baseline  53.134 I £
1

r

Fig. 12: The “Gaussian fit” dialog box is displayed. An automatic fit is performed by default. Click on “OK” (or
eventually try to fit the model manually by adjusting the parameters or the sliders, or try to change the automatic fitting
parameters).
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Fig. 13: The result of the fit is displayed in the main window. Here we selected both the spectrum and the fit in the
“Signals” panel on the right, so both are displayed in the visualization panel on the left.
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Fig. 14: We may also select the full spectrum and the fit in the “Signals” panel on the right, so that both are displayed
in the visualization panel on the left, if this has a sense for the analysis we want to perform. Note that the full spectrum
visualization also contains the region of interest we extracted previously.
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Fig. 15: Execute the “Processing > Detrending” feature.
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Fig. 16: We choose a linear detrending method, and we click on “OK”.
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Fig. 17: The result of the detrending is displayed in the main window (in that specific case, the detrending may not be
appropriate, but it is just to demonstrate the feature).
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Fig. 18: First, a “Signal peak detection” dialog box is displayed. We can adjust the the vertical cursor position to select
the threshold for the peak detection, as well as the minimum distance between two peaks. Then, we click on “OK”.
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Fig. 19: The “Multi-Gaussian fit” dialog box is displayed. An automatic fit is performed by default. Click on “OK”
(or eventually try to fit the model manually by adjusting the parameters or the sliders, or try to change the automatic

fitting parameters).
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Fig. 20: The result of the fit is displayed in the main window. Here we selected both the spectrum and the fit in the
“Signals” panel on the right, so both are displayed in the visualization panel on the left.
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Fig. 21: Open the “Peak detection” window with “Operations > Peak detection”.
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Fig. 22: After having adjusted the parameters of the peak detection dialog (same dialog as the one used for the multi-
Gaussian fit), click on “OK”. Then, we select the “peak_detection” and the original spectrum in the “Signals” panel
on the right, so that both are displayed in the visualization panel on the left.
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Fig. 23: Save the workspace to a file with “File > Save to HDFS file...”, or the button in the toolbar.
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Fig. 24: In the “General” tab, we can see the “Plugins path” field. This is the path where DatalLab will look for plugins.
We can add a new plugin by copying/pasting the plugin file in this directory.
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First, we open DatalLab, and open the settings dialog (using “File > Settings...”, or the icon in the toolbar).
See also:
The plugin system is described in the Plugins section.

Let’s add the cdl_example_imageproc.py plugin to DatalLab (this is an example plugin that is shipped with Datal.ab
source package, or may be downloaded from here on GitHub).

If we close and reopen DatalLab, we can see that the plugin is now available in the “Plugins” menu: there is a new
“Extract blobs (example)” entry.

% About Datalab x

Datalab v0.11.0
Datalab is a generic signal and image processing platform

Created by Pierre Raybaut
Developed and maintained by Datalab open-source project team
Copyright © 2023 Codra

Advanced configuration:
» AML-RPC server: started (port 33730)
* Process izolation: enabled

Registered plugins:

[ = Extract blobs (example) (1.0.0): This is an example plugin
= Test data (1.0.0): Testing Datalab functionalities

Fig. 25: The “About DatalLab” dialog shows the list of available plugins.
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Fig. 26: Let’s click on “Extract blobs (example) > Generate test image”

For information, the image is generated by the plugin using the following code:

def generate_test_image(self) -> None:
"""Generate test image
# Create a NumPy array:
arr = np.random.normal (10000, 1000, (2048, 2048))
for _ in range(10):
row = np.random.randint(0, arr.shape[0])
col = np.random.randint(®, arr.shape[1])
rr, cc = skimage.draw.disk((row, col), 40, shape=arr.shape)
arr[rr, cc] -= np.random.randint (5000, 6000)
icenter = arr.shape[0] // 2

mirn

(continues on next page)
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(continued from previous page)

rr, cc = skimage.draw.disk((icenter, icenter), 200, shape=arr.shape)
arr[rr, cc] -= np.random.randint (5000, 8000)
data = np.clip(arr, 0, 65535).astype(np.uint16)

# Create a new image object and add it to the image panel
image = cdl.obj.create_image("Test image", data, units=C"mm", "mm", "1lsb"))
self.proxy.add_object(image)
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Fig. 27: The plugin has generated a test image, and added it to the “Images” panel. The image shows a few blobs, with
a central dark disk, and a noisy background.

The plugin has other features, such as denoising the image, and detecting blobs on the image, but we won’t cover them
here: we will use the same Datal.ab native features as the plugin, manually.

The image is a bit noisy, and also quite large. Let’s reduce the size of the image while denoising it a bit by binning the
image by a factor of 2.

Let’s apply a moving median filter to the image, to denoise it a bit more.
Now, let’s detect the blobs on the image.

Finally, we can save the workspace to a file. The workspace contains all the images that were loaded in Datal.ab, as
well as the processing results. It also contains the visualization settings (colormaps, contrast, etc.), the metadata, and
the annotations. To save the workspace, click on “File > Save to HDFS5 file...”, or the button in the toolbar.

If you want to load the workspace again, you can use the “File > Open HDFS5 file...” (or the button in the toolbar) to
load the whole workspace, or the “File > Browse HDFS file...” (or the button in the toolbar) to load only a selection
of data sets from the workspace.
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Fig. 28: Click on “Operations > Pixel binning”.
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Fig. 29: The “Binning” dialog opens. Set the binning factor to 2, and click on “OK”.
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Fig. 30: The binned image is added to the “Images” panel. It is now easier to see the blobs (even if they were already
quite visible on the original image: this is just an example), and the image will be faster to process.
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Fig. 32: The filtered image is added to the “Images” panel. Denoising is quite efficient.
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Fig. 34: The “Blob detection (OpenCV)” dialog opens. Set the parameters as shown on the screenshot, and click on

“OK”.
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Fig. 33: Click on “Computing > Blob detection > Blob detection (OpenCV)”.
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Fig. 35: The “Results” dialog opens, showing the detected blobs: one line per blob, with the blob coordinates and

radius.
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Fig. 36: The detected blobs are also added to the image metadata, and can be seen in the visualization panel on the left.
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Measuring Fabry-Perot fringes

This example shows how to measure Fabry-Perot fringes using the image processing features of DatalLab:
* Load an image of a Fabry-Perot interferometer
* Define a circular region of interest (ROI) around the central fringe
* Detect contours in the ROI and fit them to circles
* Show the radius of the circles
* Annotate the image
* Copy/paste the ROI to another image
 Extract the intensity profile along the X axis
» Save the workspace

First, we open DatalLab and load the images:
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-
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Settings... B r
....... L 500

R Quit

Fig. 37: Open the image files with “File > Open...”, or with the button in the toolbar, or by dragging and dropping the
files into DatalLab (on the panel on the right).
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dac D flower.npy 09/11/2023 18:03 Fichier NPY 257 Ko
icons
lego
> tests
Nom du fichier: |"fabr}r-perot2.jpg" "fabry-perotl,jpg" v| All supported files (".bmp *.jpg ~

Fig. 38: Select the test images “fabry_perotl.jpg” and “fabry_perot2.jpg” and click “Open”.

The selected image is displayed in the main window. We can zoom in and out by pressing the right mouse button and
dragging the mouse up and down. We can also pan the image by pressing the middle mouse button and dragging the
mouse.
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Fig. 39: Zoom in and out with the right mouse button. Pan the image with the middle mouse button.
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Note: When working on application-specific images (e.g. X-ray radiography images, or optical microscopy images),
it is often useful to change the colormap to a grayscale colormap. If you see a different image colormap than the one
shown in the figure, you can change it by selecting the image in the visualization panel, and the selecting the colormap
in the vertical toolbar on the left of the visualization panel.

Or, even better, you can change the default colormap in the Datalab settings by selecting “Edit > Settings...” in the
menu, or the button in the toolbar.
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Fig. 40: Select the “Visualization” tab, and select the “gray” colormap.

Then, let’s define a circular region of interest (ROI) around the central fringe.

Now, let’s detect the contours in the ROI and fit them to circles.

Note: If you want to show the results again, click on the “Show results” button, below the image list:

s Show results < apply

Show results obtained from previous computation

& Pluginz T &8 XML-RPC 50550 M Memony: 665

The images (or signals) can also be displayed in a separate window, by clicking on the “View in a new window” entry
in the “View” menu (or the button in the toolbar). This is useful to compare side by side images or signals.

If you want to take a closer look at the metadata, you can open the “Metadata” dialog.
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Fig. 41: Select the “Edit regions of interest” tool in the “Computing” menu.
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Fig. 42: The “Regions of interest” dialog opens. Click “Add region of interest” and select a circular ROI. Resize the
predefined ROI by dragging the handles. Note that you may change the ROI radius while keeping its center fixed by
pressing the “Ctrl” key. Click “OK” to close the dialog.
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Fig. 43: Another dialog box opens, and asks you to confirm the ROI parameters. Click “OK”.
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Fig. 44: The ROl is displayed on the image: masked pixels are grayed out, and the ROI boundary is displayed in blue
(note that, internally, the ROI is defined by a binary mask, i.e. image data is represented as a NumPy masked array).
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Fig. 45: Select the “Contour detection” tool in the “Computing” menu.
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Fig. 46: The “Contour” parameters dialog opens. Select the shape “Circle” and click “OK”.
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Fig. 47: The “Results” dialog opens, and displays the fitted circle parameters. Click “OK”.
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Fig. 48: The fitted circles are displayed on the image.
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Fig. 49: The image is displayed in a separate window. The ROI and the fitted circles are also displayed. Annotations
can be added to the image by clicking on the buttons at the bottom of the window. The annotations are stored in the
metadata of the image, and together with the image data when the workspace is saved. Click on “OK” to close the
window.
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Fig. 50: The image is displayed in the main window, together with the annotations.
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Fig. 51: The “Metadata” button is located below the image list.

1.4. Tutorials 41



DatalLab, Release 0.11.0

& Dictionary (11 elements) = O >
I =
Key Type Size Value
__format str 1 %.1f
__showlabel bool 1 False
{
_ann_ str 1
"LabelItem @@81": {
q a. 599.14366368 554.7T3589723 463..
_cir_contour_shape floatsd (2, 4) [E o
_roi_ int32 (WY [[ 141 559 1859 559]1]
alpha float 1 1.8
alpha_function int 1 8
colormap str 1 gray '
. ([ e. 806.43982016]
contour_shapeDiameter fleoatsd (2, 2) [ o, 734 6976628711
contour_shapeParam str 1 DS TR i
Relative threshold: 8.5
interpolation int 1 8

Save and Close

Fig. 52: The “Metadata” dialog opens. Among other information, it displays the annotations (in a JSON format), some
style information (e.g. the colormap), and the ROIL.
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Now, let’s delete the image metadata (including the annotations) to clean up the image.
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Fig. 53: Select the “Delete metadata” entry in the “Edit” menu, or the button in the toolbar.

L, Delete metadata X

Some selected ohjects have regions of interest.
. Do you want to delete them as well?

Yes Mo Cancel

Fig. 54: The “Delete metadata” dialog opens. Click “No” to keep the ROI and delete the rest of the metadata.
If we want to define the exact same ROI on the second image, we can copy/paste the ROI from the first image to the
second image, using the metadata.
To extract the intensity profile along the X axis, we have two options:

« Either select the “Line profile extraction...” entry in the “Operations > Intensity profiles” menu.

* Or activate the “Cross section” tool ﬁ in the vertical toolbar on the left of the visualization panel.

Let’s try the first option, by selecting the “Line profile extraction...” entry : that is the most straightforward way to
extract a profile from an image, and it corresponds to the compute_profile method of Datal.ab’s API (so it can be
used in a script, a plugin or a macro).

If you want to do some measurements on the profile, or add annotations, you can open the signal in a separate window,
by clicking on the “View in a new window” entry in the “View” menu (or the button in the toolbar).

Now, let’s try the second option for extracting the intensity profile along the X axis, by activating the “Cross section”

tool ﬁg in the vertical toolbar on the left of the visualization panel (this tool is a PlotPy feature). Before being able
to use it, we need to select the image in the visualization panel (otherwise the tool is grayed out). Then, we can click
on the image to display the intensity profile along the X axis. DataLab integrates a modified version of this tool, that
allows to transfer the profile to the “Signals” panel for further processing.

Then, click on the “Process signal” button in the toolbar near the profile to transfer the profile to the “Signals” panel.
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Fig. 55: Select the “Copy metadata” entry in the “Edit” menu, or the button in the toolbar.
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the button in the toolbar.
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Select the second image in the “Images” panel, then select the “Paste metadata” entry in the “Edit” menu, or
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Fig. 57: The ROl is added to the second image.
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Fig. 58: Select the “Contour detection” tool in the “Computing” menu, with the same parameters as before (shape
“Circle”). On this image, there are two fringes, so four circles are fitted. The “Results” dialog opens, and displays the
fitted circle parameters. Click “OK”.
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Fig. 59: The fitted circles are displayed on the image.
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Fig. 60: Select the “Line profile extraction...” entry in the “Operations” menu.
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Fig. 61: The “Profile” dialog opens. Enter the row of the horizontal profile (or the column of the vertical profile) in the
dialog box that opens. Click “OK”.
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Fig. 62: The intensity profile is added to the “Signals” panel, and Datal.ab switches to this panel to display the profile.
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Fig. 63: The signal is displayed in a separate window. Here, we added vertical cursors and a very interesting text label.
As for the images, the annotations are stored in the metadata of the signal, and together with the signal data when the
workspace is saved. Click on “OK” to close the window.

Finally, we can save the workspace to a file. The workspace contains all the images and signals that were loaded or
processed in DatalLab. It also contains the computing results, the visualization settings (colormaps, contrast, etc.), the
metadata, and the annotations.

If you want to load the workspace again, you can use the “File > Open HDFS5 file...” (or the button in the toolbar) to
load the whole workspace, or the “File > Browse HDFS file...” (or the button in the toolbar) to load only a selection
of data sets from the workspace.

Prototyping a custom processing pipeline

This example shows how to prototype a custom image processing pipeline using Datal.ab:
* Define a custom processing function
* Create a macro-command to apply the function to an image
 Use the same code from an external IDE (e.g. Spyder) or a Jupyter notebook

¢ Create a plugin to integrate the function in the DatalLab GUI
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Fig. 64: Switch back to the “Images” panel, and select the image in the visualization panel (otherwise the “Cross
section” ﬁ tool is grayed out). Select the “Cross section” tool lﬁ in the vertical toolbar, and click on the image to

display the intensity profiles along the X and Y axes.
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Fig. 65: The intensity profile is added to the “Signals” panel, and Datalab switches to this panel to display the profile.
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Fig. 66: Save the workspace to a file with “File > Save to HDFS file...”, or the button in the toolbar.
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Define a custom processing function

For illustrating the extensibility of Datalab, we will use a simple image processing function that is not available in the
standard DatalLab distribution, and that represents a typical use case for prototyping a custom processing pipeline.

The function that we will work on is a denoising filter that combines the ideas of averaging and edge detection. This
filter will average the pixel values in the neighborhood, but with a twist: it will give less weight to pixels that are
significantly different from the central pixel, assuming they might be part of an edge or noise.

Here is the code of the weighted_average_denoise function:

def weighted_average_denoise(data: np.ndarray) -> np.ndarray:
"""Apply a custom denoising filter to an image.

This filter averages the pixels in a 5x5 neighborhood, but gives less weight
to pixels that significantly differ from the central pixel.

i

def filter_func(values: np.ndarray) -> float:

Filter function"""

central_pixel = values[len(values) // 2]

differences = np.abs(values - central_pixel)

weights = np.exp(-differences / np.mean(differences))
return np.average(values, weights=weights)

i

return spi.generic_filter(data, filter_func, size=5)

For testing our processing function, we will use a generated image from a Datalab plugin example (plug-
ins/examples/cdl_example_imageproc.py). Before starting, make sure that the plugin is installed in DatalLab (see the
first steps of the tutorial Detecting blobs on an image).
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Fig. 67: To begin, we reorganize the window layout of DatalLab to have the “Image panel” on the left and the “Macro
manager” on the right.

1.4. Tutorials 51



DatalLab, Release 0.11.0

£, Datalab

File Edit Operations Processing Computing Plugins View 7

E e B A S sl bbb (cams

Test data
Image panel

il

Fig. 68: We generate a new image using the “Plugins > Extract blobs (example) > Generate test image” menu.

Fig. 69: We select a limited size for the image (e.g. 512x512 pixels) because our algorithm is quite slow, and click on

“OK”.
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Fig. 70: We can now see the generated image in the “Image panel”.
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Create a macro-command

Let’s get back to our custom function. We can create a new macro-command that will apply the function to the current
image. To do so, we open the “Macro manager” and click on the “New macro” button.

DatalLab creates a new macro-command which is not empty: it contains a sample code that shows how to create a new
image and add it to the “Image panel”. We can remove this code and replace it with our own code:

# Import the necessary modules
import numpy as np

import scipy.ndimage as spi

from cdl.proxy import RemoteProxy

# Define our custom processing function
def weighted_average_denoise(values: np.ndarray) -> float:
"""Apply a custom denoising filter to an image.

This filter averages the pixels in a 5x5 neighborhood, but gives less weight
to pixels that significantly differ from the central pixel.

central_pixel = values[len(values) // 2]

differences = np.abs(values - central_pixel)

weights = np.exp(-differences / np.mean(differences))

return np.average(values, weights=weights)

# Initialize the proxy to DatalLab
proxy = RemoteProxy()

# Switch to the "Image panel" and get the current image
proxy.set_current_panel ("image")
image = proxy.get_object()
if image is None:
# We raise an explicit error if there is no image to process
raise RuntimeError("No image to process!")

# Get a copy of the image data, and apply the function to it
data = np.array(image.data, copy=True)
data = spi.generic_filter(data, weighted_average_denoise, size=5)

# Add new image to the panel
proxy.add_image("My custom filtered data", data)

In DatalLab, macro-commands are simply Python scripts:

* Macros are part of DatalLab’s workspace, which means that they are saved and restored when exporting and
importing to/from an HDFS5 file.

* Macros are executed in a separate process, so we need to import the necessary modules and initialize the proxy
to DataLab. The proxy is a special object that allows to communicate with DatalLab.

* As a consequence, when defining a plugin or when controlling DataL.ab from an external IDE, we can use
exactly the same code as in the macro-command. This is a very important point, because it means that we can
prototype our processing pipeline in DatalLab, and then use the same code in a plugin or in an external IDE to
develop it further.
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Note: The macro-command is executed in DatalLab’s Python environment, so we can use the modules that are available
in DatalLab. However, we can also use our own modules, as long as they are installed in DatalLab’s Python environment
or in a Python distribution that is compatible with DatalLab’s Python environment.

If your custom modules are not installed in DatalLab’s Python environment, and if they are compatible with Datal.ab’s
Python version, you can prepend the sys.path with the path to the Python distribution that contains your modules:

import sys
sys.path.insert(0, "/path/to/my/python/distribution")

This will allow you to import your modules in the macro-command and mix them with the modules that are available
in DataLab.

Warning: If you use this method, make sure that your modules are compatible with Datal.ab’s Python version.
Otherwise, you will get errors when importing them.

Now, let’s execute the macro-command by clicking on the “Run macro” button:

* The macro-command is executed in a separate process, so we can continue to work in DatalLab while the macro-
command is running. And, if the macro-command takes too long to execute, we can stop it by clicking on the
“Stop macro” button.

* During the execution of the macro-command, we can see the progress in the “Macro manager” window: the
process standard output is displayed in the “Console” below the macro editor. We can see the following messages:

-—-[...]---[# ==> Running 'Untitled 01' macro...]: the macro-command starts

Connecting to Datalab XML-RPC server...OK [...]: the proxy is connected to DatalLab

-—-[...]---[# <== 'Untitled 01' macro has finished]: the macro-command ends
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Fig. 71: When the macro-command has finished, we can see the new image in the “Image panel”. Our filter has been
applied to the image, and we can see that the noise has been reduced.
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Prototyping with an external IDE

Now that we have a working prototype of our processing pipeline, we can use the same code in an external IDE to
develop it further.

For example, we can use the Spyder IDE to debug our code. To do so, we need to install Spyder but not necessarily in
DatalLab’s Python environment (in the case of the stand-alone version of Datal.ab, it wouldn’t be possible anyway).

The only requirement is to install a DatalLab client in Spyder’s Python environment:

* If you use the stand-alone version of Datal.ab or if you want or need to keep DatalLab and Spyder in separate
Python environments, you can install the DatalLab Simple Client (cd1-client) using the pip package manager:

[pip install cdl-client ]

Or you may also install the DatalLab Python package (cdl) which includes the client (but also other modules, so
we don’t recommend this method if you don’t need all DatalLab’s features in this Python environment):

[pip install cdl ]

* If you use the DatalLab Python package, you may run Spyder in the same Python environment as Datal.ab, so
you don’t need to install the client: it is already available in the main Datal.ab package (the cdl package).

Once the client is installed, we can start Spyder and create a new Python script:

# -*- coding: utf-8 -*-

e

Example of remote control of Datalab current session,
from a Python script running outside Datalab (e.g. in Spyder)

Created on Fri May 12 12:28:56 2023

@author: p.raybaut

i

# %% Importing necessary modules

import numpy as np

import scipy.ndimage as spi

from cdlclient import SimpleRemoteProxy

# %% Connecting to Datalab current session

proxy = SimpleRemoteProxy()
proxy.connect()

# %% Executing commands in DatalLab (...)
# Define our custom processing function
def weighted_average_denoise(data: np.ndarray) -> np.ndarray:

"""Apply a custom denoising filter to an image.

This filter averages the pixels in a 5x5 neighborhood, but gives less weight
to pixels that significantly differ from the central pixel.

(continues on next page)
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(continued from previous page)

o

def filter_func(values: np.ndarray) -> float:
"""Filter function"""
central_pixel = values[len(values) // 2]
differences = np.abs(values - central_pixel)
weights = np.exp(-differences / np.mean(differences))
return np.average(values, weights=weights)

return spi.generic_filter(data, filter_func, size=5)

# Switch to the "Image panel" and get the current image
proxy.set_current_panel ("image")
image = proxy.get_object()
if image is None:
# We raise an explicit error if there is no image to process
raise RuntimeError("No image to process!")

# Get a copy of the image data, and apply the function to it
data = np.array(image.data, copy=True)
data = weighted_average_denoise(data)

# Add new image to the panel
proxy.add_image("Filtered using Spyder", data)

A Signals B3 Images
v 2 gl
ﬂ i001: Test image

Fig. 72: We go back to DatalLab and select the first image in the “Image panel”.

Prototyping with a Jupyter notebook

We can also use a Jupyter notebook to prototype our processing pipeline. To do so, we need to install Jupyter but not
necessarily in DatalLab’s Python environment (in the case of the stand-alone version of Datal.ab, it wouldn’t be possible
anyway).

The only requirement is to install a Datalab client in Jupyter’s Python environment (see the previous section for more
details: that is exactly the same procedure as for Spyder or any other IDE like Visual Studio Code, for example).
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Fig. 73: Then, we execute the script in Spyder, step-by-step (using the defined cells), and we can see the result in
DataLab.
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Fig. 74: We can see in DatalLab that a new image has been added to the “Image panel”. This image is the result of the
execution of the script in Spyder. Here we have used the script without any modification, but we could have modified
it to test new ideas, and then use the modified script in DataLab.
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DatalLab custom function example

This is part of the Datalab's custom function tutorial which aims at illustrating the extensibility of Datalab (macros, plugins, and control from an external IDE or a Jupyter
notebook).

The only requirement is to install the Datalab Simple Client package (using pip install cdlclient . for example).

import numpy as np
import scipy.ndimage as spi
from cdlclient import SimpleRemoteProxy

# Define our custom processing function
def weighted_average_denoise(values: np.ndarray) -> float:

Apply a custom denoising filter to an image.

This filter averages the pixels in a 5x5 neighborhood, but gives less weight

to pixels that significantly differ from the central pixel.

central_pixel = values[len(values) // 2]

differences = np.abs(values - central pixel)

weights = np.exp(-differences / np.mean(differences))
return np.average{values, weights=weights)

Connecting to Datalab current session:
proxy = SimpleRemoteProxy()

proxy .connect()

Connecting to Datalab XML-RPC server...OK (port: 6133@)

Switch to the "Image panel” and get the current image

proxy.set_current_panel{"image")
image = proxy.get_object()
if image is None:

# .

# We raise an explicit error if there is no image to process

raise RuntimeError{"No image to process!")
Get a copy of the image data, apply the function to it. and add new image to the panel

data
data

np.array(image.data, copy=True}

spi.generic_filter(data, weighted_average_denoise, size=5)
proxy.add_image("Filtered using a Jupyter notebook”, data)

Fig. 75: Once the client is installed, we can start Jupyter and create a new notebook.
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Fig. 76: We go back to DatalLab and select the first image in the “Image panel”.
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Fig. 77: Then, we execute the notebook in Jupyter, step-by-step (using the defined cells), and we can see the result in
DatalLab. Once again, we can see in DatalLab that a new image has been added to the “Image panel”. This image is the
result of the execution of the notebook in Jupyter. As for the script in Spyder, we could have modified the notebook to
test new ideas, and then use the modified notebook in DatalLab.
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Creating a plugin

Now that we have a working prototype of our processing pipeline, we can create a plugin to integrate it in DatalLab’s
GUI. To do so, we need to create a new Python module that will contain the plugin code. We can use the same code as
in the macro-command, but we need to make some changes.

See also:
The plugin system is described in the Plugins section.

Apart from integrating the feature to DatalLab’s GUI which is more convenient for the user, the advantage of creating a
plugin is that we can take benefit of the DatalLab infrastructure, if we encapsulate our processing function in a certain
way (see below):

 Our function will be executed in a separate process, so we can interrupt it if it takes too long to execute.
* Warnings and errors will be handled by DatalLab, so we don’t need to handle them ourselves.

The most significant change is that we need to define a function that will be operating on DatalLab’s native image objects
(cdl.obj.ImageObj), instead of operating on NumPy arrays. So we need to find a way to call our custom function
weighted_average_denoise with a cdl.obj.ImageObj as input and output. To avoid writing a lot of boilerplate
code, we can use the function wrapper provided by DatalLab: cdl.core.computation.image.WrapllFunc.

Besides we need to define a class that describes our plugin, which must inherit from cdl.plugins.PluginBase and
name the Python script that contains the plugin code with a name that starts with cd1l_ (e.g. cdl_custom_func.py),
so that DatalLab can discover it at startup.

Moreover, inside the plugin code, we want to add an entry in the “Plugins” menu, so that the user can access our plugin
from the GUI.

Here is the plugin code:

# -*- coding: utf-8 -*-

Custom denoising filter plugin

This is a simple example of a Datalab image processing plugin.
It is part of the Datalab custom function tutorial.
. note::

This plugin is not installed by default. To install it, copy this file to

your DatalLab plugins directory (see ‘Datalab documentation

<https://codra-ingenierie-informatique.github.io/DatalLab/en/features/general/plugins.
~html>"_).

i

import numpy as np
import scipy.ndimage as spi

import cdl.core.computation.image as cpi
import cdl.obj
import cdl.param
import cdl.plugins
(continues on next page)
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(continued from previous page)

def weighted_average_denoise(data: np.ndarray) -> np.ndarray:
"""Apply a custom denoising filter to an image.

This filter averages the pixels in a 5x5 neighborhood, but gives less weight
to pixels that significantly differ from the central pixel.

e

def filter_func(values: np.ndarray) -> float:
"""Filter function
central_pixel = values[len(values) // 2]
differences = np.abs(values - central_pixel)
weights = np.exp(-differences / np.mean(differences))
return np.average(values, weights=weights)

mirn

return spi.generic_filter(data, filter_func, size=5)

class CustomFilters(cdl.plugins.PluginBase):
"""DataLab Custom Filters Plugin"""

PLUGIN_INFO = cdl.plugins.PluginInfo(
name="My custom filters",
version="1.0.0",
description="This is an example plugin",

def create_actions(self) -> None:
"""Create actions
acth = self.imagepanel.acthandler
proc = self.imagepanel.processor
with acth.new_menu(self.PLUGIN_INFO.name):
for name, func in (("Weighted average denoise", weighted_average_denoise),):
# Wrap function to handle ““ImageObj" objects instead of NumPy arrays
wrapped_func = cpi.WrapllFunc(func)
acth.new_action(
name, triggered=lambda: proc.compute_11(wrapped_func, title=name)

mirn

To test it, we have to add the plugin script to one of the plugin directories that are discovered by Datal.ab at startup (see
the Plugins section for more details, or the Detecting blobs on an image for an example).
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Fig. 78: We restart DatalLab and we can see that the plugin has been loaded.
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Fig. 79: We generate again our test image using (see the first steps of the tutorial), and we process it using the plugin:

“Plugins > My custom filters > Weighted average denoise”.
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CHAPTER
TWO

FEATURES

DatalLab features are detailed in the following sections. The first section describes the general features of Datalab,
then the two following sections describe the features specific to the signal and image processing panels.

Before jumping into the details of other parts of the documentation, it is recommended to start with the Workspace
page, which describes the basic concepts of DatalL.ab.

See also:

For a synthetic overview of the features of Datalab, please refer to the Key features page.

2.1 General features

This section describes the general features of DatalLab, which concern both the signal and image processing panels.

2.1.1 Workspace

Basic concepts

Working with DataLab is very easy. The user interface is intuitive and self-explanatory. The main window is divided
into two main areas:

* The right area shows the list of data sets which are currently loaded in Datal.ab, distibuted over two tabs: Signals
and Images. The user can switch between the two tabs by clicking on the corresponding tab: this switches the
main window to the corresponding panel, as well as the menu and toolbar contents. Below the list of data sets,
a Properties view shows information about the currently selected data set.

* The left area shows the visualization of the currently selected data set. The visualization is updated automatically
when the user selects a new data set in the list of data sets.

DatalLab has its own internal data model, in which data sets are organized around a tree structure. Each panel in the
main window corresponds to a branch of the tree. Each data set shown in the panels corresponds to a leaf of the tree.
Inside the data set, the data is organized in an object-oriented way, with a set of attributes and methods. The data model
is described in more details in the API section (see cdl.obj).

For each data set (1D signal or 2D image), not only the data itself is stored, but also a set of metadata, which describes
the data or the way it has to be displayed. The metadata is stored in a dictionary, which is accessible through the
metadata attribute of the data set (and may also be browsed in the Properties view, with the Metadata button).

The DatalLab Workspace is defined as the collection of all data sets which are currently loaded in Datal.ab, in both
the Signals and Images panels. The workspace may be saved to an HDFS file, and reloaded later. It is also possible to
import data sets from an HDF? file into the workspace, using the HDF5 Browser.
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Fig. 1: DatalLab main window
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Fig. 2: DatalLab main window, at startup.
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Note: Data sets may also be saved or loaded individually, using data formats such as .zxt or .npy for 1D signals (see
Open signal for the list of supported formats), , or .#iff or.dcm for 2D images (see Open image for the list of supported
formats).

HDF5 Browser

The “HDF5 Browser” is a modal dialog box allowing to import almost any 1D and 2D data into DatalLab workspace
(and eventually metadata).
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Compatible curve or image data are displayed in a hierarchical view on the left panel, as well as other scalar data (scalar
values are just shown for context purpose and may not be imported into Datal.ab workspace).

The HDFS5 browser is fairly simple to use:
* On the left panel, select the curve or image data you want to import
* Selected data is plotted on the right panel
¢ Click on “Check all” if you want to import all compatible data

* Then validate by clicking on “OK”
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2.1.2 Remote controlling

DatalLab may be controlled remotely using the XML-RPC protocol which is natively supported by Python (and many
other languages). Remote controlling allows to access Datal.ab main features from a separate process.

Note: If you are looking for a lighweight alternative solution to remote control Datal.ab (i.e. without having to install
the whole DatalLab package and its dependencies on your environment), please have a look at the Datal.ab Simple
Client package (pip install cdlclient).

From an IDE

DatalLab may be controlled remotely from an IDE (e.g. Spyder or any other IDE, or even a Jupyter Notebook) that
runs a Python script. It allows to connect to a running DatalLab instance, adds a signal and an image, and then runs
calculations. This feature is exposed by the RemoteProxy class that is provided in module cdl.proxy.

From a third-party application

DatalLab may also be controlled remotely from a third-party application, for the same purpose.

If the third-party application is written in Python 3, it may directly use the RemoteProxy class as mentioned above.
From another language, it is also achievable, but it requires to implement a XML-RPC client in this language using the
same methods of proxy server as in the RemoteProxy class.

Data (signals and images) may also be exchanged between DatalLab and the remote client application, in both directions.

The remote client application may be written in any language that supports XML-RPC. For example, it is possible
to write a remote client application in Python, Java, C++, C#, etc. The remote client application may be a graphical
application or a command line application.

The remote client application may be run on the same computer as DatalLab or on a different computer. In the latter
case, the remote client application must know the IP address of the computer running DatalLab.

The remote client application may be run before or after DatalLab. In the latter case, the remote client application must
try to connect to DatalLab until it succeeds.

Supported features

Supported features are the following:
» Switch to signal or image panel
* Remove all signals and images
 Save current session to a HDFS5 file
¢ Open HDFS5 files into current session
* Browse HDFS5 file
* Open a signal or an image from file
* Add a signal
¢ Add an image
* Get object list

* Run calculation with parameters
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Note: The signal and image objects are described on this section: Internal data model.

Some examples are provided to help implementing such a communication between your application and DataLab:
¢ See module: cdl.tests.remoteclient_app

¢ See module: cdl.tests.remoteclient_unit

I Host application - O *
This the dient application, which connects to Datalab. 14 Initialized Datalab connection & A
of Gt b Dok oy 2 Communication port: 34779
enne a=a 2 List of exposed methods:
4 add_annotations_from_items
Execute multiple commands 5 add_image
] add_label_with_title
Get object titles 7 add_signal
8 calc
Get object uids 9 close_application
18 delete_metadata
; ; 11 get_object
— Add signal objects 12 get_object_from_title
5 Addi — 13 get_object_from_uuid
Lo 14 get_object_titles
: = 15 get_object_uuids
8\ Remove al abjects 16 get_sel_ocbject_uuids
17 get_version
A Close Datalab 18 import_h5_file
19 open_h5_files v

Fig. 3: Screenshot of remote client application test (cdl.tests.remoteclient_app)

Examples

When using Python 3, you may directly use the RemoteProxy class as in examples cited above or below.

Here is an example in Python 3 of a script that connects to a running Datalab instance, adds a signal and an image,
and then runs calculations (the cell structure of the script make it convenient to be used in Spyder IDE):

# -*- coding: utf-8 -*-

e

Example of remote control of Datalab current session,
from a Python script running outside Datalab (e.g. in Spyder)

Created on Fri May 12 12:28:56 2023

@author: p.raybaut

i

# %% Importing necessary modules

# NumPy for numerical array computations:
import numpy as np

# Datalab remote control client:

(continues on next page)
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(continued from previous page)

from cdl.proxy import RemoteProxy

# %% Connecting to Datalab current session
proxy = RemoteProxy()

# %% Executing commands in Datalab (...)

z = np.random.rand(20, 20)
proxy.add_image("toto", z)

# %% Executing commands in DatalLab (...)
proxy.toggle_auto_refresh(False) # Turning off auto-refresh
X = np.array([1.0, 2.0, 3.0])

y = np.array([4.0, 5.0, -1.0])

proxy.add_signal("toto", x, y)

# %% Executing commands in Datalab (...)

proxy.compute_derivative()
proxy.toggle_auto_refresh(True) # Turning on auto-refresh

# %% Executing commands in Datalab (...)
proxy.set_current_panel ("image")

# %% Executing a lot of commands without refreshing DataLab
z = np.random.rand(400, 400)

proxy.add_image("foobar", z)

with proxy.context_no_refresh():

for _idx in range(100):
proxy.compute_£fft()

Here is a Python 2.7 reimplementation of this class:

# -*- coding: utf-8 -*-

#

# Licensed under the terms of the BSD 3-Clause
# (see cdl/LICENSE for details)

i

Datalab remote controlling class for Python 2.7

i

import io

import os

import os.path as osp
import socket

import sys

(continues on next page)
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(continued from previous page)

import ConfigParser as cp

import numpy as np

from guidata.userconfig import get_config_dir
from xmlrpclib import Binary, ServerProxy

def array_to_rpcbinary(data):
"""Convert NumPy array to XML-RPC Binary object, with shape and dtype
dbytes = io.BytesIO()
np.save(dbytes, data, allow_pickle=False)
return Binary(dbytes.getvalue())

i

def get_cdl_xmlrpc_port():
"""Return Datalab current XML-RPC port"""

if sys.platform == "win32" and "HOME" in os.environ:
os.environ.pop("HOME") # Avoid getting old WinPython settings dir
fname = osp.join(get_config_dir(), ".DatalLab", "Datalab.ini'")

ini = cp.ConfigParser()
ini.read(fname)
try:
return ini.get("main", "rpc_server_port")
except (cp.NoSectionError, cp.NoOptionError):
raise ConnectionRefusedError(''Datalab has not yet been executed")

class RemoteClient(object):

"""Object representing a proxy/client to DatalLab XML-RPC server"""
def __init__(self):

self.port = None

self.serverproxy = None

def connect(self, port=None):
"""Connect to Datalab XML-RPC server
if port is None:
port = get_cdl_xmlrpc_port()
self.port = port
url = "http://127.0.0.1:" + port
self.serverproxy = ServerProxy(url, allow_none=True)
try:
self.get_version()
except socket.error:
raise ConnectionRefusedError('Datalab is currently not running")

i

def get_version(self):
"""Return Datalab version
return self.serverproxy.get_version()

e

def close_application(self):
"""Close Datalab application
self.serverproxy.close_application()

i

(continues on next page)
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(continued from previous page)

def raise_window(self):
"""Raise Datalab window
self.serverproxy.raise_window()

i

def get_current_panel(self):
"""Return current panel"""
return self.serverproxy.get_current_panel ()

def set_current_panel(self, panel):
"""Switch to panel"""
self.serverproxy.set_current_panel (panel)

def reset_all(self):
"""Reset all application data
self.serverproxy.reset_all()

i

def toggle_auto_refresh(self, state):
"""Toggle auto refresh state
self.serverproxy.toggle_auto_refresh(state)

i

def toggle_show_titles(self, state):
"""Toggle show titles state
self.serverproxy.toggle_show_titles(state)

i

def save_to_h5_file(self, filename):
"""Save to a DatalLab HDF5 file"""
self.serverproxy.save_to_h5_file(filename)

def open_h5_files(self, h5files, import_all, reset_all):
"""Open a Datalab HDF5 file or import from any other HDF5 file"""
self.serverproxy.open_h5_files(h5files, import_all, reset_all)

def import_hS5_file(self, filename, reset_all):
"""Open DataLab HDF5 browser to Import HDF5 file"""
self.serverproxy.import_h5_file(filename, reset_all)

def open_object(self, filename):
"""Open object from file in current panel (signal/image)
self.serverproxy.open_object (filename)

mirn

def add_signal(
self, title, xdata, ydata, xunit=None, yunit=None, xlabel=None, ylabel=None

"""Add signal data to DataLab"""

xbinary = array_to_rpcbinary(xdata)

ybinary = array_to_rpcbinary(ydata)

p = self.serverproxy

return p.add_signal(title, xbinary, ybinary, xunit, yunit, xlabel, ylabel)

def add_image(
self,

(continues on next page)
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(continued from previous page)
title,
data,
xunit=None,
yunit=None,
zunit=None,
xlabel=None,
ylabel=None,
zlabel=None,

"""Add image data to DatalLab"""

zbinary = array_to_rpcbinary(data)

p = self.serverproxy

return p.add_image(title, zbinary, xunit, yunit, zunit, xlabel, ylabel, zlabel)

def get_object_titles(self, panel=None):
"""Get object (signal/image) list for current panel"""
return self.serverproxy.get_object_titles(panel)

def get_object(self, nb_id_title=None, panel=None):
"""Get object (signal/image) by number, id or title
return self.serverproxy.get_object(nb_id_title, panel)

mirn

def get_object_uuids(self, panel=None):
"""Get object (signal/image) list for current panel"""
return self.serverproxy.get_object_uuids(panel)

def test_remote_client():
"""DataLab Remote Client test
cdl = RemoteClient()
cdl.connect()
data = np.array([[3, 4, 5], [7, 8, 0]], dtype=np.uintl6)
cdl.add_image("toto", data)

o

if __name__ == "__main__":
test_remote_client()

Connection dialog

The DatalLab package also provides a connection dialog that may be used to connect to a running DataLab instance. It
is exposed by the cdl .widgets.connection.ConnectionDialog class

Example of use:

# -*- coding: utf-8 -*-

#

# Licensed under the terms of the BSD 3-Clause
# (see cdlclient/LICENSE for details)

i

(continues on next page)
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B Connection to Datalab

‘ﬂ‘P

.

ﬁ Connecting to server...

DatalLab

Cancel

Fig. 4: Screenshot of connection dialog (cdl.widgets.connection.ConnectionDialog)

DatalLab Remote client connection dialog example

i

# guitest: show,skip

from guidata.qthelpers import qt_app_context
from qtpy import QtWidgets as QW

from cdl.proxy import RemoteProxy
from cdl.widgets.connection import ConnectionDialog

def test_dialogQ):
"""Test connection dialog
proxy = RemoteProxy(autoconnect=False)
with qt_app_context():
dlg = ConnectionDialog(proxy.connect)
if dlg.exec(Q):

i

(continued from previous page)

QW.QMessageBox.information(None, "Connection", "Successfully connected")
else:
QW.QMessageBox.critical (None, "Connection", "Connection failed")
if __name__ == "__main__":

test_dialog()
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Public API: remote client

class cdl.core.remote.RemoteClient

Object representing a proxy/client to DatalLab XML-RPC server. This object is used to call DatalLab functions
from a Python script.

Examples

Here is a simple example of how to use RemoteClient in a Python script or in a Jupyter notebook:

>>> from cdl.core.remote import RemoteClient

>>> proxy = RemoteClient()

>>> proxy.connect()

Connecting to DatalLab XML-RPC server...OK (port: 28867)
>>> proxy.get_version()

'1.0.0'

>>> proxy.add_signal("toto", np.array([l., 2., 3.1), np.array([4., 5., -1.1))
True

>>> proxy.get_object_titles()

['toto']

>>> proxy["toto"]

<cdl.core.model.signal.SignalObj at 0x7f7f1cOb4a90>
>>> proxy[1]

<cdl.core.model.signal.SignalObj at 0x7£f7f1c0®b4a90>
>>> proxy[1].data

array([1., 2., 3.1)

connect (port: str | None = None, timeout: float | None = None, retries: int | None = None) — None
Try to connect to DatalLab XML-RPC server.

Parameters

* port (str | None)— XML-RPC port to connect to. If not specified, the port is automat-
ically retrieved from Datal.ab configuration.

e timeout (float | None) - Timeout in seconds. Defaults to 5.0.

e retries (int | None) - Number of retries. Defaults to 10.
Raises

¢ ConnectionRefusedError — Unable to connect to Datal.ab

e ValueError — Invalid timeout (must be >= 0.0)

e ValueError — Invalid number of retries (must be >= 1)

disconnect() — None

Disconnect from DatalLab XML-RPC server.
is_connected() — bool

Return True if connected to DatalLab XML-RPC server.

get_method_list() — list[str]
Return list of available methods.
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add_signal (title: str, xdata: ndarray, ydata: ndarray, xunit: str | None = None, yunit: str | None = None,
xlabel: str | None = None, ylabel: str | None = None) — bool

Add signal data to Datalab.
Parameters

e title (str) - Signal title
e xdata (numpy.ndarray) — X data
¢ ydata (numpy.ndarray) —Y data
e xunit (str | None)— X unit. Defaults to None.
e yunit (str | None)-Y unit. Defaults to None.
e xlabel (str | None)- X label. Defaults to None.
e ylabel (str | None)-Y label. Defaults to None.

Returns
True if signal was added successfully, False otherwise

Return type
bool

Raises
¢ ValueError - Invalid xdata dtype
e ValueError — Invalid ydata dtype

add_image (title: str, data: ndarray, xunit: str | None = None, yunit: str | None = None, zunit: str | None =
None, xlabel: str | None = None, ylabel: str | None = None, zlabel: str | None = None) — bool

Add image data to Datalab.
Parameters
e title (str) — Image title
e data (numpy.ndarray) — Image data
e xunit (str | None)— X unit. Defaults to None.
e yunit (str | None)-Y unit. Defaults to None.
e zunit (str | None) — Z unit. Defaults to None.
e xlabel (str | None) - X label. Defaults to None.
e ylabel (str | None)-Y label. Defaults to None.
e zlabel (str | None)—Z label. Defaults to None.

Returns
True if image was added successfully, False otherwise

Return type
bool

Raises
ValueError — Invalid data dtype

calc(name: str, param: DataSet | None = None) — DataSet

Call compute function name in current panel’s processor.

Parameters
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* name (str)— Compute function name

e param (guidata.dataset.DataSet | None)— Compute function parameter. Defaults
to None.

Returns
Compute function result

Return type
guidata.dataset.DataSet

get_object (nb_id_title: int | str | None = None, panel: str | None = None) — SignalObj | ImageObj
Get object (signal/image) from index.

Parameters

e nb_id_title — Object number, or object id, or object title. Defaults to None (current
object).

¢ panel - Panel name. Defaults to None (current panel).

Returns
Object

Raises
KeyError — if object not found

get_object_shapes(nb_id_title: int | str | None = None, panel: str | None = None) — list
Get plot item shapes associated to object (signal/image).

Parameters

e nb_id_title — Object number, or object id, or object title. Defaults to None (current
object).

¢ panel - Panel name. Defaults to None (current panel).

Returns
List of plot item shapes

add_annotations_from_items (items: list, refresh_plot: bool = True, panel: str | None = None) — None
Add object annotations (annotation plot items).

Parameters
e items (1ist)— annotation plot items
e refresh_plot (bool | None) - refresh plot. Defaults to True.

e panel (str | None) — panel name (valid values: “signal”, “image”). If None, current
panel is used.

add_object (0obj: SignalObj | ImageObj) — None
Add object to DataLab.

Parameters
obj (SignalObj | ImageObj) — Signal or image object

add_label_with_title(title: str | None = None, panel: str | None = None) — None
Add a label with object title on the associated plot

Parameters

e title (str | None) - Label title. Defaults to None. If None, the title is the object title.

76 Chapter 2. Features


https://docs.python.org/3/library/stdtypes.html#str
https://guidata.readthedocs.io/en/latest/reference/dataset/datatypes.html#guidata.dataset.DataSet
https://guidata.readthedocs.io/en/latest/reference/dataset/datatypes.html#guidata.dataset.DataSet
https://docs.python.org/3/library/functions.html#int
https://docs.python.org/3/library/stdtypes.html#str
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/stdtypes.html#str
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/exceptions.html#KeyError
https://docs.python.org/3/library/functions.html#int
https://docs.python.org/3/library/stdtypes.html#str
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/stdtypes.html#str
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/stdtypes.html#list
https://docs.python.org/3/library/stdtypes.html#list
https://docs.python.org/3/library/functions.html#bool
https://docs.python.org/3/library/stdtypes.html#str
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/stdtypes.html#list
https://docs.python.org/3/library/functions.html#bool
https://docs.python.org/3/library/stdtypes.html#str
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/stdtypes.html#str
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/stdtypes.html#str
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/stdtypes.html#str

DatalLab, Release 0.11.0

e panel (str | None) — panel name (valid values: “signal”, “image”). If None, current
panel is used.

close_application() — None
Close DataLab application

context_no_refresh() — Callable
Return a context manager to temporarily disable auto refresh.

Returns
Context manager

Example

>>> with proxy.context_no_refresh():
proxy.add_image("imagel", datal)
proxy.compute_£fft ()
proxy.compute_wiener()
proxy.compute_ifft()
# Auto refresh is disabled during the above operations

delete_metadata(refresh_plot: bool = True, keep_roi: bool = False) — None
Delete metadata of selected objects
Parameters
e refresh_plot — Refresh plot. Defaults to True.
* keep_roi — Keep ROI. Defaults to False.
get_current_panel () — str
Return current panel name.

Returns
Panel name (valid values: “signal”, “image”, “macro”))

Return type
str
get_group_titles_with_object_infos() — tuple[list[str], list[list[str]], list[list[str]]]
Return groups titles and lists of inner objects uuids and titles.

Returns
groups titles, lists of inner objects uuids and titles

Return type
Tuple
get_object_titles(panel: str | None = None) — list[str]
Get object (signal/image) list for current panel. Objects are sorted by group number and object index in
group.
Parameters

panel (str | None) - panel name (valid values: “signal”, “image”). If None, current panel
is used.

Returns
list of object titles
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Return type
list[str]

Raises
ValueError - if panel not found

get_object_uuids (panel: str | None = None) — list[str]

Get object (signal/image) uuid list for current panel. Objects are sorted by group number and object index
in group.

Parameters
panel (str | None) - panel name (valid values: “signal”, “image”). If None, current panel
is used.

Returns
list of object uuids

Return type
list[str]

Raises
ValueError — if panel not found

classmethod get_public_methods() — list[str]

Return all public methods of the class, except itself.

Returns
List of public methods

Return type
list[str]
get_sel_object_uuids (include_groups: bool = False) — list[str]
Return selected objects uuids.

Parameters
include_groups - If True, also return objects from selected groups.

Returns
List of selected objects uuids.

get_version() — str

Return DatalLab version.

Returns
Datal.ab version

Return type
str

import_h5_file(filename: str, reset_all: bool | None = None) — None
Open DatalL.ab HDF5 browser to Import HDF? file.

Parameters
¢ filename (str)— HDFS5 file name
e reset_all (bool | None)— Reset all application data. Defaults to None.

open_h5_files (hSfiles: list[str] | None = None, import_all: bool | None = None, reset_all: bool | None =
None) — None

Open a DatalLab HDFS5 file or import from any other HDF? file.
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Parameters
e h5files (list[str] | None) - List of HDFS files to open. Defaults to None.
e import_all (bool | None)— Import all objects from HDFS files. Defaults to None.
» reset_all (bool | None)— Reset all application data. Defaults to None.

open_object (filename: str) — None
Open object from file in current panel (signal/image).

Parameters
filename (str) — File name

raise_window() — None
Raise DatalLab window

reset_all() — None
Reset all application data

save_to_h5_file(filename: str) — None
Save to a DatalLab HDF5 file.

Parameters
filename (str)— HDF? file name

select_groups (selection: list[int | str] | None = None, panel: str | None = None) — None

Select groups in current panel.
Parameters

» selection — List of group numbers (1 to N), or list of group uuids, or None to select all
groups. Defaults to None.

e panel (str | None) — panel name (valid values: “signal”, “image”). If None, current
panel is used. Defaults to None.

select_objects(selection: list[int | str], panel: str | None = None) — None

Select objects in current panel.
Parameters
¢ selection — List of object numbers (1 to N) or uuids to select

* panel — panel name (valid values: “signal”, “image”). If None, current panel is used.
Defaults to None.

set_current_panel (panel: sir) — None
Switch to panel.

Parameters
panel (str) — Panel name (valid values: “signal”, “image”, “macro”))

toggle_auto_refresh(state: bool) — None
Toggle auto refresh state.

Parameters
state (bool) — Auto refresh state

toggle_show_titles(state: bool) — None
Toggle show titles state.

Parameters
state (bool) — Show titles state
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Public API: additional methods

The remote control class methods (either using the proxy or the remote client) may be completed with additional
methods which are dynamically added at runtime. This mechanism allows to access the methods of the “processor”
objects of Datalab.

Signal Processor

class cdl.core.gui.processor.signal.SignalProcessor (panel: SignalPanel | ImagePanel, plotwidget:

PlotWidget)

Object handling signal processing: operations, processing, computing

compute_sum() — None

Compute sum

compute_average() — None

Compute average

compute_product () — None
Compute product

compute_roi_extraction(param: ROIDataParam | None = None) — None
Extract Region Of Interest (ROI) from data

compute_swap_axes() — None

Swap data axes

compute_abs() — None

Compute absolute value

compute_re() — None

Compute real part

compute_im() — None
Compute imaginary part
compute_astype (param: DataTypeSParam | None = None) — None

Convert data type

compute_logl®() — None
Compute Log10

compute_difference(obj2: SignalObj | None = None) — None

Compute difference between two signals

compute_quadratic_difference (obj2: SignalObj | None = None) — None
Compute quadratic difference between two signals

compute_division(obj2: SignalObj | None = None) — None
Compute division between two signals

compute_peak_detection(param: PeakDetectionParam | None = None) — None
Detect peaks from data

compute_normalize(param: NormalizeYParam | None = None) — None

Normalize data
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compute_derivative() — None

Compute derivative

compute_integral () — None
Compute integral

compute_calibration(param: XYCalibrateParam | None = None) — None
Compute data linear calibration

compute_threshold(param: ThresholdParam | None = None) — None
Compute threshold clipping

compute_clip (param: ClipParam | None = None) — None
Compute maximum data clipping

compute_gaussian_filter (param: GaussianParam | None = None) — None
Compute gaussian filter

compute_moving_average (param: MovingAverageParam | None = None) — None

Compute moving average

compute_moving median(param: MovingMedianParam | None = None) — None
Compute moving median

compute_wiener () — None
Compute Wiener filter

compute_£ft (param: FFTParam | None = None) — None
Compute iFFT

compute_ifft (param: FFTParam | None = None) — None
Compute FFT

compute_interpolation(obj2: SignalObj | None = None, param: InterpolationParam | None = None)
Compute interpolation

compute_resampling (param: ResamplingParam | None = None)
Compute resampling

compute_detrending (param: DetrendingParam | None = None)

Compute detrending

compute_convolution(obj2: SignalObj | None = None) — None
Compute convolution

compute_f£it (name, fitdigfunc)
Compute fitting curve

compute_polyfit (param: PolynomialFitParam | None = None) — None
Compute polynomial fitting curve

compute_multigaussianfit() — None
Compute multi-Gaussian fitting curve

compute_fwhm(param: FWHMParam | None = None) — dict[str, ResultShape]
Compute FWHM

compute_fwle2 () — dict[str, ResultShape]
Compute FW at 1/¢?
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Image Processor

class cdl.core.gui.processor.image.ImageProcessor (panel: SignalPanel | ImagePanel, plotwidget:

PlotWidget)
Object handling image processing: operations, processing, computing
compute_sum() — None

Compute sum

compute_average() — None

Compute average

compute_product () — None

Compute product

compute_logpl (param: LogP1Param | None = None) — None
Compute base 10 logarithm
compute_rotate(param: RotateParam | None = None) — None

Rotate data arbitrarily

compute_rotate90() — None
Rotate data 90°

compute_rotate270() — None
Rotate data 270°

compute_£liph() — None
Flip data horizontally

compute_£1lipv() — None
Flip data vertically

distribute_on_grid(param: GridParam | None = None) — None
Distribute images on a grid

reset_positions() — None
Reset image positions

compute_resize(param: ResizeParam | None = None) — None
Resize image

compute_binning (param: BinningParam | None = None) — None
Binning image

compute_roi_extraction(param: ROIDataParam | None = None) — None
Extract Region Of Interest (ROI) from data

compute_profile(param: ProfileParam | None = None) — None
Compute profile

compute_average_profile(param: AverageProfileParam | None = None) — None
Compute average profile

compute_radial_profile (param: RadialProfileParam | None = None) — None
Compute radial profile
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compute_swap_axes() — None

Swap data axes

compute_abs() — None

Compute absolute value

compute_re() — None
Compute real part
compute_im() — None
Compute imaginary part
compute_astype (param: DataTypelParam | None = None) — None
Convert data type
compute_log1®() — None
Compute Log10
compute_difference(obj2: ImageObj | None = None) — None
Compute difference between two images
compute_quadratic_difference (obj2: ImageObj | None = None) — None
Compute quadratic difference between two images
compute_division(obj2: ImageObj | None = None) — None
Compute division between two images
compute_flatfield(obj2: ImageObj | None = None, param: FlatFieldParam | None = None) — None
Compute flat field correction
compute_calibration(param: ZCalibrateParam | None = None) — None
Compute data linear calibration
compute_threshold(param: ThresholdParam | None = None) — None
Compute threshold clipping
compute_clip (param: ClipParam | None = None) — None
Compute maximum data clipping
compute_gaussian_filter (param: GaussianParam | None = None) — None
Compute gaussian filter
compute_moving_average (param: MovingAverageParam | None = None) — None
Compute moving average
compute_moving _median(param: MovingMedianParam | None = None) — None
Compute moving median
compute_wiener() — None
Compute Wiener filter
compute_£ft (param: FFTParam | None = None) — None
Compute FFT
compute_ifft (param: FETParam | None = None) — None
Compute iFFT

2.1.

General features 83


https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None

DatalLab, Release 0.11.0

compute_butterworth(param: ButterworthParam | None = None) — None
Compute Butterworth filter

compute_adjust_gamma (param: AdjustGammaParam | None = None) — None
Compute gamma correction

compute_adjust_log(param: AdjustLogParam | None = None) — None
Compute log correction

compute_adjust_sigmoid(param: AdjustSigmoidParam | None = None) — None
Compute sigmoid correction

compute_rescale_intensity(param: RescalelntensityParam | None = None) — None
Rescale image intensity levels

compute_equalize_hist (param.: EqualizeHistParam | None = None) — None
Histogram equalization

compute_equalize_adapthist (param: EqualizeAdaptHistParam | None = None) — None
Adaptive histogram equalization

compute_denoise_tv(param: DenoiseTVParam | None = None) — None
Compute Total Variation denoising

compute_denoise_bilateral (param: DenoiseBilateralParam | None = None) — None
Compute bilateral filter denoising

compute_denoise_wavelet (param: DenoiseWaveletParam | None = None) — None
Compute Wavelet denoising

compute_denoise_tophat (param: MorphologyParam | None = None) — None
Denoise using White Top-Hat

compute_all_denoise (params: list | None = None) — None
Compute all denoising filters

compute_white_tophat (param: MorphologyParam | None = None) — None
Compute White Top-Hat

compute_black_tophat (param: MorphologyParam | None = None) — None
Compute Black Top-Hat

compute_erosion(param: MorphologyParam | None = None) — None
Compute Erosion

compute_dilation(param: MorphologyParam | None = None) — None
Compute Dilation

compute_opening (param: MorphologyParam | None = None) — None
Compute morphological opening

compute_closing (param: MorphologyParam | None = None) — None
Compute morphological closing

compute_all_morphology (param: MorphologyParam | None = None) — None
Compute all morphology filters
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compute_canny (param: CannyParam | None = None) — None
Compute Canny filter

compute_roberts() — None
Compute Roberts filter

compute_prewitt() — None
Compute Prewitt filter

compute_prewitt_h() — None

Compute Prewitt filter (horizontal)

compute_prewitt_v() — None

Compute Prewitt filter (vertical)

compute_sobel () — None
Compute Sobel filter
compute_sobel_h() — None
Compute Sobel filter (horizontal)
compute_sobel_v() — None
Compute Sobel filter (vertical)
compute_scharr() — None
Compute Scharr filter
compute_scharr_h() — None
Compute Scharr filter (horizontal)
compute_scharr_v() — None
Compute Scharr filter (vertical)
compute_farid() — None
Compute Farid filter
compute_farid_h() — None
Compute Farid filter (horizontal)
compute_farid_v() — None
Compute Farid filter (vertical)
compute_laplace() — None
Compute Laplace filter
compute_all_edges() — None
Compute all edges
compute_centroid() — dict[str, ResultShape]
Compute image centroid
compute_enclosing_circle() — dict[str, ResultShape]

Compute minimum enclosing circle

compute_peak_detection(param: Peak2DDetectionParam | None = None) — dict[str, ResultShape)

Compute 2D peak detection
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compute_contour_shape (param: ContourShapeParam | None = None) — dict[str, ResultShape]

Compute contour shape fit

compute_hough_circle_peaks (param: HoughCircleParam | None = None) — dict[str, ResultShape]

Compute peak detection based on a circle Hough transform

compute_blob_dog(param: BlobDOGParam | None = None) — dict[str, ResultShape]

Compute blob detection using Difference of Gaussian method

compute_blob_doh (param: BlobDOHParam | None = None) — dict[str, ResultShape]

Compute blob detection using Determinant of Hessian method

compute_blob_log(param: BlobLOGParam | None = None) — dict[str, ResultShape]

Compute blob detection using Laplacian of Gaussian method

compute_blob_opencv (param: BlobOpenCVParam | None = None) — dict[str, ResultShape]
Compute blob detection using OpenCV

2.1.3 Internal data model

In its internal data model, DatalLab stores data using two main classes:
* cdl.obj.SignalObj, which represents a signal object, and
e cdl.obj.ImageObj, which represents an image object.
These classes are defined in the cdl.core.model package but are exposed publicly in the cdl.obj package.

Also, DatalLab uses many different datasets (based on guidata’s DataSet class) to store the parameters of the compu-
tations. These datasets are defined in different modules but are exposed publicly in the cdl.param package.

See also:

The API section for more information on the public APIL.

2.1.4 Plugins

DatalLab is a modular application. It is possible to add new features to DatalLab by writing plugins. A plugin is a Python
module that is loaded at startup by DatalLab. A plugin may add new features to DatalLab, or modify existing features.
The plugin system currently supports the following features:

* Processing features: add new processing tasks to the DatalLab processing system, including specific graphical
user interfaces.

* Input/output features: add new file formats to the DataL.ab file I/O system.
* HDFS features: add new HDFS file formats to the DatalLab HDF5 I/O system.
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What is a plugin?
A plugin is a Python module that is loaded at startup by DatalLab. A plugin may add new features to DatalLab, or modify
existing features.

A plugin is a Python module that contains a class derived from the cdl.plugins.PluginBase class. The name of
the class is not important, as long as it is derived from cdl.plugins.PluginBase and has a PLUGIN_INFO attribute
that is an instance of the cdl.plugins.PluginInfo class. The PLUGIN_INFO attribute is used by Datal.ab to retrieve
information about the plugin.

Where to put a plugin?

As plugins are Python modules, they can be put anywhere in the Python path of the Datalab installation.
Special additional locations are available for plugins:

e The plugins directory in the user configuration folder (e.g. C:UsersJohnDoe.DataLabplugins on Windows or
~/.DataLab/plugins on Linux).

* The plugins directory in the same folder as the DataLab executable in case of a standalone installation.

* The plugins directory in the cdl package in case for internal plugins only (i.e. it is not recommended to put your
own plugins there).

Example: processing plugin

Here is a simple example of a plugin that adds a new features to DataLab.

# -*- coding: utf-8 -*-

#

# Licensed under the terms of the BSD 3-Clause
# (see cdl/LICENSE for details)

i

Test Data Plugin for DatalLab

This plugin is an example of Datalab plugin. It provides test data samples
and some actions to test Datalab functionalities.

i

import cdl.obj as dlo

import cdl.tests.data as test_data

from cdl.config import _

from cdl.core.computation import image as cpima
from cdl.core.computation import signal as cpsig
from cdl.plugins import PluginBase, PluginInfo

# All computation functions must be defined as global functions, otherwise
# they cannot be pickled and sent to the worker process

(continues on next page)
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(continued from previous page)

def add_noise_to_signal(
src: dlo.SignalObj, p: test_data.GaussianNoiseParam
) -> dlo.SignalObj:
"""Add gaussian noise to signal"""
dst = cpsig.dst_1l1(src, "add_gaussian_noise", f'mu={p.mu},sigma={p.sigma}")
test_data.add_gaussian_noise_to_signal(dst, p)
return dst

def add_noise_to_image(src: dlo.ImageObj, p: dlo.NormalRandomParam) -> dlo.ImageObj:
Add gaussian noise to image'""

dst = cpima.dst_11(src, "add_gaussian_noise", f'mu={p.mu},sigma={p.sigma}")
test_data.add_gaussian_noise_to_image(dst, p)

return dst

o

class PluginTestData(PluginBase):
"""DataLab Test Data Plugin"""

PLUGIN_INFO = PluginInfo(
name=_("Test data"),
version="1.0.0",
description=_("Testing Datalab functionalities"),

)

# Signal processing features --—--—-————————————— -
def add_noise_to_signal(self) -> None:
"""Add noise to signal"""
self.signalpanel.processor.compute_11(
add_noise_to_signal,
paramclass=test_data.GaussianNoiseParam,
title=_("Add noise"),
)

def create_paracetamol_signal(self) -> None:
"""Create paracetamol signal"""
obj = test_data.create_paracetamol_signal()
self.proxy.add_object(obj)

def create_noisy_signal(self) -> None:
"""Create noisy signal"""
obj = self.signalpanel.new_object(add_to_panel=False)
if obj is not None:
noiseparam = test_data.GaussianNoiseParam(_("Noise™))
self.signalpanel.processor.update_param_defaults(noiseparam)
if noiseparam.edit(self.signalpanel):
test_data.add_gaussian_noise_to_signal (obj, noiseparam)
self.proxy.add_object(obj)

i c (IO G E S S e At e S R e e e e e e e e e e e e e
def add_noise_to_image(self) -> None:
"""Add noise to image"""
(continues on next page)
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(continued from previous page)

self.imagepanel .processor.compute_11(
add_noise_to_image,
paramclass=dlo.NormalRandomParam,
title=_("Add noise"),

)

def create_peak2d_image(self) -> None:
"""Create 2D peak image
obj = self.imagepanel.new_object(add_to_panel=False)
param = test_data.PeakDataParam.create(size=max(obj.data.shape))
self.imagepanel .processor.update_param_defaults(param)
if param.edit(self.imagepanel):
obj.data = test_data.get_peak2d_data(param)
self.proxy.add_object(obj)

i

def create_sincos_image(self) -> None:
"""Create 2D sin cos image
newparam = self.edit_new_image_parameters(hide_image_type=True)
if newparam is not None:
obj = test_data.create_sincos_image(newparam)
self.proxy.add_object(obj)

e

def create_noisygauss_image(self) -> None:
"""Create 2D noisy gauss image
newparam = self.edit_new_image_parameters(hide_image_type=True)
if newparam is not None:
obj = test_data.create_noisygauss_image(newparam)
self.proxy.add_object(obj)

e

def create_multigauss_image(self) -> None:
"""Create 2D multi gauss image"""
newparam = self.edit_new_image_parameters(hide_image_type=True)
if newparam is not None:
obj = test_data.create_multigauss_image(newparam)
self.proxy.add_object(obj)

def create_2dstep_image(self) -> None:
"""Create 2D step image
newparam = self.edit_new_image_parameters(hide_image_type=True)
if newparam is not None:
obj = test_data.create_2dstep_image(newparam)
self.proxy.add_object(obj)

i

def create_ring_image(self) -> None:
"""Create 2D ring image
param = test_data.RingParam(_("'Ring"))
if param.edit(self.imagepanel):
obj = test_data.create_ring_image(param)
self.proxy.add_object(obj)

i

def create_annotated_image(self) -> None:
"""Create annotated image

e

(continues on next page)
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obj = test_data.create_annotated_image()
self.proxy.add_object(obj)

# Plugin menu entries -----------—-—-———————————-

def create_actions(self) -> None:
"""Create actions

mirn

# Signal panel - —————-—"-"-—"-"-"—"———"———"—~————~————

sah = self.signalpanel.acthandler
with sah.new_menu(_("Test data")):

(continued from previous page)

sah.new_action(_("Add noise to signal"), triggered=self.add_noise_to_signal)

sah.new_action(

_("Load spectrum of paracetamol"),

triggered=self.create_paracetamol_signal,

select_condition="always",
separator=True,

sah.new_action(
_("Create noisy signal"),

triggered=self.create_noisy_signal,

select_condition="always",

)

# Image panel ---——-———-—----"---"-"-————"————————

iah = self.imagepanel.acthandler
with iah.new_menu(_("Test data")):

iah.new_action(_("Add noise to image"),
# with iah.new_menu(_("Data samples")):

iah.new_action(
_("Create image with peaks"),

triggered=self.create_peak2d_image,

select_condition="always",
separator=True,

iah.new_action(
_("Create 2D sin cos image"),

triggered=self.create_sincos_image,

select_condition="always",

iah.new_action(

_("Create 2D noisy gauss image"),

triggered=self.add_noise_to_image)

triggered=self.create_noisygauss_image,

select_condition="always",

iah.new_action(

_("Create 2D multi gauss image"),

triggered=self.create_multigauss_image,

select_condition="always",

iah.new_action(
_("Create annotated image"),

triggered=self.create_annotated_image,

select_condition="always",

(continues on next page)
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(continued from previous page)
iah.new_action(
_("Create 2D step image'),
triggered=self.create_2dstep_image,
select_condition="always",

iah.new_action(
_("Create ring image"),
triggered=self.create_ring_image,
select_condition="always",

Example: input/output plugin

Here is a simple example of a plugin that adds a new file formats to DatalL.ab.

# -*- coding: utf-8 -*-

#

# Licensed under the terms of the BSD 3-Clause
# (see cdl/LICENSE for details)

i

Image file formats Plugin for DatalLab

This plugin is an example of Datalab plugin.
It provides image file formats from cameras, scanners, and other acquisition devices.

i

import struct
import numpy as np

from cdl.core.io.base import FormatInfo
from cdl.core.io.image.base import ImageFormatBase

#
# Thales Pixium FXD file format
#

class FXDFile:
"""Class implementing Thales Pixium FXD Image file reading feature

Args:
fname (str): path to FXD file
debug (bool): debug mode

i

HEADER = "<111111££1"

def __init__(self, fname: str = None, debug: bool = False) -> None:
(continues on next page)
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def

def

(continued from previous page)

self.__debug = debug
self.file_format = None # long
self.nbcols = None # long
self.nbrows = None # long
self.nbframes = None # Ilong
self.pixeltype = None # long
self.quantlevels = None # long
self.maxlevel = None # float
self.minlevel = None # float
self.comment_length = None # Iong
self.fname = None
self.data = None
if fname is not None:
self.load(fname)

__repr__(self) -> str:

"""Return a string representation of the object

info = (
("Image width", f"{self.nbcols:d}"),
("Image Height", f"{self.nbrows:d}"),
("Frame number", f"{self.nbframes:d}"),
("File format", f"{self.file_format:d}"),
("Pixel type", f"{self.pixeltype:d}"),
("Quantlevels", f"{self.quantlevels:d}"),
("Min. level", f"{self.minlevel:f}"),
("Max. level", f"{self.maxlevel:f}"),
("Comment length", f"{self.comment_length:d}"),

i

)
desc_len = max(len(d) for d in list(zip(*info))[0]) + 3

ras = ""
for description, value in info:

res += ("{:" + str(desc_len) + "}{}\n").format(description +

, value)

res = object.__repr__(self) + "\n" + res
return res

load(self, fname: str) -> None:
"""Load header and image pixel data

Args:
fname (str): path to FXD file
with open(fname, "rb") as data_file:
header_s = struct.Struct(self.HEADER)
record = data_file.read(9 * 4)
unpacked_rec = header_s.unpack(record)
(
self.file_format,
self.nbcols,
self.nbrows,
self.nbframes,
self.pixeltype,

(continues on next page)
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self.quantlevels,
self.maxlevel,
self.minlevel,
self.comment_length,
) = unpacked_rec
if self.__debug:
print (unpacked_rec)
print(self)
data_file.seek(128 + self.comment_length)
if self.pixeltype ==
size, dtype = 4, np.float32
elif self.pixeltype == 1:
size, dtype = 2, np.uintl6
elif self.pixeltype ==
size, dtype = 1, np.uint8
else:

(continued from previous page)

raise NotImplementedError (f"Unsupported pixel type: {self.pixeltype}")

block = data_file.read(self.nbrows * self.nbcols
data = np.fromstring(block, dtype=dtype)
self.data = data.reshape(self.nbrows, self.nbcols)

class FXDImageFormat(ImageFormatBase):
"""Object representing Thales Pixium (FXD) image file type

FORMAT_INFO = FormatInfo(
name="Thales Pixium",
extensions=""*.fxd",
readable=True,
writeable=False,

)

@staticmethod
def read_data(filename: str) -> np.ndarray:
"""Read data and return it

Args:
filename (str): path to FXD file

Returns:

np.ndarray: image data
fxd_file = FXDFile(filename)
return fxd_file.data

* size)

e

#
# Diirr NDT XYZ file format

#

class XYZImageFormat(ImageFormatBase):

(continues on next page)
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(continued from previous page)

o i

Object representing Diirr NDT XYZ image file type

FORMAT_INFO = FormatInfo(
name="Diurr NDT",
extensions="*.xyz",
readable=True,
writeable=False,

)

@staticmethod
def read_data(filename: str) -> np.ndarray:
"""Read data and return it

Args:
filename (str): path to XYZ file

Returns:
np.ndarray: image data

with open(filename, "rb") as fdesc:
cols = int(np.fromfile(fdesc, dtype=np.uintl6, count=1)[0])
rows = int(np.fromfile(fdesc, dtype=np.uintl6, count=1)[0])
arr = np.fromfile(fdesc, dtype=np.uintl6, count=cols * rows)
arr = arr.reshape((rows, cols))

return np.fliplr(arr)

Other examples

Other examples of plugins can be found in the plugins/examples directory of the DatalLab source code (explore here on
GitHub).

Public API

DataLab plugin system

DatalLab plugin system provides a way to extend the application with new functionalities.
Plugins are Python modules that relies on two classes:

* PluginInfo, which stores information about the plugin

e PluginBase, which is the base class for all plugins

Plugins may also extends Datal.ab I/O features by providing new image or signal formats. To do so, they must provide
a subclass of ImageFormatBase or SignalFormatBase, in which format infos are defined using the FormatInfo
class.
class cdl.plugins.PluginRegistry (name, bases, attrs)

Metaclass for registering plugins

classmethod get_plugin_classes() — list[PluginBase]
Return plugin classes
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classmethod get_plugins() — list[PluginBase]

Return plugin instances

classmethod get_plugin(name_or_class) — PluginBase | None

Return plugin instance
classmethod register_plugin(plugin: PluginBase)
Register plugin
classmethod unregister_plugin(plugin: PluginBase)
Unregister plugin
classmethod get_plugin_infos() — str
Return plugin infos (names, versions, descriptions) in html format
class cdl.plugins.PluginInfo(name: str = None, version: str ='0.0.0', description: str =", icon: str = None)
Plugin info
class cdl.plugins.PluginBaseMeta (name, bases, namespace,/, **kwargs)
Mixed metaclass to avoid conflicts

class cdl.plugins.PluginBase

Plugin base class

property signalpanel: SignalPanel

Return signal panel

property imagepanel: ImagePanel

Return image panel

show_warning (message: str)

Show warning message

show_error (message: str)

Show error message

show_info (message: str)

Show info message

ask_yesno (message: str, title: str | None = None, cancelable: bool = False) — bool
Ask yes/no question

edit_new_signal_parameters(title: str | None = None, size: int | None = None, hide_signal_type: bool =
True) — NewSignalParam

Create and edit new signal parameter dataset
Parameters
e title - title of the new signal
* size - size of the new signal (default: None, get from current signal)
* hide_signal_type - hide signal type parameter (default: True)

Returns
New signal parameter dataset (or None if canceled)
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edit_new_image_parameters (title: sir | None = None, shape: tuple[int, int] | None = None,
hide_image_type: bool = True, hide_image_dtype: bool = False) —
NewlmageParam | None

Create and edit new image parameter dataset
Parameters
e title - title of the new image
» shape — shape of the new image (default: None, get from current image)
* hide_image_type — hide image type parameter (default: True)
¢ hide_image_dtype — hide image data type parameter (default: False)

Returns
New image parameter dataset (or None if canceled)

is_registered()
Return True if plugin is registered
register (main: main.CDLMainWindow) — None
Register plugin
unregister()
Unregister plugin
register_hooks()
Register plugin hooks

unregister_hooks ()
Unregister plugin hooks

abstract create_actions()
Create actions

cdl.plugins.discover_plugins () — list[PluginBase]

Discover plugins using naming convention

2.1.5 Log viewer

Despite countless efforts (unit testing, test coverage, ...), DatalLab might crash or behave unexpectedly.
For those situations, Datal.ab provides two logs (located in your home directory):
» “Traceback log”, for Python exceptions

¢ “Faulthandler log”, for system failures (e.g. Qt-related crash)

If DatalL.ab crashed or if any Python exception is raised during its execution, those log files will be updated accordingly.
DatalLab will even notify that new informations are available in log files at next startup. This is an invitation to submit

a bug report.

Reporting unexpected behavior or any other bug on GitHub Issues will be greatly appreciated, especially if those log file
contents are attached to the report (as information on your installation configuration, see Installation and configuration

viewer).
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%=, .DatalLab_traceback. 1.log %=, .Datalab_faulthandler. 1.log

Contents of file C:\Usersip.raybautl.Datal abY. Datalab tracebadk. 1.log:

exception
2 Traceback (most recent call last):
File "C:\Dev\Libre\guidata\guidata\gthelpers.py", line 122, in <lambda>
actien.triggered.connect(lambda checked=False: triggered())
File "C:\Dev\Projets\DataLab\cdl\core\gui\main.py", line 844, in <lambda=>
triggered=lambda: instconfviewer.exec_cdl_installconfig_dialeg(self),
File "C:\Dev\Projets\DataLab\cdl\widgets\instconfviewer.py”, line 115, in
exec_cdl_installeconfig_dialog

=l h 0 E W

I
=

1[28/86/2823 - 15:43:39] {C:\Dev\Projets\Datalab\cdl\utils\gthelpers.py:1684} CRITICAL - Unhandled

8 dlg = InstallConfigViewerWindow(parent=parent)

9 File "C:\Dev\Projets\DatalLab\cdl\widgets\instconfviewer.py”, line 164, in __init__
18 viewer.set_data(title, contents)

11 File "C:\Dev\Projets\Datalab\cdl\widgets\fileviewer.py", line 86, in set_data

12 self.editor.setPlainText(contents)

13 TypeError: setPlainText(self, str): argument 1 has unexpected type 'tuple’

Fig. 5: DatalLab log viewer (see “?”” menu)

2.1.6 Installation and configuration viewer

Because of the multiple ways of installing DatalLab on your machine, understanding why the application behaves un-

expectedly without any information on your configuration could be very challenging.

That is why Datalab provides the dialog box “Installation and configuration” which gathers all the information about

your installation and configuration.

Reporting unexpected behavior or any other bug on GitHub Issues will be greatly appreciated, especially if above

contents are attached to the report (as well log files, see Log viewer).

2.1.7 Command line features

Run DatalLab

To run DatalLab from the command line, type the following:

[$ cdl

To show help on command line usage, simply run:

$ cdl --help

—xmlrpcport PORT]
[--verbose {quiet,minimal,normal}]
[h5]

Run Datalab

positional arguments:

- (separated by ',")

usage: app.py [-h] [-b path] [-v] [--unattended] [--screenshot] [--delay DELAY] [--

h5 HDF5 file names (separated by ';'), optionally with dataset name.

(continues on next page)
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7 Installation configuration 5 User configuration

Installation configuration

1 DatalLab v8.9.8

AL S ]

3 Machine type: AMD6U

4 Platform: Windows-18-18.0.19645-5P8

5 Python v3.8.168 (tags/v3.8.10:3d8993a, May
(AMDBY]]

6

7 Invalid dependencies: guidata

g8

S Package

1@

11 alabaster
12 altgraph
13 appdirs
14 astroid
15 asttokens
16 Babel
17 backeall
18 black

19 bleach

B certifi

O M MEMNDMNMNMNMSDD

Bl B R B b
(]
-+
-+
[

3 2021,

11:48:83) [MSC v.1928 64 bit

Fig. 6: Installation and configuration (see “?” menu)

optional arguments:
-h, --help
-b path, --h5browser path

(continued from previous page)

show this help message and exit

path to open with HDF5 browser

-v, --version show Datalab version
--unattended non-interactive mode
--screenshot automatic screenshots

--delay DELAY
--xmlrpcport XMLRPCPORT

XML-RPC port number

--verbose {quiet,minimal,normal}

delay (seconds) before quitting application in unattended mode

verbosity level: for debugging/testing purpose
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Open HDFS5 file at startup

To open HDFS files, or even import only a specified HDF5 dataset, use the following:

$ cdl /path/to/filel.h5
$ cdl /path/to/filel.h5,/path/to/datasetl
$ cdl /path/to/filel.h5,/path/to/datasetl;/path/to/file2.h5, /path/to/dataset2

Open HDF5 browser at startup

To open the HDF5 browser at startup, use one of the following commands:

$ cdl -b /path/to/filel.h5
$ cdl --hSbrowser /path/to/filel.h5

Run DatalLab demo

To execute DatalLab demo, run the following:

[$ cdl-demo

Run unit tests

Note: This test suite is based on guidata.guitest discovery mechanism. It is not compatible with pyfest because most
of the high level tests have to be executed in a separate process (e.g. scenario tests will fail if executed in the same
process as other tests).

To execute all DatalLab unit tests, simply run:

$ cdl-alltests

Datalab v0.9.0 automatic unit tests

Datalab characteristics/environment:
Configuration version: 1.0.0

Path: C:\Dev\Projets\DatalLab\cdl
Frozen: False

Debug: False

Datalab configuration:
Process isolation: enabled
RPC server: enabled
Console: enabled
Available memory threshold: 500 MB
Ignored dependencies: disabled
Processing:
Extract all ROIs in a single signal or image

(continues on next page)
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Test parameters:
Test data path:
Environment:

PYTHONPATH=.
DEBUG=

===[01/51]=== Running
===[02/51]=== Running
===[03/51]=== Running
===[04/51]=== Running
===[05/51]=== Running
===[06/51]===Running

FFT shift: enabled

test
test
test
test
test
test

Selected 51 tests (51 total available)
C:\Dev\Projets\DataLab\cdl\data\tests

CDL_DATA=C:\Dev\Projets\DatalLab_data\

Please wait while test scripts are executed (a few minutes).
Only error messages will be printed out (no message = test OK).

[tests\annotations_app.py]
[tests\annotations_unit.py]
[tests\auto_app.pyl]
[tests\basicl_app.py]
[tests\basic2_app.py]
[tests\basic3_app.py]

(continued from previous page)

Run interactive tests

To execute Datalab interactive tests, run the following:

[$ cdl-tests
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(1]

Tests - cdlapp medule

all_tests.py
backbone\catcher_unit.py
backbone\config_unit.py
backbone\dictlistserial_app.py
backbone\errormsgbox_unit.py
backbone\main_app.py
backbone\procisclation_unit.py
features\embeddedl_unit. py
features\embedded2_unit.py
features\macroeditor_unit.py
features\remoteclient_app.py
features\applauncherilauncherl..
features\applauncher\launcher2..
features\commeniol_unit.py
features\commonio2_unit.py
features\common\io_app.py
features\common\metadata_app.py
features\common\metadata_io_un..
features\common\newobject_unit..
features\common\resultshapes_a..
features‘\common\roi_app.py

features\common'\stat_app.py

Ffoaturashhdfs5hhShrawsar! unit nu

v

«”Run this script

X
Description
o Application embedded test 2
Datalab main window is simply hidden when closing application.
It is shown and raised above other windows when reopening application.
1 from cdlapp.core.gui.main import CDLMainWindow ~
2 from cdlapp.tests.features import embeddedl_unit
y
5 class HostWindow(embeddedl_unit.AbstractHostWindow):
6 """Test main view"""
7
8 def init_edl(self) — None:
9 """Open Datalab test"""
18 if self.cdlapp is None:
11 self.cdlapp = CDLMainWindow(console=False, hide_on_close=True)
12 self.host.log("# Initialized DatalLab window")
13 self.cdlapp.show()
14 else:
15 self.cdlapp.show()
16 self.cdlapp.raise_()
17 self.host.log("= Shown Datalab window")
18
19 def close_cdl(self)} — None:
28 ""rClose Datalab window"""
21 if self.cdlapp is not None:
22 self.host.log("= Closed DatalLab")
23 self.cdlapp.close()
24
25 def closeEvent(self, event) — None:
26 "rrClose event
27
28 Reimplemented from QWidget.closeEvent"""
29 if self.cdlapp is None or self.cdlapp.close_properly():
38 event.accept() v
1len-
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2.2 Signal processing

This section describes the features specific to the signal processing panel. The signal processing panel is the default
panel when Datalab is started.

File Edit Operations Processing Computing Plugins  View 7

FEHe S BPEASS00QTahGibk FOHOROD

Curve panel & % [ signals B8 Images

s derivative(s007) v = goon:

@ s001: lorentz(a=1,sigma=1,mu=0,ymin=0)
@ =002: #t(s001)

@ 003: wiener(s002)

@ =004: derivative(s003)

[ s005: integral(s004)

i F i @ s00&: gaussian_filter(s005)|o=1.000

50 o R, | @ =007 FFt(s0D0B)

[ s008: derivative(s007)

derivative(s007)

rE e e p

Properties

-

-

o
1

Data and metadata Titles and units Computing parameters

Data
IEE 500 x 2 ‘ complex128 ﬂ

4 -10.020, -117.960
F 9.980, 117.953

po) ni

il Metadata

400 freees S

-10 5 0 5 10 [ Show results + Apply

Curve panel Image panel Macro manager

Fig. 7: DatalLab main window: Signal processing view

2.2.1 Menus

This section describes the signal related feature of Datalab, by presenting the different menus and their entries.

“File” menu

The “File” menu allows you to create, open, save and close signals. It also allows you to import and export data from/to
HDFS5 files, and to edit the settings of the current session.
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New signal

B New signal... Ctrl+M
Open signal... Ctrl+ 0
m Save signal... Ctrl+5

#  Open HDFS files...
m Save to HDFS file...
@\ Browse HDFS file...

Settings...

X Quit

Fig. 8: Screenshot of the “File” menu.

Create a new signal from various models:

Model Equation
Zeros yli] =0
Random y[i] € [-0.5,0.5]
A 1 z—x
Gaussian = yo + exp(—=. 2
Y ="y \1/4%0 piz( —))
Lorentzian Yy=1+ —. =
g.Tt 1+ (T)Q
. Re(exp(—22).erfe(—j.2)) . T —Tp—j.o
Voigt =yo + A. with 2 = ———
c §=t V2.0 V2.0
Open signal
Create a new signal from the following supported filetypes:
File type Extensions
Text files AXt, .csv

NumPy arrays .npy

2.2. Signal processing
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Save signal

Save current signal to the following supported filetypes:

File type Extensions

Text files  .csv

Open HDF5 file

Import data from a HDFS file.

Save to HDFS5 file

Export the whole DatalLab session (all signals and images) into a HDF? file.

Browse HDF5 file

Open the HDF5 Browser in a new window to browse and import data from HDFS file.

Settings

Open the the “Settings” dialog box.

L, Settings ? >

General Processing Visualization Ijo Console

Settings for main window and general features

Process isolation
RPC server
Available memory threshold (ME) |5EIIII
Ignore dependency check ]
Third-party plugins

Corcel
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“Edit” menu

2 Mew group...
= Rename group...
Mowe up

Mowve down

Oy Duplicate Ctrl+C
Remove Deel

o Delete all

Copy metadata
& Paste metadata
= |mport metadata...
= Export metadata...
#  Delete object metadata

Add object title to plot
Copy titles to clipboard

Fig. 9: Screenshot of the “Edit” menu.

The “Edit” menu allows you to edit the current signal or group of signals, by adding, removing, renaming, moving up
or down, or duplicating signals. It also manipulates metadata, or handles signal titles.

New group

Create a new group of signals. Images may be moved from one group to another by drag and drop.

Rename group

Rename currently selected group.

Move up

Move current selection up in the list (groups or signals may be selected). If multiple objects are selected, they are
moved together. If a selected signal is already at the top of its group, it is moved to the bottom of the previous group.
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Move down

Move current selection down in the list (groups or signals may be selected). If multiple objects are selected, they are
moved together. If a selected signal is already at the bottom of its group, it is moved to the top of the next group.

Duplicate

Create a new signal which is identical to the currently selected object.

Remove

Remove currently selected signal.

Delete all

Delete all signals.

Copy metadata

Copy metadata from currently selected signal into clipboard.

Paste metadata

Paste metadata from clipboard into selected signal.

Import metadata into signal

Import metadata from a JSON text file.

Export metadata from signal

Export metadata to a JSON text file.

Delete object metadata

Delete metadata from currently selected signal. Metadata contains additionnal information such as Region of Interest

or results of computations
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Add object title to plot

Add currently selected signal title to the associated plot.

Copy titles to clipboard

Copy all signal titles to clipboard as a multiline text. This text may be used for reproducing a processing chain, for

example.

“Operation” menu

fohl

Sum

Average

Difference
Cuadratic difference
Product

Division

Absolute value

Real part

Imaginary part

Convert data type
Log10(y]

Peak detection
Convolution

ROl extraction
Swap XY axes

Fig. 10: Screenshot of the “Operation” menu.

The “Operation” menu allows you to perform various operations on the selected signals, such as arithmetic operations,

peak detection, or convolution.

2.2. Signal processing
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Sum

Create a new signal which is the sum of all selected signals:

M—-1
Ym = Z Yk
k=0
Average

Create a new signal which is the average of all selected signals:
| M-l
Ym = M ];) Yk

Difference

Create a new signal which is the difference of the two selected signals:

Y2 =Y1 — Yo

Product

Create a new signal which is the product of all selected signals:

M—-1

Ym = Hyk

k=0
Division

Create a new signal which is the division of the two selected signals:

_n
Yo

Y2

Absolute value

Create a new signal which is the absolute value of each selected signal:

Yk = |yk71‘
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Real part
Create a new signal which is the real part of each selected signal:
Uk = R(yx-1)
Imaginary part
Create a new signal which is the imaginary part of each selected signal:
Yk = S(yr-1)
Convert data type

Create a new signal which is the result of converting data type of each selected signal.

Note: Data type conversion relies on numpy.ndarray.astype() function with the default parameters (cast-
ing="unsafe’).

Log10(y)

Create a new signal which is the base 10 logarithm of each selected signal:

2z = logyg(2k-1)

Peak detection

Create a new signal from semi-automatic peak detection of each selected signal.

zo0 - Peaks:

13.95 ab
700 - 16.1
a 18.1
500 3 19,5
cop = 21.2
23.8
400 - 27.45

28.45
00 4 31.05 \V/
{318,

= 13.95 X =161 Xx=1x=19.5 x=212

100 a%.20

16 18 20 22

Cancel

Fig. 11: Peak detection dialog: threshold is adjustable by moving the horizontal marker, peaks are detected automati-
cally (see vertical markers with labels indicating peak position)
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Convolution

Create a new signal which is the convolution of each selected signal with respect to another signal.

This feature is based on SciPy’s scipy.signal.convolve function.

ROI extraction

Create a new signal from a user-defined Region of Interest (ROI).

7 :
| !
B0 — e fe -
1
i
- i
500 — e fons :, ______
: i
J . | &
T !
A —feoeeeeereeeee e fieens :;
] i
I !
| !
200 — 5 R
Regions of|inte
W ROID0: 11.509597989940748 < ¥ < 15.280904522613065
- |ROIO1: 36.3[442?11 552764 = ¥ = 41.61005025125628
1

10 20 30

7 Add region of interest

Cancel

Fig. 12: ROI extraction dialog: the ROI is defined by moving the position and adjusting the width of an horizontal
range.
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Swap X/Y axes

Create a new signal which is the result of swapping X/Y data.

“Processing” menu

Mormalize
Derivative
Integral
Thresholding
Clipping

Linear calibration
Gaussian filter
Maving average
Moving median
Wiener filter

FFT

Inverse FFT
Interpolation
Resampling
Detrending
Fitting r

Fig. 13: Screenshot of the “Processing” menu.

The “Processing” menu allows you to perform various processing on the selected signals, such as smoothing, normal-

ization, or interpolation.

Normalize

Create a new signal which is the normalization of each selected signal by maximum, amplitude, sum or energy:

Parameter Normalization
Maximum Y1 = -

maz(yo)
Amplitude Yy = #O(y,) with y{ = yo — min(yo)
Sum Y1 = 0’

1= &N ;5

2 n=q Yo["]

Energy Y = __ Y
N
2n=0 |Y0[][?

2.2. Signal processing
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Derivative

Create a new signal which is the derivative of each selected signal.

Integral

Create a new signal which is the integral of each selected signal.

Linear calibration

Create a new signal which is a linear calibration of each selected signal with respect to X or Y axis:

Parameter Linear calibration
X-axis Ty =a.xg+b
Y-axis y1 =ayo+b

Gaussian filter

Compute 1D-Gaussian filter of each selected signal (implementation based on scipy.ndimage.gaussian_filter1d).

Moving average

Compute moving average on M points of each selected signal, without border effect:

| M-l
yili] = i Z Yoli + J]
=0

Moving median

Compute moving median of each selected signal (implementation based on scipy.signal.medfilt).

Wiener filter

Compute Wiener filter of each selected signal (implementation based on scipy.signal.wiener).

FFT

Create a new signal which is the Fast Fourier Transform (FFT) of each selected signal.
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Inverse FFT

Create a new signal which is the inverse FFT of each selected signal.

Interpolation

Create a new signal which is the interpolation of each selected signal with respect to a second signal X-axis (which
might be the same as one of the selected signals).

The following interpolation methods are available:

Method Description

Linear Linear interpolation, using using NumPy’s interp function

Spline Cubic spline interpolation, using using SciPy’s scipy.interpolate.splev function
Quadratic Quadratic interpolation, using using NumPy’s polyval function

Cubic Cubic interpolation, using using SciPy’s AkimalDInterpolator class

Barycentric Barycentric interpolation, using using SciPy’s Barycentriclnterpolator class

PCHIP Piecewise Cubic Hermite Interpolating Polynomial (PCHIP) interpolation, using using

SciPy’s PchiplInterpolator class

Resampling

Create a new signal which is the resampling of each selected signal.

The following parameters are available:

Parameter Description
Method Interpolation method (see previous section)
Fill value Interpolation fill value (see previous section)
Xmin Minimum X value
Xmax Maximum X value
Mode Resampling mode: step size or number of points
Step size Resampling step size
Number of points Resampling number of points
Detrending

Create a new signal which is the detrending of each selected signal. This features is based on SciPy’s
scipy.signal.detrend function.

The following parameters are available:

Parameter Description

Method Detrending method: ‘linear’ or ‘constant’. See SciPy’s scipy.signal.detrend function.
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Lorentzian, Voigt, Polynomial and Multi-Gaussian fit

Open an interactive curve fitting tool in a modal dialog box.

Model Equation
A 1 x—xo
Gaussian =yo+ ——.exp(—=. 2
Y= 1Yo \1/4%0 pi 5-(———)%)
Lorentzian Y=y + —.
ag.m 1 _|_ (Z‘ _xO)Q
a
) Re(exp(—22).erfe(—j.2)) . x—x0— j.o
Voigt =yo + A. with 2 = ———>—
: J= - V2.0 3 V2.0
. . i T — X0,
Multi-Gaussian =1y + K 0 eap(—=. i48)2
Y=1Yo Z'L_O \/%0_7 p( D) ( o; ) )

“Computing” menu

Edit regions of interest...

Remove regions of interest

oyl Statistics...
Full width at half-maximum

Full width at 1/&*
s Show results...
,f Plot results...
Fig. 14: Screenshot of the “Computing” menu.

The “Computing” menu allows you to perform various computations on the selected signals, such as statistics, full
width at half-maximum, or full width at 1/e2.

Note: In Datalab vocabulary, a “computing” is a feature that computes a scalar result from a signal. This result is
stored as metadata, and thus attached to signal. This is different from a “processing” which creates a new signal from
an existing one.

Edit regions of interest

Open a dialog box to setup multiple Region Of Interests (ROI). ROI are stored as metadata, and thus attached to signal.

ROI definition dialog is exactly the same as ROI extraction (see above): the ROl is defined by moving the position and
adjusting the width of an horizontal range.
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File Edit Operations Processing Computing Plugins View
i m - - =
=BT T S SusemhikELEFPE a®

Curve panel

curve_formats\paracetamol.txt

s\paracetamol. bt

Properties

Data and metadata Titles and units Computing para

floats4

000, 61.975

B Metadata

10 20 0 50 HSth results +" Apply

Curve panel Image panel Macro manager

Fig. 15: A signal with an ROL

Remove regions of interest

Remove all defined ROI for selected object(s).

Statistics

Compute statistics on selected signal and show a summary table.

Full width at half-maximum

Fit data to a Gaussian, Lorentzian or Voigt model using least-square method. Then, compute the full width at half-
maximum value.
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min(y)

aly) Z(y) Jyex
. - | o o

oo I - [N

Format | | Resize | [] Background color

Fig. 16: Example of statistical summary table: each row is associated to an ROI (the first row gives the statistics for

the whole data).
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Fig. 17: The computed result is displayed as an annotated segment.
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Full width at 1/e2

Fit data to a Gaussian model using least-square method. Then, compute the full width at 1/e?.

Note: Computed scalar results are systematically stored as metadata. Metadata is attached to signal and serialized
with it when exporting current session in a HDFS file.

Show results

Show the results of all computations performed on the selected signals. This shows the same table as the one shown
after having performed a computation.

Plot results

Plot the results of computations performed on the selected signals, with user-defined X and Y axes (e.g. plot the FWHM
as a function of the signal index).

“View” menu

%
H

View in a new window
Auto-refresh
' Refresh rnanually F5

Show graphical chject titles

i)
L

Curve anti-aliasing

@ Reset curve styles

*  |mage panel
~  Macro manager

+  Curve panel

+  Main Toclbar
+  Signal Processing Toolbar

Image Processing Toolbar

Fig. 18: Screenshot of the “View” menu.

The “View” menu allows you to visualize the current signal or group of signals. It also allows you to show/hide titles,
to enable/disable anti-aliasing, or to refresh the visualization.
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View in a new window

Open a new window to visualize and the selected signals.

In the separate window, you may visualize your data more comfortably (e.g., by maximizing the window) and you may
also annotate the data.

See also:

See Annotations (Signals) for more details on annotations.

Show graphical object titles

Show/hide titles of computing results or annotations.

Auto-refresh

Automatically refresh the visualization when the data changes. When enabled (default), the plot view is automatically
refreshed when the data changes. When disabled, the plot view is not refreshed until you manually refresh it by clicking
the “Refresh manually” button in the toolbar. Even though the refresh algorithm is optimized, it may still take some
time to refresh the plot view when the data changes, especially when the data set is large. Therefore, you may want to
disable the auto-refresh feature when you are working with large data sets, and enable it again when you are done. This
will avoid unnecessary refreshes.

Refresh manually

Refresh the visualization manually. This triggers a refresh of the plot view, even if the auto-refresh feature is disabled.

Curve anti-aliasing

Enable/disable anti-aliasing of curves. Anti-aliasing makes the curves look smoother, but it may also make them look
less sharp.

Note: Anti-aliasing is enabled by default.

Warning: Anti-aliasing may slow down the visualization, especially when working with large data sets.

Reset curve styles

When plotting curves, DatalLab automatically assigns a color and a line style to each curve. Both parameters are chosen
from a predefined list of colors and line styles, and are assigned in a round-robin fashion.

This menu entry allows you to reset the curve styles, so that the next time you plot curves, the first curve will be assigned
the first color and the first line style of the predefined lists, and the loop will start again from there.
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Other menu entries

Show/hide panels or toolbars.

“?” menu

Online documentation

Log files...

Installation and configuration...

Project home page
Bug report or feature request
Check critical dependencies...

About...

5 @@ 1r O

Fig. 19: Screenshot of the “?” menu.

The “?” menu allows you to access the online documentation, to show log files, to show information regarding your
Datalab installation, and to show the “About Datal.ab” dialog box.

Online or Local documentation

Open the online or local documentation:

i\ sl processinn Ko procesing  Develogitl €4 Search | ctr1 |+ n gi

Datalab User Guide

latalal i a generic signal and image processing software with unigue featuwes designed to meet industrial requirements

are available not anly using the stand-alone application (easily installed thanks 1o the Windows

taller or the Python package] but slso by smbedding it into your own application (see the “embedded tests” for detailed
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Show log files

Open Datalab log viewer
See also:

See Log viewer for more details on log viewer.

About DatalLab installation

Show information regarding your Datal.ab installation (this is typically needed for submitting a bug report).

See also:

See Installation and configuration viewer for more details on this dialog box.

About

Open the “About DatalLab” dialog box:

Datalab +0.9.0
Datalab is a generic signal and image processing platform

Created by Pierre Raybaut
Developed and maintained by Datalab cpen-source project team
Copyright © 2023 CEA, Codra

Advanced configuration:
= AML-RPC server: started (port 11284)

» Process isolation: enabled

Registered plugins:
» Test data (1.0.07: Testing Datalab functionalities

%, About Datalab =

2.2.2 Annotations (Signals)
DatalLab provides an annotation feature for signals (as well as for images).

View 7

_ ®  View in a new window |

How to use the feature:

» Create or open a signal in DatalLab workspace

* Double-click on the signal or select “View in a new window” in “View” menu

* Add annotations (labels, cursors, rectangles and segments)
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» Eventually customize the annotations (right-click, “Parameters™)

¢ Validate your changes by clicking on “OK” button

» That’s it: your annotations are now attached to the signal and will be saved with your DatalLab workspace

A & B L v BB = 5

257 Ttem list
]
i a
2 o Segment
i
J i Rectangle
1.5 —_ ~ Test signal
il [ Grid
=
1 —_
0.5 — MNote something about this
i Baseline
0 _- Musk s vm i allasin s i byimdy sl M.ﬂ.
bt syl o o
- T T I T T T T I T T T T I T T T T I T T T T I T T a.
-1e-05 -S5e-06 [¥] Se-06 1e-05 & v = ﬁ
5
¥ - + Ce im

Cancel

Label Wertical cursor Horizontal cursor  Cross cursor  Segment  Rectangle

Fig. 20: Annotations may be added in the separate view.

Once the annotations have been added in the separate view (see above), they are part of the object (signal) metadata

(see below).

Note: Annotations may be copied from a signal to another by using the “copy/paste metadata” features.
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Main panel & X | Curve panel g X
= signals 4 Images Test signal
s00D; Test signal 2.5
E Test zignal

2 —
Properties ]
1.5
Data and metadata Titles and units ]
=
Data 1
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101k 2 @ floatss e, ]
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Fig. 21: Annotations are now part of the signal metadata.

2.3 Image processing

This section describes the features specific to the image processing panel. The image processing panel can be selected
by clicking on the “Images” tab at the bottom-right of the DatalLab main window.

2.3.1 Menus

This section describes the image related features of Datalab, by presenting the different menus and their associated
functions.

“File” menu

The “File” menu allows you to create, open, save and close images. It also allows you to import and export data from/to
HDFS files, and to edit the settings of the current session.

New image

Create a new image from various models (supported datatypes: uint8, uint16, int16, float32, float64):
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Fig. 22: DatalLab main window: Image processing view
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Fig. 23: Screenshot of the “File” menu.

2.3. Image processing 123



DatalLab, Release 0.11.0

Model Equation

Zeros z[i] =0

Empty Data is directly taken from memory as it is

Random z[i] € [0, Zmaz) Where 2,4, is the datatype maximum value

2D Gaussian

(/& = 20)2 + (y — y0)? — p)?
202

)

z = A.exp(—

Open image

Create a new image from the following supported filetypes:

Save image

File type Extensions
PNG files .png

TIFF files Aif, Ltiff

8-bit images Jjpg, .gif
NumPy arrays .npy

Text files tXt, .csv, .asc

Andor SIF files  .sif
SPIRICON files .scor-data
FXD files xd
Bitmap images  .bmp

Save current image (see “Open image” supported filetypes).

Open HDFS5 file

Import data from a HDFS file.

Save to HDFb5 file

Export the whole DatalLab session (all signals and images) into a HDF? file.

Browse HDF5 file

Open the HDF5 Browser in a new window to browse and import data from HDFS file.
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Settings

Open the the “Settings” dialog box.

L, Settings ? *

General Processing Visualization Ijo Console

Settings for main window and general features

Process isolation

K] &

RPC server

Available memory threshold (MB) |5EIIZI

Ignaore dependency check ]
Third-party plugins
Cancel
“Edit” menu

Mew group...

."|:-:} ﬂﬂ:’

Rename group...

& Moveup

£ Move down

0 Duplicate Ctrl+C
T  Remove Del

“o Delete all

Copy metadata
& Paste metadata
= Import metadata...
=  Export metadata...
®  [elete object metadata

Add object title to plot
Copy titles to clipboard
Fig. 24: Screenshot of the “Edit” menu.

The “Edit” menu allows you to edit the current image or group of images, by adding, removing, renaming, moving up
or down, or duplicating images. It also manipulates metadata, or handles image titles.
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New group

Create a new group of images. Images may be moved from one group to another by drag and drop.

Rename group

Rename currently selected group.

Move up

Move current selection up in the list (groups or images may be selected). If multiple objects are selected, they are
moved together. If a selected image is already at the top of its group, it is moved to the bottom of the previous group.

Move down

Move current selection down in the list (groups or images may be selected). If multiple objects are selected, they are
moved together. If a selected image is already at the bottom of its group, it is moved to the top of the next group.

Duplicate

Create a new image which is identical to the currently selected object.

Remove

Remove currently selected image.

Delete all

Delete all images.

Copy metadata

Copy metadata from currently selected image into clipboard.

Paste metadata

Paste metadata from clipboard into selected image.
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Import metadata into image

Import metadata from a JSON text file.

Export metadata from image

Export metadata to a JSON text file.

Delete object metadata

Delete metadata from currently selected image. Metadata contains additionnal information such as Region of Interest

or results of computations

Add object title to plot

Add currently selected image title to the associated plot.

Copy titles to clipboard

Copy all image titles to clipboard as a multiline text. This text may be used for reproducing a processing chain, for

example.

“Operation” menu

The “Operation” menu allows you to perform various operations on the current image or group of images. It also allows

you to extract profiles, distribute images on a grid, or resize images.

Sum

Create a new image which is the sum of all selected images:
M-1
ZM = Z Zk
k=0

Average

Create a new image which is the average of all selected images:

2.3. Image processing
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Sum

Average

Difference
Quadratic difference
Product

Division

Absolute value

Real part

Imaginary part

Convert data type

Log10(y)
Log10{z+n)

Flat-field correction
Rotation r
Intensity profiles »
Distribute on a grid...

Reset image positions

Resize

E:: Pixel binning

(£ ROl extraction
Swap XY axes

Fig. 25: Screenshot of the “Operation” menu.
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Difference

Create a new image which is the difference of the two selected images:

Zo =21 — 20

Quadratic difference

Create a new image which is the quadratic difference of the two selected images:

21 — 20

V2

Z9 =

Product

Create a new image which is the product of all selected images:
M—1
ZM = H Zk
k=0
Division
Create a new image which is the division of the two selected images:
21

zo =
20

Absolute value
Create a new image which is the absolute value of each selected image:
2 = |2k—1]
Real part
Create a new image which is the real part of each selected image:
2z = R(zK-1)
Imaginary part

Create a new image which is the imaginary part of each selected image:

ZE = %(Zkfl)
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Convert data type

Create a new image which is the result of converting data type of each selected image.

Note: Data type conversion relies on numpy.ndarray.astype() function with the default parameters (cast-
ing="unsafe’).

Log10(z)
Create a new image which is the base 10 logarithm of each selected image:

2 = logo(2r-1)

Log10(z+n)
Create a new image which is the Log10(z+n) of each selected image (avoid Log10(0) on image background):

2 =log o (zk—1 +n)

Flat-field correction

Create a new image which is flat-field correction of the two selected images:

20 .

— .Zf if 20 > Zthreshold .
21 = Zf

20 otherwise

where 2 is the raw image, z is the flat field image, 2¢xreshota i an adjustable threshold and Zy is the flat field image
average value:

i 24 (i, j
! Nrow~Ncol ; f( )

Note: Raw image and flat field image are supposedly already corrected by performing a dark frame subtraction.

Rotation

Create a new image which is the result of rotating (90°, 270° or arbitrary angle) or flipping (horizontally or vertically)
data.
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Intensity profiles

Line profile extraction
Extract an horizontal or vertical profile from each selected image, and create new signals from these profiles.

Average profile extraction
Extract an horizontal or vertical profile averaged over a rectangular area, from each selected image, and create

new signals from these profiles.

Radial profile extraction
Extract a radial profile from each selected image, and create new signals from these profiles.

The following parameters are available:

Parameter Description

Center Center around which the radial profile is computed: centroid, image center, or
manual

X X coordinate of the center (if manual), in pixels

Y Y coordinate of the center (if manual), in pixels

Distribute on a grid

Distribute selected images on a regular grid.

Reset image positions

Reset selected image positions to first image (x0, y0) coordinates.

Resize

Create a new image which is a resized version of each selected image.

Pixel binning

Combine clusters of adjacent pixels, throughout the image, into single pixels. The result can be the sum, average,
median, minimum, or maximum value of the cluster.

ROI extraction

Create a new image from a user-defined Region of Interest.
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Fig. 26: ROI extraction dialog: the ROI is defined by moving the position and adjusting the size of a rectangle shape.
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Swap X/Y axes

Create a new image which is the result of swapping X/Y data.

“Processing” menu

Thresheolding
Clipping

Linear calibration
Gaussian filter
Moving average
Moving median
Wiener filter

FFT

Inverse FFT
Butterworth filter
Exposure r
Restoration r
Morphology r
Edges r

Fig. 27: Screenshot of the “Processing” menu.

The “Processing” menu allows you to perform various processing on the current image or group of images: it allows
you to apply filters, to perform exposure correction, to perform denoising, to perform morphological operations, and
SO on.

Linear calibration

Create a new image which is a linear calibration of each selected image with respect to Z axis:

Parameter Linear calibration

Z-axis z1=a.29+b

Thresholding

Apply the thresholding to each selected image.
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Clipping

Apply the clipping to each selected image.

Moving average

Compute moving average of each selected image (implementation based on scipy.ndimage.uniform_filter).

Moving median

Compute moving median of each selected image (implementation based on scipy.signal.medfilt).

Wiener filter

Compute Wiener filter of each selected image (implementation based on scipy.signal.wiener).

FFT

Create a new image which is the Fast Fourier Transform (FFT) of each selected image.

Inverse FFT

Create a new image which is the inverse FFT of each selected image.

Butterworth filter

Perform Butterworth filter on an image (implementation based on skimage.filters.butterworth)

Exposure

Gamma correction
Apply gamma correction to each selected image (implementation based on skimage.exposure.adjust_gamma)

Logarithmic correction
Apply logarithmic correction to each selected image (implementation based on skimage.exposure.adjust_log)

Sigmoid correction
Apply sigmoid correction to each selected image (implementation based on skimage.exposure.adjust_sigmoid)

Histogram equalization
Equalize image histogram levels (implementation based on skimage.exposure.equalize_hist)

Adaptive histogram equalization
Equalize image histogram levels using Contrast Limited Adaptive Histogram Equalization (CLAHE) algorithm
(implementation based on skimage.exposure.equalize_adapthist)

Intensity rescaling
Stretch or shrink image intensity levels (implementation based on skimage.exposure.rescale_intensity)
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Restoration

Total variation denoising
Denoise ~ image  using  Total = Variation  algorithm  (implementation  based on
age.restoration.denoise_tv_chambolle)

Bilateral filter denoising
Denoise image using bilateral filter (implementation based on skimage.restoration.denoise_bilateral)

Wavelet denoising
Perform wavelet denoising on image (implementation based on skimage.restoration.denoise_wavelet)

White Top-Hat denoising
Denoise image by subtracting its white top hat transform (using a disk footprint)

All denoising methods

skim-

Perform all denoising methods on image. Combined with the “distribute on a grid” option, this allows to compare

the different denoising methods on the same image.

Morphology

White Top-Hat (disk)
Perform white top hat transform of an image, using a disk footprint (implementation based on
age.morphology.white_tophat)

Black Top-Hat (disk)
Perform black top hat transform of an image, using a disk footprint (implementation based on
age.morphology.black_tophat)

Erosion (disk)
Perform morphological erosion on an image, using a disk footprint (implementation based on
age.morphology.erosion)

Dilation (disk)
Perform morphological dilation on an image, using a disk footprint (implementation based on
age.morphology.dilation)

Opening (disk)
Perform morphological opening on an image, using a disk footprint (implementation based on
age.morphology.opening)

Closing (disk)
Perform morphological closing on an image, using a disk footprint (implementation based on
age.morphology.closing)

All morphological operations

skim-

skim-

skim-

skim-

skim-

skim-

Perform all morphological operations on an image, using a disk footprint. Combined with the “distribute on a

grid” option, this allows to compare the different morphological operations on the same image.
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Edges

Roberts filter
Perform edge filtering on an image, using the Roberts algorithm (implementation based on skim-
age filters.roberts)

Prewitt filter
Perform edge filtering on an image, using the Prewitt algorithm (implementation based on skimage.filters.prewitt)

Prewitt filter (horizontal)
Find the horizontal edges of an image, using the Prewitt algorithm (implementation based on skim-
age. filters.prewitt_h)

Prewitt filter (vertical)

Find the vertical edges of an image, using the Prewitt algorithm (implementation based on skim-
age.filters.prewitt_v)

Sobel filter
Perform edge filtering on an image, using the Sobel algorithm (implementation based on skimage.filters.sobel)

Sobel filter (horizontal)
Find the horizontal edges of an image, using the Sobel algorithm (implementation based on skim-
age.filters.sobel_h)

Sobel filter (vertical)
Find the vertical edges of an image, using the Sobel algorithm (implementation based on skimage.filters.sobel _v)

Scharr filter
Perform edge filtering on an image, using the Scharr algorithm (implementation based on skimage.filters.scharr)

Scharr filter (horizontal)
Find the horizontal edges of an image, using the Scharr algorithm (implementation based on skim-
age.filters.scharr_h)

Scharr filter (vertical)
Find the vertical edges of an image, using the Scharr algorithm (implementation based on skim-
age.filters.scharr_v)

Farid filter
Perform edge filtering on an image, using the Farid algorithm (implementation based on skimage.filters.farid)

Farid filter (horizontal)
Find the horizontal edges of an image, using the Farid algorithm (implementation based on skim-
age.filters.farid_h)

Farid filter (vertical)
Find the vertical edges of an image, using the Farid algorithm (implementation based on skimage.filters.farid_v)

Laplace filter
Perform edge filtering on an image, using the Laplace algorithm (implementation based on skim-
age.filters.laplace)

All edges filters
Perform all edge filtering algorithms (see above) on an image. Combined with the “distribute on a grid” option,
this allows to compare the different edge filters on the same image.

Canny filter
Perform edge filtering on an image, using the Canny algorithm (implementation based on skimage.feature.canny)
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Fig. 28: Screenshot of the “Computing” menu.

Edit regions of interest...

Remowve regions of interest

Statistics...
Centroid

Minimurn enclosing circle center

20 peak detection
Contour detection
Circle Hough transform

Blob detection r

Show results...

Plot results...

The “Computing” menu allows you to perform various computations on the current image or group of images. It also
allows you to compute statistics, to compute the centroid, to detect peaks, to detect contours, and so on.

Note: In Datal.ab vocabulary, a “computing” is a feature that computes a scalar result from an image. This result is
stored as metadata, and thus attached to image. This is different from a “processing” which creates a new image from

an existing one.

Edit regions of interest

Open a dialog box to setup multiple Region Of Interests (ROI). ROI are stored as metadata, and thus attached to image.

ROI definition dialog is exactly the same as ROI extraction (see above).

Remove regions of interest

Remove all defined ROI for selected object(s).

Statistics

Compute statistics on selected image and show a summary table.
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Fig. 29: An image with ROIL.
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Close

Fig. 30: Example of statistical summary table: each row is associated to an ROI (the first row gives the statistics for
the whole data).
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Centroid

Compute image centroid using a Fourier transform method (as discussed by Weisshaar et al.). This method is quite
insensitive to background noise.

Minimum enclosing circle center

Compute the circle contour enclosing image values above a threshold level defined as the half-maximum value.

2D peak detection

Automatically find peaks on image using a minimum-maximum filter algorithm.

Test image with peaks

1050

1000

500

1000

a50
1500

a00

2000

] 500 1000 1500 2000

Fig. 31: Example of 2D peak detection.
See also:

See 2D Peak Detection for more details on algorithm and associated parameters.

Contour detection

Automatically extract contours and fit them using a circle or an ellipse, or directly represent them as a polygon.
See also:

See Contour Detection for more details on algorithm and associated parameters.
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Fig. 32: Example of contour detection.
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Note: Computed scalar results are systematically stored as metadata. Metadata is attached to image and serialized
with it when exporting current session in a HDF?5 file.

Circle Hough transform

Detect  circular  shapes using circle Hough transform  (implementation based on  skim-
age.transform.hough_circle_peaks).

Blob detection

Blob detection (DOG)
Detect blobs using Difference of Gaussian (DOG) method (implementation based on skimage.feature.blob_dog).

Blob detection (DOH)
Detect blobs using Determinant of Hessian (DOH) method (implementation based on skimage.feature.blob_doh).

Blob detection (LOG)
Detect blobs using Laplacian of Gaussian (LOG) method (implementation based on skimage.feature.blob_log).

Blob detection (OpenCV)
Detect blobs using OpenCV implementation of SimpleBlobDetector.

Show results

Show the results of all computations performed on the selected images. This shows the same table as the one shown
after having performed a computation.

Plot results

Plot the results of computations performed on the selected images, with user-defined X and Y axes (e.g. plot the contour
circle radius as a function of the image number).

“View” menu

The “View” menu allows you to visualize the current image or group of images. It also allows you to show/hide titles,
to show/hide the contrast panel, to refresh the visualization, and so on.

View in a new window

Open a new window to visualize and the selected images.

In the separate window, you may visualize your data more comfortably (e.g., by maximizing the window) and you may
also annotate the data.

See also:

See Annotations (Images) for more details on annotations.
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View in a new window

Auta-refresh

"
|

Refresh manually F5
Show graphical object titles

Show contrast panel

Curve panel

Macro manager

L 4L @il D

Image panel

<

Main Toolbar
Signal Processing Toolbar

¥  Image Processing Toolbar

Fig. 33: Screenshot of the “View” menu.

Show graphical object titles

Show/hide titles of computing results or annotations.

Auto-refresh

Automatically refresh the visualization when the data changes. When enabled (default), the plot view is automatically
refreshed when the data changes. When disabled, the plot view is not refreshed until you manually refresh it by clicking
the “Refresh manually” button in the toolbar. Even though the refresh algorithm is optimized, it may still take some
time to refresh the plot view when the data changes, especially when the data set is large. Therefore, you may want to
disable the auto-refresh feature when you are working with large data sets, and enable it again when you are done. This
will avoid unnecessary refreshes.

Refresh manually

Refresh the visualization manually. This triggers a refresh of the plot view, even if the auto-refresh feature is disabled.
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Show contrast panel

Show/hide contrast adjustment panel.

Other menu entries

Show/hide panels or toolbars.

“?” menu

Online documentation

L&)

Log files...

Installation and configuration...

Project home page

&@é s

Bug report or feature request
Check critical dependencies...

About...

Fig. 34: Screenshot of the “?”” menu.

The “?” menu allows you to access the online documentation, to show log files, to show information regarding your
Datalab installation, and to show the “About Datal.ab” dialog box.

Online or Local documentation

Open the online or local documentation:
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f‘; sctting starfed  General features  Signal processing  Image processing  Development O Search ctr1 |4+ ® & i

Datalab User Guide

latalab i a generic signal and image processing softeare with migue features designed to meet industrial res

tatalsb Main features are available not only using the stand-alone application (easily installed thanks 1o the ‘Wirdows

wstaller or the Python packsgs] but slso by smbedding it into your own application (s=e the “embedded tests” for detailed

Show log files

Open DatalLab log viewer
See also:

See Log viewer for more details on log viewer.

About Datalab installation

Show information regarding your Datal.ab installation (this is typically needed for submitting a bug report).
See also:

See Installation and configuration viewer for more details on this dialog box.

About

Open the “About DatalLab” dialog box:
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L. About Datalab et

Datalab +0.9.0
Datalak is a generic signal and image processing platform

Created by Pierre Raybaut
Developed and maintained by Datalab open-source project team
Copyright © 2023 CEA, Codra

Advanced configuration:
= XML-RPC server: started (port 11334)
» Process isolation: enabled

Registered plugins:
» Test data (1.0.07: Testing Datalab functionalities

2.3.2 2D Peak Detection

DataLab provides a “2D Peak Detection” feature which is based on a minimum-maximum filter algorithm.

Meighborhoods size (pixels) |5IZI| |

Relative threshold |III. 5 |

|:| Create regions of interest

Cancel

Fig. 35: 2D peak detection parameters.

How to use the feature:
* Create or open an image in DatalLab workspace
* Select “2d peak detection” in “Computing” menu
* Enter parameters “Neighborhoods size” and “Relative threhold”

* Check “Create regions of interest” if you want a ROI defined for each detected peak (this may become
useful when using another computation afterwards on each area around peaks, e.g. contour detection)

Results are shown in a table:
» Each row is associated to a detected peak
e First column shows the ROI index (0 if no ROI is defined on input image)
» Second and third columns show peak coordinates

The 2d peak detection algorithm works in the following way:

e First, the minimum and maximum filtered images are computed using a sliding window al-
gorithm with a user-defined size (implementation based on scipy.ndimage.minimum_filter and
scipy.ndimage.maximum_filter)
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2 Results - NumPy array (read only) — | >

¥

ROI X
o [T TR o

Format | | Resize | [+] Background calor

Fig. 36: 2d peak detection results (see test “peak2d_app.py”)
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Curve panel Image panel

Fig. 37: Example of 2D peak detection.
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old
» Resulting image features are labeled using scipy.ndimage.label
» Peak coordinates are then obtained from labels center
* Duplicates are eventually removed
The 2d peak detection parameters are the following:
* “Neighborhoods size”: size of the sliding window (see above)
» “Relative threshold”: detection threshold

Feature is based on get_2d_peaks_coords function from cdl .algorithms module:

(def get_2d_peaks_coords(

data: np.ndarray, size: int | None = None, level: float = 0.5
) -> np.ndarray:

"""Detect peaks in image data, return coordinates.

If neighborhoods size is None, default value is the highest value
between 50 pixels and the 1/40th of the smallest image dimension.

Detection threshold level is relative to difference
between data maximum and minimum values.

Args:
data: Input data
size: Neighborhood size (default: None)
level: Relative level (default: 0.5)

Returns:
Coordinates of peaks
if size is None:
size = max(min(data.shape) // 40, 50)
data_max = spf.maximum_filter(data, size)
data_min = spf.minimum_filter(data, size)
data_diff = data_max - data_min
diff = (data_max - data_min) > get_absolute_level(data_diff, level)
maxima = data == data_max
maxima[diff == 0] = 0
labeled, _num _objects = spi.label(maxima)
slices = spi.find_objects(labeled)
coords []
for dy, dx in slices:
x_center = int(0.5 * (dx.start + dx.stop - 1))
y_center = int(0.5 * (dy.start + dy.stop - 1))
coords.append((x_center, y_center))
if len(coords) > 1:
# Eventually removing duplicates
dist = distance_matrix(coords)

=0 [11)):

(continues on next page)

for index in reversed(np.unique(np.where((dist < size) & (dist >.

Then, the difference between the maximum and minimum filtered images is clipped at a user-defined thresh-
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(continued from previous page)

coords.pop(index)
return np.array(coords)

2.3.3 Contour Detection

DataLab provides a “Contour Detection” feature which is based on the marching cubes algorithm.

%, Contour ? *

Relative threshald |III. 5

Shape

Fig. 38: Contour detection parameters.

How to use the feature:
» Create or open an image in DatalLab workspace
» Eventually create a ROI around the target area
¢ Select “Contour detection” in “Computing” menu

» Enter parameter “Shape” (“Ellipse”, “Circle” or “Polygon”)

4 Results - MumPy array (read only) — | pd
%0 y0 ®1 ¥l xd
iD01: contour_shape | ) 118 158.125 189 156.375 108
i007: contour_shape ] 168.75 199 160 1958.625 159
< >

Format Resize Background color

Close

Fig. 39: Contour detection results (see test “contour_app.py”)

Results are shown in a table:
¢ Each row is associated to a contour

¢ First column shows the ROI index (0 if no ROI is defined on input image)
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¢ Other columns show contour coordinates: 4 columns for circles (coordinates of diameter), 8 columns for
ellipses (coordinates of diameters)

L, Datalab* — O >
File Edit Operations Processing Computing  Plugins  View 7
L i = = = o
rHe & BEESSO I = Bk FRO
Image panel g X A Signals [} Images

v 2 g001:
B i001: Untitled image

Untitled image

Properties

Data Origin / Pixel spacing Titles ;4 1 #

Data
1 woxo00 @ unts | N
4 0.000
1 141000
£ ] 50 100 150 200
- (P Contrast adjustment tool - | Metadata
5000 | : | -
a i
& | s M
i
dt _ l
o T T T I T T T I T T T I T T T I T T T I T T T I T T T I
0 20 4D &0 80 100 120 40 =
¥ u Show results <« apply
Curve panel  Image panel ~ Macro manager

A Plugins: 1 oo XML-RPC: 32144 28 Memory: T0%

Fig. 40: Example of contour detection.

The contour detection algorithm works in the following way:

* First, iso-valued contours are computed (implementation based on skim-
age.measure.find_contours.find_contours)

* Then, each contour is fitted to the closest ellipse (or circle)

Feature is based on get_contour_shapes function from cdl.algorithms module:

def get_contour_shapes(

data: np.ndarray | ma.MaskedArray, shape: str = "ellipse", level: float =_
0.5
) -> np.ndarray:

"""Find iso-valued contours in a 2D array, above relative level (.5 means.
—FWHM) ,

(continues on next page)
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(continued from previous page)

then fit contours with shape (‘ellipse' or 'circle')

Args:
data: Input data
shape: Shape to fit. Valid values: 'circle', 'ellipse', 'polygon'.
(default: 'ellipse')
level: Relative level (default: 0.5)

Returns:
Coordinates of shapes

i

# pylint: disable=too-many-locals

assert shape in ('"circle", "ellipse", "polygon")
contours = measure.find_contours(data, level=get_absolute_level(data,..
—level))

coords = []
for contour in contours:
# ‘contour” is a (N, 2) array (rows, cols): we need to check if all.
—those
# coordinates are masked: if so, we skip this contour
if isinstance(data, ma.MaskedArray) and np.all(
data.mask[contour[:, 0].astype(int), contour[:, 1].astype(int)]
):
continue
if shape == "circle":
model = measure.CircleModel ()
if model.estimate(contour):
yc, Xc, r = model.params
if r <= 1.0:
continue
coords.append([xc, yc, r])
elif shape == "ellipse":
model = measure.EllipseModel ()
if model.estimate(contour):
yc, xc, b, a, theta = model.params
if a<=1.0 or b <= 1.0:
continue
coords.append([xc, yc, a, b, theta])
elif shape == "polygon":
# “contour’ is a (N, 2) array (rows, cols): we need to convert it
# to a list of x, y coordinates flattened in a single list
coords.append(contour[:, ::-1].flatten())
else:
raise NotImplementedError(f"Invalid contour model {model}")
if shape == "polygon":
# ‘coords’ is a list of arrays of shape (N, 2) where N is the number of.
—points
# that can vary from one array to another, so we need to padd with.,
—NaNs each
# array to get a regular array:
max_len = max(coord.shape[0] for coord in coords)
arr = np.full((len(coords), max_len), np.nan)

(continues on next page)
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for i_row, coord in enumerate(coords):
arr[i_row, : coord.shape[0]] = coord
return arr
return np.array(coords)

2.3.4 Annotations (Images)

DatalLab provides an annotation feature for images (as well as for signals).

View 7

™ View in a new window

How to use the feature:
 Create or open an image in DatalLab workspace
* Double-click on the image or select “View in a new window” in “View” menu
* Add annotations (labels, rectangles, circles, etc.)
» Eventually customize the annotations (right-click, “Parameters”)
* Validate your changes by clicking on “OK” button
e That’s it: your annotations are now attached to the image and will be saved with your DatalLab workspace

Once the annotations have been added in the separate view (see above), they are part of the object (image) metadata
(see below).

Note: Annotations may be copied from an image to another by using the “copy/paste metadata” features.
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Fig. 41: Annotations may be added in the separate view.
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Fig. 42: Annotations are now part of the image metadata.
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CHAPTER
THREE

API

The public Application Programming Interface (API) of Datalab offers a set of functions to access the DatalLab fea-
tures. Those functions are available in various submodules of the cdl package. The following table lists the available
submodules and their purpose:

Submodule Purpose

cdl.algorithms  Algorithms for data analysis, which operates on NumPy arrays

cdl.param Convenience module to access the Datal.ab sets of parameters (instances of guidata.
dataset.DataSet objects)

cdl.obj Convenience module to access the DatalLab objects (cdl.obj.SignalObj or cdl.obj.
ImageObj) and related functions

cdl.core. Computation functions, which operate on Datal.ab objects (cdl.obj.SignalObj or cdl.

computation obj.ImageObj)

cdl.proxy Proxy objects to access the Datal.ab interface from a Python script or a remote application

3.1 Algorithms (cdl.algorithms)

This package contains the algorithms used by the Datalab project. Those algorithms operate directly on NumPy arrays
and are designed to be used in the DatalLab pipeline, but can be used independently as well.

See also:

The cdl.algorithms package is the main entry point for the DatalLab algorithms when manipulating NumPy arrays.
See the cdl.core.computation package for algorithms that operate directly on DatalLab objects (i.e. cdl.obj.
SignalObj and cdl.obj.ImageObj).

The algorithms are organized in subpackages according to their purpose. The following subpackages are available:
e cdl.algorithms.signal: Signal processing algorithms
e cdl.algorithms.image: Image processing algorithms
e cdl.algorithms.datatypes: Data type conversion algorithms
* cdl.algorithms.coordinates: Coordinate conversion algorithms

e cdl.algorithms. fit: Fitting algorithms
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3.1.1 Signal Processing Algorithms

cdl.algorithms.signal.moving_average(y: ndarray, n: int) — ndarray

Compute moving average.
Parameters
* y (numpy.ndarray) — Input array
* n(int)— Window size

Returns
Moving average

Return type
np.ndarray

cdl.algorithms.signal.derivative (x: ndarray, y: ndarray) — ndarray

Compute numerical derivative.
Parameters
e X (numpy.ndarray) — X data
e y (numpy.ndarray)—Y data

Returns
Numerical derivative

Return type
np.ndarray

cdl.algorithms.signal.normalize(yin: ndarray, parameter: str = 'maximum') — ndarray

Normalize input array to a given parameter.
Parameters
* yin (numpy.ndarray) — Input array

* parameter (str | None)— Normalization parameter. Defaults to “maximum”. Supported
values: ‘maximum’, ‘amplitude’, ‘sum’, ‘energy’

Returns
Normalized array

Return type
np.ndarray

cdl.algorithms.signal.xy_f£fft(x: ndarray, y: ndarray, shift: bool = True) — tuple[ndarray, ndarray]
Compute FFT on X,Y data.

Parameters
e X (numpy.ndarray)— X data
e y (numpy.ndarray)—Y data

e shift (hool | None)— Shift the zero frequency to the center of the spectrum. Defaults to
True.

Returns
X.,Y data

Return type
tuple[np.ndarray, np.ndarray]
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cdl.algorithms.signal.xy_ifft(x: ndarray, y: ndarray, shift: bool = True) — tuple[ndarray, ndarray]
Compute iFFT on X,Y data.

Parameters
* X (numpy.ndarray) — X data
e y (numpy.ndarray)—Y data

» shift (bool | None) - Shift the zero frequency to the center of the spectrum. Defaults to
True.

Returns
X,Y data

Return type
tuple[np.ndarray, np.ndarray]

cdl.algorithms.signal .peak_indexes(y, thres: float = 0.3, min_dist: int = 1, thres_abs: bool = False) —
ndarray

Peak detection routine.

Finds the numeric index of the peaks in y by taking its first order difference. By using thres and min_dist param-
eters, it is possible to reduce the number of detected peaks. y must be signed.

Parameters
* y(ndarray (signed))- 1D amplitude data to search for peaks.

» thres (float between [0., 1.])- Normalized threshold. Only the peaks with ampli-
tude higher than the threshold will be detected.

e min_dist (int) - Minimum distance between each detected peak. The peak with the highest
amplitude is preferred to satisfy this constraint.

* thres_abs (boolean) — If True, the thres value will be interpreted as an absolute value,
instead of a normalized threshold.

Returns
Array containing the numeric indexes of the peaks that were detected

Return type
ndarray

cdl.algorithms.signal.xpeak(x: ndarray,y: ndarray) — float

Return default peak X-position (assuming a single peak).
Parameters
e X (numpy.ndarray) — X data
e y (numpy.ndarray)—Y data

Returns
Peak X-position

Return type
float

cdl.algorithms.signal.interpolate(x: ndarray, y: ndarray, xnew: ndarray, method: str, fill_value: float |
None = None) — ndarray

Interpolate data.

Parameters
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e X (numpy.ndarray) — X data
e y (numpy.ndarray) - Y data
e xnew (numpy.ndarray)— New X data

* method (str)— Interpolation method. Valid values are ‘linear’, ‘spline’, ‘quadratic’, ‘cubic’,
‘barycentric’, ‘pchip’

e fill_value (float | None) — Fill value. Defaults to None. This value is used to fill in
for requested points outside of the X data range. It is only used if the method argument is
‘linear’, ‘cubic’ or ‘pchip’.

3.1.2 Image Processing Algorithms

cdl.algorithms.image.scale_data_to_min_max(data: ndarray, zmin: float | int, zmax: float | int) — ndarray

Scale array data to fit [zmin, zmax] dynamic range
Parameters
* data - Input data
* zmin — Minimum value of output data
* zmax — Maximum value of output data

Returns
Scaled data

cdl.algorithms.image.z_££ft(z: ndarray, shift: bool = True) — ndarray
Compute FFT of complex array z

Parameters
e z — Input data
» shift — Shift zero frequency to center (default: True)

Returns
FFT of input data

cdl.algorithms.image.z_ifft(z: ndarray, shift: bool = True) — ndarray
Compute inverse FFT of complex array z

Parameters
e Z — Input data
 shift - Shift zero frequency to center (default: True)

Returns
Inverse FFT of input data

cdl.algorithms.image.binning(data: ndarray, binning_x: int, binning_y: int, operation: str, dtype=None) —
ndarray

Perform image pixel binning
Parameters
» data - Input data
* binning_x - Binning factor along x-axis

* binning_y — Binning factor along y-axis
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» operation - Binning operation (sum, average, median, min, max)
» dtype — Output data type (default: None, i.e. same as input)

Returns
Binned data

cdl.algorithms.image.flatfield(rawdata: ndarray, flatdata: ndarray, threshold: float | None = None) —
ndarray
Compute flat-field correction
Parameters
» rawdata — Raw data
» flatdata - Flat-field data
e threshold - Threshold for flat-field correction (default: None)

Returns
Flat-field corrected data

cdl.algorithms.image.get_centroid_fourier(data: ndarray) — tuple[float, float]
Return image centroid using Fourier algorithm

Parameters
data — Input data

Returns
Centroid coordinates (row, col)

cdl.algorithms.image.get_absolute_level (data: ndarray, level: float) — float
Return absolute level

Parameters
 data - Input data
e level — Relative level (0.0 to 1.0)

Returns
Absolute level

cdl.algorithms.image.get_enclosing_circle(data: ndarray, level: float = 0.5) — tuple[int, int, float]

Return (x, y, radius) for the circle contour enclosing image values above threshold relative level (.5 means

FWHM)
Parameters
* data - Input data
¢ level — Relative level (default: 0.5)
Returns

A tuple (X, y, radius)

Raises
ValueError — No contour was found

cdl.algorithms.image.get_radial_profile(data: ndarray, center: tuple[int, int]) — tuple[ndarray, ndarray]

Return radial profile of image data
Parameters

* data - Input data (2D array)
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» center — Coordinates of the center of the profile (x, y)

Returns
Radial profile (X, Y) where X is the distance from the center (1D array) and Y is the average
value of pixels at this distance (1D array)

cdl.algorithms.image.distance_matrix(coords: list) — ndarray

Return distance matrix from coords

Parameters
coords — List of coordinates

Returns
Distance matrix

cdl.algorithms.image.get_2d_peaks_coords (data: ndarray, size: int | None = None, level: float = 0.5) —
ndarray
Detect peaks in image data, return coordinates.

If neighborhoods size is None, default value is the highest value between 50 pixels and the 1/40th of the smallest
image dimension.

Detection threshold level is relative to difference between data maximum and minimum values.
Parameters
 data - Input data
» size — Neighborhood size (default: None)
* level — Relative level (default: 0.5)

Returns
Coordinates of peaks

cdl.algorithms.image.get_contour_shapes(data: ndarray | MaskedArray, shape: str = "ellipse’, level: float
= (0.5) — ndarray

Find iso-valued contours in a 2D array, above relative level (.5 means FWHM), then fit contours with shape
(‘ellipse’ or ‘circle’)

Parameters
* data - Input data
 shape — Shape to fit. Valid values: ‘circle’, ‘ellipse’, ‘polygon’. (default: ‘ellipse’)
¢ level — Relative level (default: 0.5)

Returns
Coordinates of shapes

cdl.algorithms.image.get_hough_circle_peaks (data: ndarray, min_radius: float | None = None,
max_radius: float | None = None, nb_radius: int | None =
None, min_distance: int = 1) — ndarray

Detect peaks in image from circle Hough transform, return circle coordinates.
Parameters
* data - Input data
e min_radius — Minimum radius (default: None)
* max_radius — Maximum radius (default: None)

e nb_radius — Number of radii (default: None)
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e min_distance — Minimum distance between circles (default: 1)

Returns
Coordinates of circles

cdl.algorithms.image.find_blobs_dog(data: ndarray, min_sigma: float = 1, max_sigma: float = 30, overlap:
float = 0.5, threshold_rel: float = 0.2, exclude_border: bool = True)
— ndarray
Finds blobs in the given grayscale image using the Difference of Gaussians (DoG) method.
Parameters
» data - The grayscale input image.
* min_sigma — The minimum blob radius in pixels.

* max_sigma — The maximum blob radius in pixels.

* overlap — The minimum overlap between two blobs in pixels. For instance, if two blobs are
detected with radii of 10 and 12 respectively, and the overlap is set to 0.5, then the area of
the smaller blob will be ignored and only the area of the larger blob will be returned.

» threshold_rel — The absolute lower bound for scale space maxima. Local maxima smaller
than threshold_rel are ignored. Reduce this to detect blobs with less intensities.

» exclude_border — If True, exclude blobs from detection if they are too close to the border
of the image. Border size is min_sigma.

Returns
Coordinates of blobs

cdl.algorithms.image.find_blobs_doh(data: ndarray, min_sigma: float = 1, max_sigma: float = 30, overlap:
float = 0.5, log_scale: bool = False, threshold_rel: float = 0.2) —
ndarray

Finds blobs in the given grayscale image using the Determinant of Hessian (DoH) method.
Parameters
» data - The grayscale input image.
* min_sigma — The minimum blob radius in pixels.
* max_sigma — The maximum blob radius in pixels.

* overlap — The minimum overlap between two blobs in pixels. For instance, if two blobs are
detected with radii of 10 and 12 respectively, and the overlap is set to 0.5, then the area of
the smaller blob will be ignored and only the area of the larger blob will be returned.

* log_scale —If True, the radius of each blob is returned as sqrt (sigma) for each detected
blob.

* threshold_rel — The absolute lower bound for scale space maxima. Local maxima smaller
than threshold_rel are ignored. Reduce this to detect blobs with less intensities.

Returns
Coordinates of blobs

cdl.algorithms.image.find_blobs_log(data: ndarray, min_sigma: float = 1, max_sigma: float = 30, overlap:
float = 0.5, log_scale: bool = False, threshold_rel: float = 0.2,
exclude_border: bool = True) — ndarray

Finds blobs in the given grayscale image using the Laplacian of Gaussian (LoG) method.

Parameters
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Returns

data — The grayscale input image.
min_sigma — The minimum blob radius in pixels.
max_sigma — The maximum blob radius in pixels.

overlap — The minimum overlap between two blobs in pixels. For instance, if two blobs are
detected with radii of 10 and 12 respectively, and the overlap is set to 0.5, then the area of
the smaller blob will be ignored and only the area of the larger blob will be returned.

log_scale - If True, the radius of each blob is returned as sqrt (sigma) for each detected
blob.

threshold_rel — The absolute lower bound for scale space maxima. Local maxima smaller
than threshold_rel are ignored. Reduce this to detect blobs with less intensities.

exclude_border — If True, exclude blobs from detection if they are too close to the border
of the image. Border size is min_sigma.

Coordinates of blobs

cdl.algorithms.image.remove_overlapping_disks(coords: ndarray) — ndarray

Remove overlapping disks among coordinates

Parameters
coords — The coordinates of the disks

Returns

The coordinates of the disks with overlapping disks removed

cdl.algorithms.image.find_blobs_opencv(data: ndarray, min_threshold: float | None = None,
max_threshold: float | None = None, min_repeatability: int | None

= None, min_dist_between_blobs: float | None = None,

filter_by_color: bool | None = None, blob_color: int | None =

None, filter_by_area: bool | None = None, min_area: float | None

= None, max_area: float | None = None, filter_by_circularity:

bool | None = None, min_circularity: float | None = None,

max_circularity: float | None = None, filter_by_inertia: bool |

None = None, min_inertia_ratio: float | None = None,

max_inertia_ratio: float | None = None, filter_by_convexity: bool

| None = None, min_convexity: float | None = None,
max_convexity: float | None = None) — ndarray

Finds blobs in the given grayscale image using OpenCV’s SimpleBlobDetector.

Parameters

data — The grayscale input image.
min_threshold — The minimum blob intensity.
max_threshold — The maximum blob intensity.

min_repeatability — The minimum number of times a blob is detected before it is re-
ported.

min_dist_between_blobs — The minimum distance between blobs.
filter_by_color - If True, blobs are filtered by color.
blob_color — The color of the blobs to filter by.

filter_by_area - If True, blobs are filtered by area.
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e min_area — The minimum blob area.

e max_area — The maximum blob area.

filter_by_circularity - If True, blobs are filtered by circularity.

* min_circularity — The minimum blob circularity.

max_circularity — The maximum blob circularity.

e filter_by_inertia - If True, blobs are filtered by inertia.

e min_inertia_ratio — The minimum blob inertia ratio.

* max_inertia_ratio — The maximum blob inertia ratio.

o filter_by_convexity - If True, blobs are filtered by convexity.
* min_convexity — The minimum blob convexity.

* max_convexity — The maximum blob convexity.

Returns
Coordinates of blobs

3.1.3 Data Type Conversion Algorithms

cdl.algorithms.datatypes.is_integer_dtype (dtype: diype) — bool

Return True if data type is an integer type

Parameters
dtype — Data type to check

Returns
True if data type is an integer type

cdl.algorithms.datatypes.is_complex_dtype (dtype: diype) — bool

Return True if data type is a complex type

Parameters
dtype — Data type to check

Returns
True if data type is a complex type

3.1.4 Coordinate Conversion Algorithms

cdl.algorithms.coordinates.circle_center_radius_to_diameter (xc: float, yc: float, r: float) —
tuple[float, float, float, float]

Convert circle center and radius to X diameter coordinates
Parameters
e xc — Circle center X coordinate
¢ yc - Circle center Y coordinate
e r — Circle radius

Returns
Circle X diameter coordinates
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Return type
tuple

cdl.algorithms.coordinates.ellipse_center_axes_angle_to_diameters(xc: float, yc: float, a: float, b:

Convert ellipse center, axes and angle to X/Y diameters coordinates
Parameters
» xc — Ellipse center X coordinate
* yc — Ellipse center Y coordinate
* a — Ellipse half larger axis

* b — Ellipse half smaller axis

theta — Ellipse angle

Returns
Ellipse X/Y diameters coordinates

3.1.5 Curve Fitting Algorithms

class cdl.algorithms.fit.FitModel

Curve fitting model base class
abstract classmethod func(x, amp, sigma, x0, y0)
Return fitting function
classmethod get_amp_from_amplitude (amplitude, sigma)
Return amp from function amplitude and sigma
classmethod amplitude(amp, sigma)
Return function amplitude
abstract classmethod fwhm(amp, sigma)
Return function FWHM
classmethod half_max_segment (amp, sigma, x0, y0)
Return segment coordinates for y=half-maximum intersection
class cdl.algorithms. fit.GaussianModel
1-dimensional Gaussian fit model
classmethod func(x, amp, sigma, x0, y0)
Return fitting function
classmethod get_amp_from_amplitude (amplitude, sigma)
Return amp from function amplitude and sigma
classmethod amplitude (amp, sigma)

Return function amplitude

classmethod fwhm(amp, sigma)
Return function FWHM

float, theta: float) —

tuple[float, float, float, float,
float, float, float, float]
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class cdl.algorithms.fit.LorentzianModel

1-dimensional Lorentzian fit model

classmethod func(x, amp, sigma, x0, y0)

Return fitting function

classmethod get_amp_from_amplitude (amplitude, sigma)

Return amp from function amplitude and sigma

classmethod amplitude (amp, sigma)

Return function amplitude

classmethod fwhm(amp, sigma)
Return function FWHM

class cdl.algorithms.fit.VoigtModel

1-dimensional Voigt fit model

classmethod func(x, amp, sigma, x0, y0)

Return fitting function

classmethod fwhm(amp, sigma)
Return function FWHM

3.2 Parameters (cdl.param)

The cdl.param module aims at providing all the dataset parameters that are used by the cdl.core. computation
and cdl.core.gui.processor packages.

Those datasets (guidata.dataset.datatypes.Dataset subclasses) are defined in other modules:
e cdl.core.computation.base
* cdl.core.computation.image
e cdl.core.computation.signal

The cdl.param module is thus a convenient way to import all the sets of parameters at once.

As a matter of fact, the following import statement is equivalent to the previous one:

# Original import statement

from cdl.core.computation.base import MovingAverageParam

from cdl.core.computation.signal import PolynomialFitParam

from cdl.core.computation.image.exposure import EqualizeHistParam

# Equivalent import statement
from cdl.param import MovingAverageParam, PolynomialFitParam, EqualizeHistParam
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3.2.1 Common parameters

class cdl.param.ClipParam(title: str | None = None, comment: str | None = None, icon: str="")

Data clipping parameters

class cdl.param.FFTParam(sitle: str | None = None, comment: str | None = None, icon: str="")
FFT parameters

class cdl.param.GaussianParam(title: str | None = None, comment: str | None = None, icon: str="")

Gaussian filter parameters

class cdl.param.MovingAverageParam(title: str | None = None, comment: str | None = None, icon: str="")

Moving average parameters

class cdl.param.MovingMedianParam(sitle: sir | None = None, comment: str | None = None, icon: str="")
Moving median parameters

class cdl.param.ROIDataParam(title: str | None = None, comment: str | None = None, icon: str="")
ROI Editor data

classmethod create(roidata: ndarray | None = None, singleobj: bool | None = None)

Create ROIDataParam instance

property is_empty: bool
Return True if there is no ROI

class cdl.param.ThresholdParam(title: str | None = None, comment: str | None = None, icon: str="")
Threshold parameters

3.2.2 Signal parameters

class cdl.param.DataTypeSParam(title: str | None = None, comment: str | None = None, icon: str="")
Convert signal data type parameters

class cdl.param.FWHMParam(title: str | None = None, comment: str | None = None, icon: str="")
FWHM parameters

class cdl.param.NormalizeYParam(title: str | None = None, comment: str | None = None, icon: str="")

Normalize parameters

class cdl.param.PeakDetectionParam(title: sir | None = None, comment: str | None = None, icon: str="")
Peak detection parameters

class cdl.param.PolynomialFitParam(title: str | None = None, comment: str | None = None, icon: str="")
Polynomial fitting parameters

class cdl.param.XYCalibrateParam(title: str | None = None, comment: str | None = None, icon: str="")

Signal calibration parameters

class cdl.param.InterpolationParam(sitle: sir | None = None, comment: str | None = None, icon: str="")
Interpolation parameters

class cdl.param.ResamplingParam(title: str | None = None, comment: str | None = None, icon: str="")
Resample parameters

class cdl.param.DetrendingParam(title: sir | None = None, comment: str | None = None, icon: str="")

Detrending parameters
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3.2.3 Image parameters

Base image parameters

class cdl.param.AverageProfileParam(zitle: str | None = None, comment: str | None = None, icon: str="")
Average horizontal or vertical profile parameters
class cdl.param.RadialProfileParam( *args, **kwargs)
Radial profile parameters
update_from_image (obj: ImageObj) — None
Update parameters from image
choice_callback (item, value)
Callback for choice item
class cdl.param.BinningParam(title: str | None = None, comment: str | None = None, icon: str="")
Binning parameters
class cdl.param.ButterworthParam(title: sir | None = None, comment: str | None = None, icon: str="")

Butterworth filter parameters

class cdl.param.DataTypeIParam(title: str | None = None, comment: str | None = None, icon: str="")
Convert image data type parameters

class cdl.param.FlatFieldParam(title=None, comment=None, icon="")
Flat-field parameters

class cdl.param.GridParam(title: str | None = None, comment: str | None = None, icon: str="")
Grid parameters

class cdl.param.HoughCircleParam(title: sir | None = None, comment: str | None = None, icon: str="")
Circle Hough transform parameters

class cdl.param.LogP1Param(title: str | None = None, comment: str | None = None, icon: str ="")
Log10 parameters

class cdl.param.ProfileParam(sitle: sir | None = None, comment: str | None = None, icon: sir ="")
Horizontal or vertical profile parameters

class cdl.param.ResizeParam(title: str | None = None, comment: str | None = None, icon: str ="")
Resize parameters

class cdl.param.RotateParam(title: str | None = None, comment: str | None = None, icon: str ="")

Rotate parameters

class cdl.param.ZCalibrateParam(title: sir | None = None, comment: str | None = None, icon: str="")

Image linear calibration parameters
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Exposure correction parameters

class cdl.param.AdjustGammaParam(title: sir | None = None, comment: str | None = None, icon: str="")

Gamma adjustment parameters

class cdl.param.AdjustLogParam(title: str | None = None, comment: str | None = None, icon: str="")

Logarithmic adjustment parameters

class cdl.param.AdjustSigmoidParam(title: str | None = None, comment: str | None = None, icon: str="")

Sigmoid adjustment parameters

class cdl.param.EqualizeAdaptHistParam(title: str | None = None, comment: str | None = None, icon: str =
I/)
Adaptive histogram equalization parameters

class cdl.param.EqualizeHistParam(title: str | None = None, comment: str | None = None, icon: str="")

Histogram equalization parameters

class cdl.param.RescalelIntensityParam(title: str | None = None, comment: str | None = None, icon: str =
ll)

Intensity rescaling parameters

Restoration parameters
class cdl.param.DenoiseBilateralParam(title: sir | None = None, comment: str | None = None, icon: str =
Y/)
Bilateral filter denoising parameters

class cdl.param.DenoiseTVParam(title: str | None = None, comment: str | None = None, icon: str="")

Total Variation denoising parameters

class cdl.param.DenoiseWaveletParam(title: sir | None = None, comment: str | None = None, icon: str="")

Wavelet denoising parameters

Morphological parameters

class cdl.param.MorphologyParam(title: str | None = None, comment: str | None = None, icon: str="")
White Top-Hat parameters

Edge detection parameters

class cdl.param.CannyParam(title: sir | None = None, comment: str | None = None, icon: str="")

Canny filter parameters
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Detection parameters

class cdl.param.BlobDOGParam(title: str | None = None, comment: str | None = None, icon: str ="")
Blob detection using Difference of Gaussian method

class cdl.param.BlobDOHParam(title: str | None = None, comment: str | None = None, icon: str ="
Blob detection using Determinant of Hessian method

class cdl.param.BlobLOGParam(title: str | None = None, comment: str | None = None, icon: str ="

Blob detection using Laplacian of Gaussian method

class cdl.param.BlobOpenCVParam(title: str | None = None, comment: str | None = None, icon: str="")
Blob detection using OpenCV

class cdl.param.ContourShapeParam(title: sir | None = None, comment: str | None = None, icon: str="")

Contour shape parameters

class cdl.param.Peak2DDetectionParam(title: str | None = None, comment: str | None = None, icon: str="")
Peak detection parameters

3.3 Object model (cdl.obj)

The cdl.obj module aims at providing all the necessary classes and functions to create and manipulate Datalab signal
and image objects.

Those classes and functions are defined in other modules:
e cdl.core.model.base
e cdl.core.model.image
e cdl.core.model.signal
e cdl.core.io

The cdl.obj module is thus a convenient way to import all the objects at once. As a matter of fact, the following
import statement is equivalent to the previous one:

# Original import statement
from cdl.core.model.signal import SignalObj
from cdl.core.model.image import ImageObj

# Equivalent import statement
from cdl.obj import SignalObj, ImageObj

3.3.1 Common objects

class cdl.obj.ResultShape (shapetype: ShapeTypes, array: ndarray, label: str="")

Object representing a geometrical shape serializable in signal/image metadata.
Result array is a NumPy 2-D array: each row is a result, optionnally associated to a ROI (first column value).
ROI index is starting at O (or is simply 0 if there is no ROI).

Parameters

» shapetype — shape type
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* array - shape coordinates (multiple shapes: one shape per row), first column is ROI index
(0 if there is no ROI)

* label - shape label

Raises
AssertionError — invalid argument

classmethod label_shapetype_from_key (key: str)

Return metadata shape label and shapetype from metadata key
classmethod from_metadata_entry(key, value) — ResultShape | None

Create metadata shape object from (key, value) metadata entry
classmethod match(key, value) — bool

Return True if metadata dict entry (key, value) is a metadata result
property key: str

Return metadata key associated to result
property shown_xlabels: tuple[str]

Return labels for result array columns
property shown_array: ndarray

Return array of shown results, i.e. including the complementary array

Returns
Array of shown results

add_to(obj: BaseObj)
Add metadata shape to object (signal/image)

merge_with(obj: BaseObj, other_obj: BaseObj | None = None)

Merge object resultshape with another’s: obj <— other_obj or simply merge this resultshape with obj if
other_obj is None

property data_colnb

Return raw data results column number

is_first_column_roi_index() — bool
Return True if first column is ROI index

property data
Return raw data (array without ROI informations)

check_array()
Check if array is valid

iterate_plot_items (fint: sir, Ibl: bool, option: str) — Iterable

Iterate over metadata shape plot items.
Parameters
e fmt (str)— numeric format (e.g. “%.3f”)
e 1bl (bool) —if True, show shape labels
e option (str) — shape style option (e.g. “shape/drag”)

Yields
Plotltem — plot item
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create_plot_item(args: ndarray, fimt: str, Ibl: bool, option: str)
Make plot item.

Parameters
e args (numpy.ndarray) — shape data
e fmt (str)— numeric format (e.g. “%.3f”)
¢ 1bl (bool) - if True, show shape labels
¢ option (str) — shape style option (e.g. “shape/drag”)

Returns
plot item

Return type
Plotltem

make_marker_item(args, fint)
Make marker item

class cdl.obj.ShapeTypes (value, names=None, *, module=None, qualname=None, type=None, start=1I,
boundary=None)

Shape types for image metadata

class cdl.obj.UniformRandomParam(title=None, comment=None, icon="")

Uniform-law random signal/image parameters

apply_integer_range (vmin, vinax)

Do something in case of integer min-max range

class cdl.obj.NormalRandomParam(title=None, comment=None, icon="")

Normal-law random signal/image parameters

apply_integer_range (vmin, vinax)

Do something in case of integer min-max range

3.3.2 Signal model

class cdl.obj.SignalObj (title=None, comment=None, icon="")
Signal object

regenerate_uuid()
Regenerate UUID

This method is used to regenerate UUID after loading the object from a file. This is required to avoid UUID

conflicts when loading objects from file without clearing the workspace first.

copy (title: str | None = None, dtype: dtype | None = None) — SignalObj
Copy object.

Parameters
e title (str) —title
 dtype (numpy.dtype) — data type

Returns
copied object
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Return type
SignalObj

set_data_type(dtype: dtype) — None
Change data type.

Parameters
dtype (numpy.dtype) — data type

set_xydata(x: ndarray | list, y: ndarray | list, dx: ndarray | list | None = None, dy: ndarray | list | None =
None) — None

Set xy data
Parameters
e X (numpy.ndarray) — x data
e y (numpy.ndarray) —y data
e dx (numpy.ndarray) — dx data (optional: error bars)
e dy (numpy.ndarray) — dy data (optional: error bars)

property x: ndarray | None
Get x data

property y: ndarray | None
Get y data

property data: ndarray | None
Get y data

property dx: ndarray | None
Get dx data
property dy: ndarray | None
Get dy data
get_data(roi_index: int | None = None) — ndarray

Return original data (if ROI is not defined or roi_index is None), or ROI data (if both ROI and roi_index
are defined).

Parameters
roi_index (int) — ROI index

Returns
data

Return type
numpy.ndarray

update_plot_item_parameters (item: Curveltem) — None

Update plot item parameters from object data/metadata

Takes into account a subset of plot item parameters. Those parameters may have been overriden by object
metadata entries or other object data. The goal is to update the plot item accordingly.

This is almost the inverse operation of update_metadata_from_plot_item.

Parameters
item - plot item
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update_metadata_from_plot_item(item: Curveltem) — None
Update metadata from plot item.

Takes into account a subset of plot item parameters. Those parameters may have been modified by the user
through the plot item GUI. The goal is to update the metadata accordingly.

This is almost the inverse operation of update_plot_item_parameters.

Parameters
item — plot item

make_item(update_from: Curveltem = None) — Curveltem
Make plot item from data.

Parameters
update_£from (CurveItem) — plot item to update from

Returns
plot item

Return type
Curveltem

update_item(item: Curveltem, data_changed: bool = True) — None
Update plot item from data.

Parameters
e item (CurveItem) - plotitem
» data_changed (bool) — if True, data has changed

roi_coords_to_indexes (coords: list) — ndarray

Convert ROI coordinates to indexes.

Parameters
coords (1ist) — coordinates

Returns
indexes

Return type
numpy.ndarray

get_roi_param(title: str, *defaults) — DataSet

Return ROI parameters dataset.
Parameters
e title (str) —title
» *defaults — default values

static params_to_roidata(params: DataSetGroup) — ndarray
Convert ROI dataset group to ROI array data.

Parameters
params (DataSetGroup) — ROI dataset group

Returns
ROI array data

Return type
numpy.ndarray
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new_roi_item(fint: str, Ibl: bool, editable: bool)

Return a new ROI item from scratch
Parameters
o fmt (str) - format string
¢ 1bl (bool) —if True, add label
¢ editable (bool) - if True, ROl is editable

iterate_roi_items(fint: str, Ibl: bool, editable: bool = True)

Make plot item representing a Region of Interest.
Parameters
e fmt (str) - format string
e 1bl (bool) —if True, add label
e editable (bool) - if True, ROl is editable

Yields
Plotltem — plot item

add_label_with_title(sitle: str| None = None) — None
Add label with title annotation

Parameters
title (str) - title (if None, use signal title)

accept (vis: object) — None

Helper function that passes the visitor to the accept methods of all the items in this dataset

Parameters
vis (object) — visitor object

add_annotations_from_file(filename: str) — None

Add object annotations from file (JSON).

Parameters
filename (str) — filename

add_annotations_from_items (items: list) — None

Add object annotations (annotation plot items).

Parameters
items (1ist)— annotation plot items

add_resultshape (label: str, shapetype: ShapeTypes, array: ndarray, param: DataSet | None = None) —
ResultShape

Add geometric shape as metadata entry, and return ResultShape instance.
Parameters
e label (str) - label
» shapetype (ShapeTypes) — shape type
e array (numpy.ndarray) — array
e param (guidata.dataset.DataSet) — parameters

Returns
result shape
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Return type
ResultShape

property annotations: str
Get object annotations (JSON string describing annotation plot items)
check () — list[str]

Check the dataset item values

Returns
list of errors

Return type
list[str]
check_dataQ)

Check if data is valid, raise an exception if that’s not the case

Raises
TypeError — if data type is not supported

classmethod create(**kwargs) — DataSet
Create a new instance of the DataSet class

Parameters
kwargs — keyword arguments to set the Dataltem values

Returns
DataSet instance

deserialize(reader: HDF5Reader | JSONReader | INIReader) — None

Deserialize the dataset

Parameters
reader (HDF5Reader | JSONReader | INIReader) - reader object

edit (parent: QWidget | None = None, apply: Callable | None = None, wordwrap: bool = True, size: QSize |

tuple[int, int] | None = None) — DataSetEditDialog
Open a dialog box to edit data set

Parameters
e parent — parent widget (default is None, meaning no parent)
* apply - apply callback (default is None)
¢ wordwrap — if True, comment text is wordwrapped
* size — dialog size (QSize object or integer tuple (width, height))

export_metadata_to_file(filename: str) — None
Export object metadata to file (JSON).

Parameters
filename (str) — filename

get_comment () — str| None
Return data set comment

Returns
comment
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Return type
str | None
get_icon() — str| None
Return data set icon
Returns
icon
Return type
str | None
get_metadata_option(name: str) — Any

Return metadata option value

A metadata option is a metadata entry starting with an underscore. It is a way to store application-specific
options in object metadata.

Parameters
name (str) — option name

Returns
Option value

Valid option names:
‘format’: format string (str) ‘showlabel’: show label (bool)

get_title() — str

Return data set title

Returns
title

Return type
Str
classmethod get_valid_dtypenames() — list[str]
Get valid data type names

Returns
Valid data type names supported by this class

import_metadata_from_file (filename: str) — None
Import object metadata from file (JSON).

Parameters
filename (str) — filename

iterate_resultshapes()
Iterate over object result shapes.

Yields
ResultShape — result shape

iterate_roi_indexes()
Iterate over object ROI indexes ([0] if there is no ROI)

iterate_shape_items (editable: bool = False)

Iterate over computing items encoded in metadata (if any).
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Parameters
editable (bool) —if True, ROI is editable

Yields
Plotltem — plot item

metadata_to_html () — str
Convert metadata to human-readable string.

Returns
HTML string

Return type
str

property number: int
Return object number (used for short ID)

read_config(conf: UserConfig, section: str, option: str) — None
Read configuration from a UserConfig instance

Parameters

¢ conf (UserConfig) — UserConfig instance
e section (str) — section name
e option (str)— option name
remove_all_shapes() — None
Remove metadata shapes and ROIs
reset_metadata_to_defaults() — None
Reset metadata to default values
property roi: ndarray | None
Return object regions of interest array (one ROI per line).

Returns
regions of interest array

Return type
numpy.ndarray

roi_has_changed() — bool

Return True if ROI has changed since last call to this method.

The first call to this method will return True if ROI has not yet been set, or if ROI has been set and has
changed since the last call to this method. The next call to this method will always return False if ROI has

not changed in the meantime.

Returns
True if ROI has changed

Return type
bool

roidata_to_params (roidata: ndarray) — DataSetGroup
Convert ROI array data to ROI dataset group.

Parameters
roidata (numpy.ndarray) — ROI array data
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Returns
ROI dataset group

Return type
DataSetGroup

serialize(writer: HDF5Writer | JSONWriter | INIWriter) — None

Serialize the dataset

Parameters
writer (HDF5Writer | JSONWriter | INIWriter) - writer object

set_annotations_from_file (filename: str) — None
Set object annotations from file (JSON).

Parameters
filename (str) — filename

set_defaults() — None

Set default values

classmethod set_global_prop (realm. str, **kwargs) — None

Set global properties for all data items in the dataset
Parameters
¢ realm (str) —realm name
e kwargs (dict) — properties to set

set_metadata_option(name: str, value: Any) — None

Set metadata option value

A metadata option is a metadata entry starting with an underscore. It is a way to store application-specific
options in object metadata.

Parameters
* name (str) — option name
* value (Any) — option value

Valid option names:
‘format’: format string (str) ‘showlabel’: show label (bool)

property short_id
Short object ID

text_edit() — None
Edit data set with text input only

to_string(debug: bool | None = False, indent: str | None = None, align: bool | None = False, show_hidden:
bool | None = True) — str

Return readable string representation of the data set If debug is True, add more details on data items
Parameters
¢ debug (bool) — if True, add more details on data items
¢ indent (str) - indentation string (default is None, meaning no indentation)

e align (bool) — if True, align data items (default is False)
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« show_hidden (bool) — if True, show hidden data items (default is True)

Returns
string representation of the data set

Return type
Str

transform_shapes (orig, func, param=None)
Apply transform function to result shape / annotations coordinates.
Parameters
e orig (BaseObj) — original object
e func (callable) — transform function
» param (object) — transform function parameter

update_metadata_view_settings() — None
Update metadata view settings from Conf.view

update_resultshapes_from(other: BaseObj) — None
Update geometric shape from another object (merge metadata).

Parameters
other - other object, from which to update this object

view(parent: QWidget | None = None, wordwrap: bool = True, size: QSize | tuple[int, int] | None = None) —
None

Open a dialog box to view data set
Parameters
* parent — parent widget (default is None, meaning no parent)
¢ wordwrap — if True, comment text is wordwrapped
» size - dialog size (QSize object or integer tuple (width, height))

write_config(conf: UserConfig, section: str, option: str) — None

Write configuration to a UserConfig instance
Parameters
e conf (UserConfig) — UserConfig instance
e section (str) — section name
* option (str) — option name

cdl.obj.read_signal (filename: str) — SignalObj
Read a signal from a file.

Parameters
filename (str) — File name.

Returns
Signal.

Return type
Signal
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cdl.obj.create_signal (title: str, x: ndarray | None = None, y: ndarray | None = None, dx: ndarray | None =
None, dy: ndarray | None = None, metadata: dict | None = None, units: tuple | None =
None, labels: tuple | None = None) — SignalObj

Create a new Signal object.
Parameters

* title (str) - signal title
e X (numpy.ndarray) — X data
e y (numpy.ndarray)—Y data
e dx (numpy.ndarray) — dX data (optional: error bars)
e dy (numpy.ndarray) — dY data (optional: error bars)
» metadata (dict) — signal metadata
e units (tuple) — X, Y units (tuple of strings)
* labels (tuple) — X, Y labels (tuple of strings)

Returns
signal object

Return type
SignalObj

cdl.obj.create_signal_from_param(newparam: NewSignalParam, addparam: gds.DataSet | None = None,
edit: bool = False, parent: QW.QWidget | None = None) — SignalObj |
None

Create a new Signal object from a dialog box.
Parameters
* newparam (NewSignalParam) — new signal parameters
* addparam (guidata.dataset.DataSet) — additional parameters
* edit (bool) - Open a dialog box to edit parameters (default: False)
* parent (QWidget) — parent widget

Returns
signal object or None if canceled

Return type
SignalObj

cdl.obj.new_signal_param(title: str | None = None, stype: str | None = None, xmin: float | None = None, xmax:
float | None = None, size: int | None = None) — NewSignalParam

Create a new Signal dataset instance.
Parameters
e title (str) — dataset title (default: None, uses default title)
* stype (str) — signal type (default: None, uses default type)
e xmin (float)— X min (default: None, uses default value)
e xmax (float)— X max (default: None, uses default value)

* size (int) — signal size (default: None, uses default value)

180 Chapter 3. API


https://docs.python.org/3/library/stdtypes.html#str
https://numpy.org/doc/stable/reference/generated/numpy.ndarray.html#numpy.ndarray
https://docs.python.org/3/library/constants.html#None
https://numpy.org/doc/stable/reference/generated/numpy.ndarray.html#numpy.ndarray
https://docs.python.org/3/library/constants.html#None
https://numpy.org/doc/stable/reference/generated/numpy.ndarray.html#numpy.ndarray
https://docs.python.org/3/library/constants.html#None
https://numpy.org/doc/stable/reference/generated/numpy.ndarray.html#numpy.ndarray
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/stdtypes.html#dict
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/stdtypes.html#tuple
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/stdtypes.html#tuple
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/stdtypes.html#str
https://numpy.org/doc/stable/reference/generated/numpy.ndarray.html#numpy.ndarray
https://numpy.org/doc/stable/reference/generated/numpy.ndarray.html#numpy.ndarray
https://numpy.org/doc/stable/reference/generated/numpy.ndarray.html#numpy.ndarray
https://numpy.org/doc/stable/reference/generated/numpy.ndarray.html#numpy.ndarray
https://docs.python.org/3/library/stdtypes.html#dict
https://docs.python.org/3/library/stdtypes.html#tuple
https://docs.python.org/3/library/stdtypes.html#tuple
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/functions.html#bool
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/constants.html#None
https://guidata.readthedocs.io/en/latest/reference/dataset/datatypes.html#guidata.dataset.DataSet
https://docs.python.org/3/library/functions.html#bool
https://docs.python.org/3/library/stdtypes.html#str
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/stdtypes.html#str
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/functions.html#float
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/functions.html#float
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/functions.html#int
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/stdtypes.html#str
https://docs.python.org/3/library/stdtypes.html#str
https://docs.python.org/3/library/functions.html#float
https://docs.python.org/3/library/functions.html#float
https://docs.python.org/3/library/functions.html#int

DatalLab, Release 0.11.0

Returns
new signal dataset instance

Return type
NewSignalParam

class cdl.obj.SignalTypes (value, names=None, *, module=None, qualname=None, type=None, start=1,
boundary=None)

Signal types
class cdl.obj.NewSignalParam(sitle: sir | None = None, comment: str | None = None, icon: str="")
New signal dataset
class cdl.obj.GaussLorentzVoigtParam(title: str | None = None, comment: str | None = None, icon: str="")
Parameters for Gaussian and Lorentzian functions
class cdl.obj.StepParam(title: sir | None = None, comment: str | None = None, icon: str="")
Parameters for step function
class cdl.obj.PeriodicParam(title: sir | None = None, comment: str | None = None, icon: str ="'

Parameters for periodic functions

get_frequency_in_hz()

Return frequency in Hz

3.3.3 Image model

class cdl.obj.ImageObj (title=None, comment=None, icon="")
Image object
regenerate_uuid()
Regenerate UUID

This method is used to regenerate UUID after loading the object from a file. This is required to avoid UUID
conflicts when loading objects from file without clearing the workspace first.
property size: tuple[int, int]
Returns (width, height)
set_metadata_from(obj: Mapping | dict) — None
Set metadata from object: dict-like (only string keys are considered) or any other object (iterating over

supported attributes)

Parameters
obj (Mapping | dict) - object

property dicom_template
Get DICOM template

property xc: float
Return image center X-axis coordinate

property yc: float

Return image center Y-axis coordinate
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get_data(roi_index: int | None = None) — ndarray

Return original data (if ROI is not defined or roi_index is None), or ROI data (if both ROI and roi_index
are defined).

Parameters
roi_index (int)— ROI index

Returns
masked data

Return type
numpy.ndarray

copy (title: str | None = None, dtype: dtype | None = None) — ImageObj
Copy object.

Parameters
e title (str) —title
e dtype (numpy.dtype) — data type

Returns
copied object

Return type
ImageObj

set_data_type(diype: dtype) — None
Change data type.

Parameters
dtype (numpy.dtype) — data type

update_plot_item_parameters (item: MaskedImageltem) — None
Update plot item parameters from object data/metadata

Takes into account a subset of plot item parameters. Those parameters may have been overriden by object
metadata entries or other object data. The goal is to update the plot item accordingly.

This is almost the inverse operation of update_metadata_from_plot_item.

Parameters
item — plot item

update_metadata_from_plot_item(item: Maskedlmageltem) — None
Update metadata from plot item.

Takes into account a subset of plot item parameters. Those parameters may have been modified by the user
through the plot item GUI. The goal is to update the metadata accordingly.

This is almost the inverse operation of update_plot_item_parameters.

Parameters
item — plot item

make_item(update_from: Maskedlmageltem | None = None) — MaskedImageltem
Make plot item from data.

Parameters
update_from (MaskedImageItem | None)— update from plot item

Returns
plot item
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Return type
MaskedImageltem

update_item(item: MaskedImageltem, data_changed: bool = True) — None
Update plot item from data.

Parameters
e item (MaskedImageItem)— plotitem
¢ data_changed (bool) —if True, data has changed

get_roi_param(title, *defaults) — DataSet
Return ROI parameters dataset.

Parameters
e title (str) —title
¢ *defaults — default values

static params_to_roidata(params: DataSetGroup) — ndarray | None
Convert ROI dataset group to ROI array data.

Parameters
params (DataSetGroup) — ROI dataset group

Returns
ROI array data

Return type
numpy.ndarray

new_roi_item(fmt: str, Ibl: bool, editable: bool, geometry: RoiDataGeometries) — MaskedImageltem

Return a new ROI item from scratch
Parameters
o fmt (str) - format string
¢ 1bl (bool) — if True, add label
e editable (bool) - if True, ROI is editable
* geometry (RoiDataGeometries)— ROI geometry

roi_coords_to_indexes(coords: list) — ndarray
Convert ROI coordinates to indexes.

Parameters
coords (1ist) — coordinates

Returns
indexes

Return type
numpy.ndarray

iterate_roi_items (fint: str, Ibl: bool, editable: bool = True) — Iterator

Make plot item representing a Region of Interest.
Parameters
o fmt (str) - format string

¢ 1bl (bool) — if True, add label
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¢ editable (bool) - if True, ROl is editable

Yields
Plotltem — plot item

property maskdata: ndarray

Return masked data (areas outside defined regions of interest)

Returns
masked data

Return type
numpy.ndarray

get_masked_view() — MaskedArray
Return masked view for data

Returns
Masked view

invalidate_maskdata_cache() — None
Invalidate mask data cache: force to rebuild it

add_label_with_title(sitle: str | None = None) — None
Add label with title annotation

Parameters
title (str) —title (if None, use image title)

accept (vis: object) — None
Helper function that passes the visitor to the accept methods of all the items in this dataset

Parameters
vis (object) — visitor object

add_annotations_from_file (filename: str) — None
Add object annotations from file (JSON).

Parameters
filename (str) — filename

add_annotations_from_items (items: list) — None
Add object annotations (annotation plot items).

Parameters
items (1ist)— annotation plot items

add_resultshape (label: str, shapetype: ShapeTypes, array: ndarray, param: DataSet | None = None) —
ResultShape

Add geometric shape as metadata entry, and return ResultShape instance.
Parameters
e label (str) —label
» shapetype (ShapeTypes) — shape type
e array (numpy.ndarray) — array
e param (guidata.dataset.DataSet) — parameters

Returns
result shape
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Return type
ResultShape

property annotations: str
Get object annotations (JSON string describing annotation plot items)
check () — list[str]

Check the dataset item values

Returns
list of errors

Return type
list[str]
check_dataQ)

Check if data is valid, raise an exception if that’s not the case

Raises
TypeError — if data type is not supported

classmethod create(**kwargs) — DataSet
Create a new instance of the DataSet class

Parameters
kwargs — keyword arguments to set the Dataltem values

Returns
DataSet instance

deserialize(reader: HDF5Reader | JSONReader | INIReader) — None

Deserialize the dataset

Parameters
reader (HDF5Reader | JSONReader | INIReader) - reader object

edit (parent: QWidget | None = None, apply: Callable | None = None, wordwrap: bool = True, size: QSize |

tuple[int, int] | None = None) — DataSetEditDialog
Open a dialog box to edit data set

Parameters
e parent — parent widget (default is None, meaning no parent)
* apply - apply callback (default is None)
¢ wordwrap — if True, comment text is wordwrapped
* size — dialog size (QSize object or integer tuple (width, height))

export_metadata_to_file(filename: str) — None
Export object metadata to file (JSON).

Parameters
filename (str) — filename

get_comment () — str| None
Return data set comment

Returns
comment
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Return type
str | None
get_icon() — str| None
Return data set icon
Returns
icon
Return type
str | None
get_metadata_option(name: str) — Any

Return metadata option value

A metadata option is a metadata entry starting with an underscore. It is a way to store application-specific
options in object metadata.

Parameters
name (str) — option name

Returns
Option value

Valid option names:
‘format’: format string (str) ‘showlabel’: show label (bool)

get_title() — str

Return data set title

Returns
title

Return type
Str
classmethod get_valid_dtypenames() — list[str]
Get valid data type names

Returns
Valid data type names supported by this class

import_metadata_from_file (filename: str) — None
Import object metadata from file (JSON).

Parameters
filename (str) — filename

iterate_resultshapes()
Iterate over object result shapes.

Yields
ResultShape — result shape

iterate_roi_indexes()
Iterate over object ROI indexes ([0] if there is no ROI)

iterate_shape_items (editable: bool = False)

Iterate over computing items encoded in metadata (if any).
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Parameters
editable (bool) —if True, ROI is editable

Yields
Plotltem — plot item

metadata_to_html () — str
Convert metadata to human-readable string.

Returns
HTML string

Return type
str

property number: int
Return object number (used for short ID)

read_config(conf: UserConfig, section: str, option: str) — None
Read configuration from a UserConfig instance

Parameters

¢ conf (UserConfig) — UserConfig instance
e section (str) — section name
e option (str)— option name
remove_all_shapes() — None
Remove metadata shapes and ROIs
reset_metadata_to_defaults() — None
Reset metadata to default values
property roi: ndarray | None
Return object regions of interest array (one ROI per line).

Returns
regions of interest array

Return type
numpy.ndarray

roi_has_changed() — bool

Return True if ROI has changed since last call to this method.

The first call to this method will return True if ROI has not yet been set, or if ROI has been set and has
changed since the last call to this method. The next call to this method will always return False if ROI has

not changed in the meantime.

Returns
True if ROI has changed

Return type
bool

roidata_to_params (roidata: ndarray) — DataSetGroup
Convert ROI array data to ROI dataset group.

Parameters
roidata (numpy.ndarray) — ROI array data
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Returns
ROI dataset group

Return type
DataSetGroup

serialize(writer: HDF5Writer | JSONWriter | INIWriter) — None

Serialize the dataset

Parameters
writer (HDF5Writer | JSONWriter | INIWriter) - writer object

set_annotations_from_file (filename: str) — None
Set object annotations from file (JSON).

Parameters
filename (str) — filename

set_defaults() — None

Set default values

classmethod set_global_prop (realm. str, **kwargs) — None

Set global properties for all data items in the dataset
Parameters
¢ realm (str) —realm name
e kwargs (dict) — properties to set

set_metadata_option(name: str, value: Any) — None

Set metadata option value

A metadata option is a metadata entry starting with an underscore. It is a way to store application-specific
options in object metadata.

Parameters
* name (str) — option name
* value (Any) — option value

Valid option names:
‘format’: format string (str) ‘showlabel’: show label (bool)

property short_id
Short object ID

text_edit() — None
Edit data set with text input only

to_string(debug: bool | None = False, indent: str | None = None, align: bool | None = False, show_hidden:
bool | None = True) — str

Return readable string representation of the data set If debug is True, add more details on data items
Parameters
¢ debug (bool) — if True, add more details on data items
¢ indent (str) - indentation string (default is None, meaning no indentation)

e align (bool) — if True, align data items (default is False)
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« show_hidden (bool) — if True, show hidden data items (default is True)

Returns
string representation of the data set

Return type
Str

transform_shapes (orig, func, param=None)
Apply transform function to result shape / annotations coordinates.
Parameters
e orig (BaseObj) — original object
e func (callable) — transform function
» param (object) — transform function parameter

update_metadata_view_settings() — None
Update metadata view settings from Conf.view

update_resultshapes_from(other: BaseObj) — None
Update geometric shape from another object (merge metadata).

Parameters
other - other object, from which to update this object

view(parent: QWidget | None = None, wordwrap: bool = True, size: QSize | tuple[int, int] | None = None) —
None

Open a dialog box to view data set
Parameters
* parent — parent widget (default is None, meaning no parent)
¢ wordwrap — if True, comment text is wordwrapped
» size - dialog size (QSize object or integer tuple (width, height))

write_config(conf: UserConfig, section: str, option: str) — None

Write configuration to a UserConfig instance
Parameters
e conf (UserConfig) — UserConfig instance
e section (str) — section name
* option (str) — option name

cdl.obj.read_image (filename: str) — ImageObj

Read an image from a file.

Parameters
filename (str) — File name.

Returns
Image.

Return type
Image
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cdl.obj.create_image((title: str, data: ndarray | None = None, metadata: dict | None = None, units: tuple | None
= None, labels: tuple | None = None) — ImageObj

Create a new Image object
Parameters
e title (str) —image title
* data (numpy.ndarray) — image data
» metadata (dict) — image metadata
e units (tuple) — X, Y, Z units (tuple of strings)
* labels (tuple) - X, Y, Z labels (tuple of strings)

Returns
image object

Return type
ImageObj

cdl.obj.create_image_from_param(newparam: NewlmageParam, addparam: gds.DataSet | None = None, edit:
bool = False, parent: QW.QWidget | None = None) — ImageObj | None

Create a new Image object from dialog box.
Parameters
* newparam (NewImageParam) — new image parameters
* addparam (guidata.dataset.DataSet) — additional parameters
* edit (bool) - Open a dialog box to edit parameters (default: False)
* parent (QWidget) — parent widget

Returns
new image object or None if user cancelled

Return type
ImageObj

cdl.obj.new_image_param(title: str | None = None, itype: ImageTypes | None = None, height: int | None = None,
width: int | None = None, dtype: ImageDatatypes | None = None) —
NewlmageParam

Create a new Image dataset instance.
Parameters
e title (str) — dataset title (default: None, uses default title)
* itype (ImageTypes) — image type (default: None, uses default type)
* height (int) — image height (default: None, uses default height)
e width (int) — image width (default: None, uses default width)
» dtype (ImageDatatypes) — image data type (default: None, uses default data type)

Returns
new image dataset instance

Return type
NewlmageParam
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class cdl.obj.ImageTypes (value, names=None, *, module=None, qualname=None, type=None, start=1I,
boundary=None)

Image types
class cdl.obj.NewImageParam(title: sir | None = None, comment: str | None = None, icon: str="")
New image dataset

class cdl.obj.Gauss2DParam(title: str | None = None, comment: str | None = None, icon: str="")

2D Gaussian parameters

class cdl.obj.RoiDataGeometries (value, names=None, *, module=None, qualname=None, type=None,
start=1, boundary=None)

ROI data geometry types

class cdl.obj.ImageDatatypes (value, names=None, *, module=None, qualname=None, type=None, start=1I,
boundary=None)

Image data types
classmethod from_dtype (dtype)
Return member from NumPy dtype

classmethod check()
Check if data types are valid

3.4 Computation (cdl.core.computation)

This package contains the computation functions used by the DatalLab project. Those functions operate directly on
DatalLab objects (i.e. cdl.obj.SignalObj and cdl.obj.ImageObj) and are designed to be used in the DatalLab
pipeline, but can be used independently as well.

See also:

The cdl.core.computation package is the main entry point for the DatalLab computation functions when manipu-
lating DatalLab objects. See the cdl.algorithms package for algorithms that operate directly on NumPy arrays.

Each computation module defines a set of computation objects, that is, functions that implement processing features and
classes that implement the corresponding parameters (in the form of guidata.dataset.datatypes.Dataset sub-
classes). The computation functions takes a DatalLab object (e.g. cdl.obj.SignalObj) and a parameter object (e.g.
cdl.param.MovingAverageParam) as input and return a DatalLab object as output (the result of the computation).
The parameter object is used to configure the computation function (e.g. the size of the moving average window).

In DatalLab overall architecture, the purpose of this package is to provide the computation functions that are used by
the cdl.core.gui.processor module, based on the algorithms defined in the cdl.algorithms module and on the
data model defined in the cdl.obj (or cdl.core.model) module.

The computation modules are organized in subpackages according to their purpose. The following subpackages are
available:

e cdl.core.computation.base: Common processing features
e cdl.core.computation.signal: Signal processing features

e cdl.core.computation.image: Image processing features
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3.4.1 Common processing features

class cdl.core.computation.base.GaussianParam(title: str | None = None, comment: str | None = None,
icon: str="")

Gaussian filter parameters

class cdl.core.computation.base.MovingAverageParam(sitle: str | None = None, comment: str | None =
None, icon: str="")

Moving average parameters

class cdl.core.computation.base.MovingMedianParam(sitle: sir | None = None, comment: str | None =
None, icon: str="")

Moving median parameters

class cdl.core.computation.base.ThresholdParam(zitle: str | None = None, comment: str | None = None,
icon: str="")

Threshold parameters

class cdl.core.computation.base.ClipParam(title: str | None = None, comment: str | None = None, icon:
str=")

Data clipping parameters

class cdl.core.computation.base.ROIDataParam(sitle: str | None = None, comment: str | None = None,
icon: str="")

ROI Editor data

classmethod create(roidata: ndarray | None = None, singleobj: bool | None = None)

Create ROIDataParam instance

property is_empty: bool
Return True if there is no ROI

class cdl.core.computation.base.FFTParam(title: str | None = None, comment: str | None = None, icon: str
— /V)

FFT parameters

3.4.2 Signal processing features

cdl.core.computation.signal.dst_11(src: SignalObj, name: str, suffix: str | None = None) — SignalObj

Create result signal object for compute_11 function
Parameters
* src (SignalObj) — source signal
e name (str) —name of the function

Returns
result signal object

Return type
SignalObj
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class cdl.core.computation.signal.WrapllFunc (func: Callable)

Wrap a 1 array -> 1 array function (the simple case of y1 = f(y0)) to produce a 1 SignalObj -> 1 SignalObj
function, which can be used inside DatalLab’s infrastructure to perform computations with SignalProcessor.

This wrapping mechanism using a class is necessary for the resulted function to be pickable by the
multiprocessing module.

The instance of this wrapper is callable and returns a SignalObj object.

Example

>>> import numpy as np

>>> from cdl.core.computation.signal import WrapllFunc
>>> import cdl.obj

>>> def square(y):

Nac return y**2

>>> compute_square = WrapllFunc(square)

>>> x = np.linspace(®, 10, 100)

>>> y = np.sin(x)

>>> sig® = cdl.obj.create_signal ("Example", x, y)

>>> sigl = compute_square(sig®)

Parameters
func - 1 array -> 1 array function

cdl.core.computation.signal.dst_nln(srcl: SignalObj, src2: SignalObj, name: str, suffix: str | None =
None)

Create result signal object for compute_n1n function
Parameters
* srcl (SignalObj) — source signal 1
» src2 (SignalObj) — source signal 2
e name (str) — name of the function

Returns
result signal object

Return type
SignalObj
cdl.core.computation.signal.compute_add(dst: SignalObj, src: SignalObj) — SignalObj
Add signal to result signal :param dst: destination signal :type dst: SignalObj :param src: source signal :type
src: SignalObj
cdl.core.computation.signal.compute_product (dst: SignalObj, src: SignalObj) — SignalObj
Multiply signal to result signal :param dst: destination signal :type dst: SignalObj :param src: source signal :type
src: SignalObj
cdl.core.computation.signal.compute_difference(srcl: SignalObj, src2: SignalObj) — SignalObj
Compute difference between two signals :param srcl: source signal 1 :type srcl: SignalObj :param src2: source

signal 2 :type src2: SignalObj

Returns
result signal object
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Return type
SignalObj

cdl.core.computation.signal.compute_quadratic_difference(srcl: SignalObj, src2: SignalObj) —
SignalObj
Compute quadratic difference between two signals :param srcl: source signal 1 :type srcl: SignalObj :param
src2: source signal 2 :type src2: SignalObj

Returns
result signal object

Return type
SignalObj
cdl.core.computation.signal.compute_division(srci: SignalObj, src2: SignalObj) — SignalObj
Compute division between two signals :param srcl: source signal 1 :type srcl: SignalObj :param src2: source
signal 2 :type src2: SignalObj

Returns
result signal object

Return type
SignalObj
cdl.core.computation.signal.extract_multiple_roi(src: SignalObj, group: DataSetGroup) — SignalObj
Extract multiple regions of interest from data :param src: source signal :type src: SignalObj :param group: group
of parameters :type group: gds.DataSetGroup

Returns
signal with multiple regions of interest

Return type
SignalObj
cdl.core.computation.signal.extract_single_roi(src: SignalObj, p: DataSet) — SignalObj
Extract single region of interest from data :param src: source signal :type src: SignalObj :param p: parameters

:type p: gds.DataSet

Returns
signal with single region of interest

Return type
SignalObj

cdl.core.computation.signal.compute_swap_axes(src: SignalObj) — SignalObj

Swap axes :param src: source signal :type src: SignalObj

Returns
result signal object

Return type
SignalObj

cdl.core.computation.signal.compute_abs(src: SignalObj) — SignalObj

Compute absolute value :param src: source signal :type src: SignalObj

Returns
result signal object

Return type
SignalObj
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cdl.core.computation.signal.compute_re(src: SignalObj) — SignalObj

Compute real part :param src: source signal :type src: SignalObj

Returns
result signal object

Return type
SignalObj

cdl.core.computation.signal.compute_im(src: SignalObj) — SignalObj

Compute imaginary part :param src: source signal :type src: SignalObj

Returns
result signal object

Return type
SignalObj

class cdl.core.computation.signal.DataTypeSParam(title: sir | None = None, comment: str | None =
None, icon: str="

Convert signal data type parameters

cdl.core.computation.signal.compute_astype(src: SignalObj, p: DataTypeSParam) — SignalObj

Convert data type :param src: source signal :param p: parameters

Returns
Result signal object

cdl.core.computation.signal.compute_loglO®(src: SignalObj) — SignalObj
Compute Log10 :param src: source signal :type src: SignalObj

Returns
result signal object

Return type
SignalObj

class cdl.core.computation.signal.PeakDetectionParam(title: str | None = None, comment: str | None =
None, icon: str="")

Peak detection parameters

cdl.core.computation.signal.compute_peak_detection(src: SignalObj, p: PeakDetectionParam) —
SignalObj

Peak detection :param src: source signal :type src: SignalObj :param p: parameters :type p: PeakDetectionParam

Returns
result signal object

Return type
SignalObj

class cdl.core.computation.signal.NormalizeYParam(ztitle: sir | None = None, comment: str | None =
None, icon: str="")

Normalize parameters
cdl.core.computation.signal.compute_normalize(src: SignalObj, p: NormalizeYParam) — SignalObj

Normalize data :param src: source signal :type src: SignalObj :param p: parameters :type p: NormalizeYParam

Returns
result signal object
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Return type
SignalObj
cdl.core.computation.signal.compute_derivative(src: SignalObj) — SignalObj
Compute derivative :param src: source signal :type src: SignalObj

Returns
result signal object

Return type
SignalObj
cdl.core.computation.signal.compute_integral (src: SignalObj) — SignalObj
Compute integral :param src: source signal :type src: SignalObj

Returns
result signal object

Return type
SignalObj

class cdl.core.computation.signal.XYCalibrateParam(title: str | None = None, comment: str | None =
None, icon: str="")
Signal calibration parameters

cdl.core.computation.signal.compute_calibration(src: SignalObj, p: XYCalibrateParam) — SignalObj
Compute linear calibration :param src: source signal :type src: SignalObj :param p: parameters :type p: XYCal-
ibrateParam

Returns
result signal object

Return type
SignalObj
cdl.core.computation.signal.compute_threshold(src: SignalObj, p: ThresholdParam) — SignalObj
Compute threshold clipping :param src: source signal :type src: SignalObj :param p: parameters :type p: Thresh-
oldParam

Returns
result signal object

Return type
SignalObj
cdl.core.computation.signal.compute_clip(src: SignalObj, p: ClipParam) — SignalObj
Compute maximum data clipping :param src: source signal :type src: SignalObj :param p: parameters :type p:
ClipParam

Returns
result signal object

Return type
SignalObj

cdl.core.computation.signal.compute_gaussian_filter(src: SignalObj, p: GaussianParam) —
SignalObj

Compute gaussian filter :param src: source signal :type src: SignalObj :param p: parameters :type p: Gaussian-
Param
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Returns
result signal object

Return type
SignalObj
cdl.core.computation.signal.compute_moving_average (src: SignalObj, p: MovingAverageParam) —
SignalObj
Compute moving average :param src: source signal :type src: SignalObj :param p: parameters :type p: Movin-
gAverageParam
Returns

result signal object

Return type
SignalObj
cdl.core.computation.signal.compute_moving_median(src: SignalObj, p: MovingMedianParam) —
SignalObj
Compute moving median :param src: source signal :type src: SignalObj :param p: parameters :type p: Moving-
MedianParam
Returns

result signal object

Return type
SignalObj

cdl.core.computation.signal.compute_wiener (src: SignalObj) — SignalObj
Compute Wiener filter :param src: source signal :type src: SignalObj

Returns
result signal object

Return type
SignalObj

cdl.core.computation.signal.compute_fft(src: SignalObj, p: FFTParam) — SignalObj
Compute FFT :param src: source signal :type src: SignalObj :param p: parameters :type p: FFTParam

Returns
result signal object

Return type
SignalObj

cdl.core.computation.signal.compute_ifft (src: SignalObj, p: FFTParam) — SignalObj
Compute iFFT :param src: source signal :type src: SignalObj :param p: parameters :type p: FFTParam

Returns
result signal object

Return type
SignalObj

class cdl.core.computation.signal.PolynomialFitParam(title: sir | None = None, comment: str | None =
None, icon: str="")

Polynomial fitting parameters
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class cdl.core.computation.signal.FWHMParam(sitle: sir | None = None, comment: str | None = None, icon:
str="")

FWHM parameters
cdl.core.computation.signal.compute_£fwhm(signal: SignalObj, param: FWHMParam)
Compute FWHM

cdl.core.computation.signal.compute_fwle2 (signal: SignalObj)
Compute FW at 1/¢?

class cdl.core.computation.signal.InterpolationParam(title: str | None = None, comment: str| None =
None, icon: str="")

Interpolation parameters

cdl.core.computation.signal.compute_interpolation(srcl: SignalObj, src2: SignalObj, p:
InterpolationParam) — SignalObj

Interpolate data :param srcl: source signal 1 :type srcl: SignalObj :param src2: source signal 2 :type src2:
SignalObj :param p: parameters :type p: InterpolationParam

Returns
result signal object

Return type
SignalObj

class cdl.core.computation.signal.ResamplingParam(zitle: str | None = None, comment: str | None =
None, icon: str="")

Resample parameters

cdl.core.computation.signal.compute_resampling(src: SignalObj, p: ResamplingParam) — SignalObj

Resample data :param src: source signal :type src: SignalObj :param p: parameters :type p: ResampleParam

Returns
result signal object

Return type
SignalObj

class cdl.core.computation.signal.DetrendingParam(sitle: sir | None = None, comment: str | None =
None, icon: str="")
Detrending parameters

cdl.core.computation.signal.compute_detrending(src: SignalObj, p: DetrendingParam) — SignalObj
Detrend data :param src: source signal :type src: SignalObj :param p: parameters :type p: DetrendingParam

Returns
result signal object

Return type
SignalObj
cdl.core.computation.signal.compute_convolution(srcl: SignalObj, src2: SignalObj) — SignalObj
Compute convolution of two signals :param srcl: source signal 1 :type srcl: SignalObj :param src2: source
signal 2 :type src2: SignalObj

Returns
result signal object

Return type
SignalObj
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3.4.3 Image processing features

Base image processing features

cdl.core.computation.image.dst_11(src: ImageObj, name: str, suffix: str | None = None) — ImageObj
Create result image object for compute_11 function

Parameters
* src (ImageObj) — input image object
* name (str)—name of the processing function

Returns
output image object

Return type
ImageObj

class cdl.core.computation.image.WrapllFunc(func: Callable)

Wrap a 1 array -> 1 array function to produce a 1 ImageObj -> 1 ImageObj function, which can be used inside
Datal.ab’s infrastructure to perform computations with ImageProcessor.

This wrapping mechanism using a class is necessary for the resulted function to be pickable by the
multiprocessing module.

The instance of this wrapper is callable and returns a ImageObj object.

Example

-

>>> import numpy as np

>>> from cdl.core.computation.signal import WrapllFunc
>>> import cdl.obj

>>> def add_noise(data):

- return data + np.random.random(data.shape)

>>> compute_add_noise = WrapllFunc(add_noise)

>>> data= np.ones((100, 100))

>>> ima® = cdl.obj.create_image("Example", data)

>>> imal = compute_add_noise(ima®)

Parameters
func - 1 array -> 1 array function

cdl.core.computation.image.dst_11_signal (src: ImageObj, name: str, suffix: str | None = None) —
SignalObj

Create result signal object for compute_11 function
Parameters
* src (ImageObj) — input image object
* name (str)— name of the processing function

Returns
output signal object

Return type
SignalObj
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cdl.core.computation.image.dst_nln(srcl: ImageObj, src2: ImageObj, name: str, suffix: str | None = None)
— ImageObj

Create result image object for compute_n1n function
Parameters
* srcl (ImageObj) — input image object
* src2 (ImageObj) — input image object
* name (str)—name of the processing function

Returns
output image object

Return type
ImageObj

cdl.core.computation.image.compute_add(dst: ImageObj, src: ImageObj) — ImageObj
Compute addition between two images
Parameters
* dst (ImageObj) — output image object
* src (ImageObj) — input image object
cdl.core.computation.image.compute_product (dst: ImageObj, src: ImageObj) — ImageObj
Compute product between two images
Parameters
* dst (ImageObj) — output image object
* src (ImageObj) — input image object
cdl.core.computation.image.compute_difference(srcl: ImageObj, src2: ImageObj) — ImageObj
Compute difference between two images :param srcl: input image object :type srcl: ImageObj :param src2:
input image object :type src2: ImageObj
Returns
output image object

Return type
ImageObj

cdl.core.computation.image.compute_quadratic_difference(srcl: ImageObj, src2: ImageObj) —
ImageObj
Compute quadratic difference between two images :param srcl: input image object :type srcl: ImageObj :param
src2: input image object :type src2: ImageObj
Returns
output image object
Return type
ImageObj
cdl.core.computation.image.compute_division(src/: ImageObj, src2: ImageObj) — ImageObj
Compute division between two images :param srcl: input image object :type srcl: ImageObj :param src2: input
image object :type src2: ImageObj

Returns
output image object
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Return type
ImageObj
class cdl.core.computation.image.FlatFieldParam(title=None, comment=None, icon="")
Flat-field parameters

cdl.core.computation.image.compute_flatfield(srcl: ImageObj, src2: ImageObj, p: FlatFieldParam) —
ImageObj

Compute flat field correction :param srcl: raw data image object :type srcl: ImageObj :param src2: flat field
image object :type src2: ImageObj :param p: flat field parameters :type p: FlatFieldParam

Returns
output image object

Return type
ImageObj

class cdl.core.computation.image.LogP1Param(ritle: str | None = None, comment: str | None = None, icon:
str="")

Log10 parameters

cdl.core.computation.image.compute_logpl(src: ImageObj, p: LogPl1Param) — ImageObj
Compute logl0(z+n) :param src: input image object :type src: ImageObj :param p: parameters :type p:
LogP1Param

Returns
output image object

Return type
ImageObj

class cdl.core.computation.image.RotateParam(title: str | None = None, comment: str | None = None,
icon: str="")

Rotate parameters

cdl.core.computation.image.rotate_obj_coords (angle: float, obj: ImageObj, orig: ImageObj, coords:
ndarray) — None

Apply rotation to coords associated to image obj :param angle: rotation angle (in degrees) :type angle: float
:param obj: image object :type obj: ImageObj :param orig: original image object :type orig: ImageObj :param
coords: coordinates to rotate :type coords: numpy.ndarray

Returns
output data

Return type
np.ndarray

cdl.core.computation.image.rotate_obj_alpha(obj: ImageObj, orig: ImageObj, coords: ndarray, p:
RotateParam) — None

Apply rotation to coords associated to image obj
cdl.core.computation.image.compute_rotate(src: ImageObj, p: RotateParam) — ImageObj
Rotate data :param src: input image object :type src: ImageObj :param p: parameters :type p: RotateParam

Returns
output image object

Return type
ImageObj
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cdl.core.computation.image.rotate_obj_90 (dst: ImageObj, src: ImageObj, coords: ndarray) — None
Apply rotation to coords associated to image obj
cdl.core.computation.image.compute_rotate90(src: ImageObj) — ImageObj
Rotate data 90° :param src: input image object :type src: ImageObj

Returns
output image object

Return type
ImageObj
cdl.core.computation.image.rotate_obj_270(dst: ImageObj, src: ImageObj, coords: ndarray) — None
Apply rotation to coords associated to image obj
cdl.core.computation.image.compute_rotate270(src: ImageObj) — ImageObj
Rotate data 270° :param src: input image object :type src: ImageObj

Returns
output image object

Return type
ImageObj

cdl.core.computation.image.hflip_coords(dst: ImageObj, src: ImageObj, coords: ndarray) — None

Apply HFlip to coords

cdl.core.computation.image.compute_f£fliph(src: ImageObj) — ImageObj
Flip data horizontally :param src: input image object :type src: ImageObj

Returns
output image object

Return type
ImageObj
cdl.core.computation.image.vflip_coords (dst: ImageObj, src: ImageObj, coords: ndarray) — None
Apply VFlip to coords
cdl.core.computation.image.compute_f£flipv(src: ImageObj) — ImageObj
Flip data vertically :param src: input image object :type src: ImageObj

Returns
output image object

Return type
ImageObj

class cdl.core.computation.image.GridParam(title: str | None = None, comment: str | None = None, icon:
str=""

Grid parameters

class cdl.core.computation.image.ResizeParam(title: str | None = None, comment: str | None = None,
icon: str="")

Resize parameters
cdl.core.computation.image.compute_resize (src: ImageObj, p: ResizeParam) — ImageObj
Zooming function :param src: input image object :type src: ImageObj :param p: parameters :type p: ResizeParam

Returns
output image object
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Return type
ImageObj

class cdl.core.computation.image.BinningParam(title: str | None = None, comment: str | None = None,
icon: str="")
Binning parameters
cdl.core.computation.image.compute_binning(src: ImageObj, param: BinningParam) — ImageObj
Binning function on data :param src: input image object :type src: ImageObj :param param: parameters :type

param: BinningParam

Returns
output image object

Return type
ImageObj
cdl.core.computation.image.extract_multiple_roi (src: ImageObj, group: DataSetGroup) — ImageObj
Extract multiple regions of interest from data :param src: input image object :type src: ImageObj :param group:
parameters defining the regions of interest :type group: gds.DataSetGroup

Returns
output image object

Return type
ImageObj
cdl.core.computation.image.extract_single_roi (src: ImageObj, p: DataSet) — ImageObj
Extract single ROI :param src: input image object :type src: ImageObj :param p: ROI parameters :type p:
gds.DataSet
Returns
output image object
Return type
ImageObj
class cdl.core.computation.image.ProfileParam(sitle: str | None = None, comment: str | None = None,
icon: str="")
Horizontal or vertical profile parameters
cdl.core.computation.image.compute_profile(src: ImageObj, p: ProfileParam) — ImageObj
Compute horizontal or vertical profile :param src: input image object :param p: parameters
Returns
Output image object
class cdl.core.computation.image.AverageProfileParam(zitle: sir | None = None, comment: str | None =
None, icon: str="")

Average horizontal or vertical profile parameters

cdl.core.computation.image.compute_average_profile(src: ImageObj, p: AverageProfileParam) —
ImageObj

Compute horizontal or vertical average profile :param src: input image object :param p: parameters

Returns
Output image object

class cdl.core.computation.image.RadialProfileParam(*args, **kwargs)
Radial profile parameters
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update_from_image (obj: ImageObj) — None
Update parameters from image

choice_callback (item, value)

Callback for choice item

cdl.core.computation.image.compute_radial_profile(src: ImageObj, p: RadialProfileParam) —

cdl.

cdl.

cdl.

cdl.

ImageObj
Compute radial profile around the centroid
Parameters
* src - input image object
* p — parameters

Returns
Output image object

core.computation.image.compute_swap_axes (src: ImageObj) — ImageObj

Swap image axes :param src: input image object :type src: ImageObj

Returns
output image object

Return type
ImageObj

core.computation.image.compute_abs(src: ImageObj) — ImageObj

Compute absolute value :param src: input image object :type src: ImageObj

Returns
output image object

Return type
ImageObj

core.computation.image.compute_re(src: ImageObj) — ImageObj
Compute real part :param src: input image object :type src: ImageObj

Returns
output image object

Return type
ImageObj

core.computation.image.compute_im(src: ImageObj) — ImageObj

Compute imaginary part :param src: input image object :type src: ImageObj

Returns
output image object

Return type
ImageObj

class cdl.core.computation.image.DataTypeIParam(title: sir | None = None, comment: str | None = None,

icon: str="")

Convert image data type parameters
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cdl.core.computation.image.compute_astype(src: ImageObj, p: DataTypelParam) — ImageObj
Convert image data type :param src: input image object :param p: parameters
Returns
Output image object
cdl.core.computation.image.compute_logl®(src: ImageObj) — ImageObj
Compute log10 :param src: input image object :type src: ImageObj

Returns
output image object

Return type
ImageObj

class cdl.core.computation.image.ZCalibrateParam(title: str | None = None, comment: str | None =
None, icon: str="

Image linear calibration parameters

cdl.core.computation.image.compute_calibration(src: ImageObj, p: ZCalibrateParam) — ImageObj
Compute linear calibration :param src: input image object :type src: ImageObj :param param: calibration pa-
rameters :type param: ZCalibrateParam

Returns
output image object

Return type
ImageObj
cdl.core.computation.image.compute_threshold(src: ImageObj, p: ThresholdParam) — ImageObj
Apply thresholding :param src: input image object :type src: ImageObj :param p: parameters :type p: Thresh-
oldParam

Returns
output image object

Return type
ImageObj
cdl.core.computation.image.compute_clip(src: ImageObj, p: ClipParam) — ImageObj
Apply clipping :param src: input image object :type src: ImageObj :param p: parameters :type p: ClipParam
Returns
output image object

Return type
ImageObj
cdl.core.computation.image.compute_gaussian_filter (src: ImageObj, p: GaussianParam) — ImageObj
Compute gaussian filter :param src: input image object :type src: ImageObj :param p: parameters :type p:
GaussianParam

Returns
output image object

Return type
ImageObj

cdl.core.computation.image.compute_moving_average(src: ImageObj, p: MovingAverageParam) —
ImageObj

3.4. Computation (cdl.core.computation) 205


https://docs.python.org/3/library/stdtypes.html#str
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/stdtypes.html#str
https://docs.python.org/3/library/constants.html#None
https://docs.python.org/3/library/stdtypes.html#str

DatalLab, Release 0.11.0

Compute moving average :param src: input image object :type src: ImageObj :param p: parameters :type p:
MovingAverageParam

Returns
output image object

Return type
ImageObj
cdl.core.computation.image.compute_moving_median(src: ImageObj, p: MovingMedianParam) —
ImageObj
Compute moving median :param src: input image object :type src: ImageObj :param p: parameters :type p:
MovingMedianParam
Returns

output image object

Return type
ImageObj
cdl.core.computation.image.compute_wiener (src: ImageObj) — ImageObj
Compute Wiener filter :param src: input image object :type src: ImageObj

Returns
output image object

Return type
ImageObj
cdl.core.computation.image.compute_£ft (src: ImageObj, p: FETParam) — ImageObj
Compute FFT :param src: input image object :type src: ImageObj :param p: parameters :type p: FFTParam

Returns
output image object

Return type
ImageObj
cdl.core.computation.image.compute_ifft(src: ImageObj, p: FFTParam) — ImageObj
Compute inverse FFT :param src: input image object :type src: ImageObj :param p: parameters :type p: FFT-
Param

Returns
output image object

Return type
ImageObj

class cdl.core.computation.image.ButterworthParam(zitle: str | None = None, comment: str | None =
None, icon: str="")
Butterworth filter parameters
cdl.core.computation.image.compute_butterworth(src: ImageObj, p: ButterworthParam) — ImageObj
Compute Butterworth filter :param src: input image object :type src: ImageObj :param p: parameters :type p:

ButterworthParam

Returns
output image object

Return type
ImageObj
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cdl.core.computation.image.calc_with_osr(image: ImageObj, func: Callable, *args: Any) — ndarray

Exec computation taking into account image x0, y0, dx, dy and ROIs
Parameters
* image — input image object
 func - computation function
» *args — computation function arguments

Returns
Computation result

Warning: The computation function must take either a single argument (the data) or multiple arguments
(the data followed by the computation parameters).

Moreover, the computation function must return a single value or a NumPy array containing the result of the
computation. This array contains the coordinates of points, polygons, circles or ellipses in the form [[x, y],
...],or [[x0, yO, x1,y1,...],...], or [[xO0, yO, 1], ...], or [[xO, yO, a, b, theta], ...].

cdl.core.computation.image.get_centroid_coords (data: ndarray) — ndarray

Return centroid coordinates :param data: input data :type data: numpy.ndarray

Returns
centroid coordinates

Return type
np.ndarray
cdl.core.computation.image.compute_centroid(image: ImageObj) — ndarray
Compute centroid :param image: input image :type image: ImageObj
Returns

centroid coordinates

Return type
np.ndarray
cdl.core.computation.image.get_enclosing_circle_coords(data: ndarray) — ndarray

Return diameter coords for the circle contour enclosing image values above threshold (FWHM) :param data:
input data :type data: numpy.ndarray

Returns
diameter coords

Return type
np.ndarray
cdl.core.computation.image.compute_enclosing_circle (image: ImageObj) — ndarray
Compute minimum enclosing circle :param image: input image :type image: ImageObj

Returns
diameter coords

Return type
np.ndarray

3.4. Computation (cdl.core.computation) 207


https://docs.python.org/3/library/collections.abc.html#collections.abc.Callable
https://docs.python.org/3/library/typing.html#typing.Any
https://numpy.org/doc/stable/reference/generated/numpy.ndarray.html#numpy.ndarray
https://numpy.org/doc/stable/reference/generated/numpy.ndarray.html#numpy.ndarray
https://numpy.org/doc/stable/reference/generated/numpy.ndarray.html#numpy.ndarray
https://numpy.org/doc/stable/reference/generated/numpy.ndarray.html#numpy.ndarray
https://numpy.org/doc/stable/reference/generated/numpy.ndarray.html#numpy.ndarray
https://numpy.org/doc/stable/reference/generated/numpy.ndarray.html#numpy.ndarray
https://numpy.org/doc/stable/reference/generated/numpy.ndarray.html#numpy.ndarray

DatalLab, Release 0.11.0

class cdl.core.computation.image.HoughCircleParam(sitle: sir | None = None, comment: str | None =
None, icon: str="")

Circle Hough transform parameters

cdl.core.computation.image.compute_hough_circle_peaks (image: ImageObj, p. HoughCircleParam) —
ndarray

Compute Hough circles :param image: input image :type image: ImageObj :param p: parameters :type p: Hough-
CircleParam

Returns
circle coordinates

Return type
np.ndarray

Exposure correction features

Exposure computation module

class cdl.core.computation.image.exposure.AdjustGammaParam(title: str | None = None, comment: str |
None = None, icon: str="")

Gamma adjustment parameters

cdl.core.computation.image.exposure.compute_adjust_gamma(src: ImageObj, p: AdjustGammaParam)
— ImageObj

Gamma correction
Parameters
* src - input image object
* p (AdjustGammaParam) — parameters

Returns
Output image object

class cdl.core.computation.image.exposure.AdjustLogParam(title: str | None = None, comment: str |
None = None, icon: str="")

Logarithmic adjustment parameters

cdl.core.computation.image.exposure.compute_adjust_log(src: ImageObj, p: AdjustLogParam) —
ImageObj

Compute log correction
Parameters
* src - input image object
* p — parameters

Returns
Output image object

class cdl.core.computation.image.exposure.AdjustSigmoidParam sitle: str | None = None, comment:
str | None = None, icon: str="")

Sigmoid adjustment parameters
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cdl.core.computation.image.exposure.compute_adjust_sigmoid(src: ImageObj, p:
AdjustSigmoidParam) — ImageObj

Compute sigmoid correction
Parameters
* src - input image object
* p — parameters

Returns
Output image object

class cdl.core.computation.image.exposure.RescaleIntensityParam(title: str | None = None,
comment: str | None = None,
icon: str="")
Intensity rescaling parameters

cdl.core.computation.image.exposure.compute_rescale_intensity(src: ImageObj, p:
RescalelntensityParam) —
ImageObj

Rescale image intensity levels
Parameters
* src - input image object
* p — parameters

Returns
Output image object

class cdl.core.computation.image.exposure.EqualizeHistParam(sitle: sir | None = None, comment: str
| None = None, icon: str="")

Histogram equalization parameters

cdl.core.computation.image.exposure.compute_equalize_hist(src: ImageObj, p: EqualizeHistParam)
— ImageObj

Histogram equalization
Parameters
* src - input image object
* p — parameters

Returns
Output image object

class cdl.core.computation.image.exposure.EqualizeAdaptHistParam(title: str | None = None,
comment: str | None = None,
icon: str=")

Adaptive histogram equalization parameters

cdl.core.computation.image.exposure.compute_equalize_adapthist(src: ImageObj, p:
EqualizeAdaptHistParam) —
ImageObj

Adaptive histogram equalization
Parameters

* src - input image object
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* p — parameters

Returns
Output image object

Restoration features

Restoration computation module

class cdl.core.computation.image.restoration.DenoiseTVParam(ritle: sir | None = None, comment: str
| None = None, icon: str=""

Total Variation denoising parameters

cdl.core.computation.image.restoration.compute_denoise_tv(src: ImageObj, p: DenoiseTVParam) —
ImageObj

Compute Total Variation denoising
Parameters
* src - input image object
* D — parameters

Returns
Output image object

class cdl.core.computation.image.restoration.DenoiseBilateralParam(title: str | None = None,
comment: str | None = None,
icon: str="")

Bilateral filter denoising parameters

cdl.core.computation.image.restoration.compute_denoise_bilateral (src: ImageObj, p:
DenoiseBilateralParam) —
ImageObj

Compute bilateral filter denoising
Parameters
* src — input image object
* D — parameters

Returns
Output image object

class cdl.core.computation.image.restoration.DenoiseWaveletParam(title: sir | None = None,
comment: str | None = None,
icon: str="")

Wavelet denoising parameters

cdl.core.computation.image.restoration.compute_denoise_wavelet(src: ImageObj, p:
DenoiseWaveletParam) —
ImageObj

Compute Wavelet denoising
Parameters
* src - input image object

* p — parameters
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Returns
Output image object

cdl.core.computation.image.restoration.compute_denoise_tophat (src: ImageObj, p:
MorphologyParam) — ImageObj

Denoise using White Top-Hat
Parameters
* src - input image object
* D — parameters

Returns
Output image object

Morphological features

Morphology computation module

class cdl.core.computation.image.morphology.MorphologyParam(sitle: sir | None = None, comment: str
| None = None, icon: str=""

White Top-Hat parameters

cdl.core.computation.image.morphology.compute_white_tophat (src: ImageObj, p: MorphologyParam)
— ImageObj

Compute White Top-Hat
Parameters
* src - input image object
* p — parameters

Returns
Output image object

cdl.core.computation.image.morphology.compute_black_tophat (src: ImageObj, p: MorphologyParam)
— ImageObj

Compute Black Top-Hat
Parameters
* src - input image object
* p — parameters

Returns
Output image object

cdl.core.computation.image.morphology.compute_erosion(src: ImageObj, p: MorphologyParam) —
ImageObj

Compute Erosion
Parameters
* src - input image object

* P — parameters
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Returns
Output image object

cdl.core.computation.image.morphology.compute_dilation(src: ImageObj, p: MorphologyParam) —
ImageObj

Compute Dilation
Parameters
* src - input image object
* D — parameters

Returns
Output image object

cdl.core.computation.image.morphology.compute_opening(src: ImageObj, p: MorphologyParam) —
ImageObj

Compute morphological opening
Parameters
* src - input image object
* p — parameters

Returns
Output image object

cdl.core.computation.image.morphology.compute_closing(src: ImageObj, p: MorphologyParam) —
ImageObj

Compute morphological closing
Parameters
* src - input image object
* p — parameters

Returns
Output image object

Edge detection features

Edges computation module

class cdl.core.computation.image.edges.CannyParam(title: str | None = None, comment: str | None =
None, icon: str="")

Canny filter parameters

cdl.core.computation.image.edges.compute_canny (src: ImageObj, p: CannyParam) — ImageObj

Compute Canny filter
Parameters
* src — input image object
* D — parameters

Returns
Output image object
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cdl

cdl

cdl

cdl

cdl

cdl

cdl

.core.computation.image.edges.

Compute Roberts filter

Parameters
src — input image object

Returns
Output image object
.core.computation.image.edges
Compute Prewitt filter

Parameters
src — input image object

Returns
Output image object

.core.computation.image.edges.

Compute horizontal Prewitt filter

Parameters
src — input image object

Returns
Output image object
.core.computation.image.edges
Compute vertical Prewitt filter

Parameters
src — input image object

Returns
Output image object

.core.computation.image.edges.

Compute Sobel filter

Parameters
src — input image object

Returns
Output image object
.core.computation.image.edges
Compute horizontal Sobel filter

Parameters
src — input image object

Returns
Output image object
.core.computation.image.edges
Compute vertical Sobel filter

Parameters
src — input image object

Returns
Output image object

compute_roberts (src: ImageObj) — ImageObj

.compute_prewitt (src: ImageObj) — ImageObj

compute_prewitt_h(src: ImageObj) — ImageObj

.compute_prewitt_v(src: ImageObj) — ImageObj

compute_sobel (src: ImageObj) — ImageObj

.compute_sobel_h(src: ImageObj) — ImageObj

.compute_sobel_v (src: ImageObj) — ImageObj

3.4. Computation (cdl.core.computation)
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cdl.

cdl.

cdl.

cdl.

cdl.

cdl.

cdl.

core.computation.image.edges.

Compute Scharr filter

Parameters
src — input image object

Returns
Output image object

core.computation.image.edges

Compute horizontal Scharr filter

Parameters
src — input image object

Returns
Output image object

core.computation.image.edges
Compute vertical Scharr filter
Parameters
src — input image object

Returns
Output image object

core.computation.image.edges.

Compute Farid filter

Parameters
src — input image object

Returns
Output image object

core.computation.image.edges
Compute horizontal Farid filter
Parameters
src — input image object

Returns
Output image object

core.computation.image.edges
Compute vertical Farid filter
Parameters
src — input image object
Returns
Output image object
core.computation.image.edges
Compute Laplace filter
Parameters
src — input image object

Returns
Output image object

compute_scharr (src: ImageObj) — ImageObj

.compute_scharr_h(src: ImageObj) — ImageObj

.compute_scharr_v(src: ImageObj) — ImageObj

compute_farid(src: ImageObj) — ImageObj

.compute_farid_h(src: ImageObj) — ImageObj

.compute_farid_v(src: ImageObj) — ImageObj

.compute_laplace(src: ImageObj) — ImageObj
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Detection features

Blob detection computation module

class cdl.core.computation.image.detection.GenericDetectionParam(title: sir | None = None,
comment: str | None = None,
icon: str="")

Generic detection parameters

class cdl.core.computation.image.detection.Peak2DDetectionParam(title: str | None = None,
comment: str | None = None,
icon: str="")

Peak detection parameters

cdl.core.computation.image.detection.compute_peak_detection(image: ImageObj, p:
Peak2DDetectionParam) — ndarray

Compute 2D peak detection
Parameters
» imageOutput - input image
* p — parameters

Returns
Peak coordinates

class cdl.core.computation.image.detection.ContourShapeParam(sitle: sir | None = None, comment:
str | None = None, icon: str="")

Contour shape parameters

cdl.core.computation.image.detection.compute_contour_shape (image: ImageObj, p:
ContourShapeParam) — ndarray

Compute contour shape fit

class cdl.core.computation.image.detection.BaseBlobParam(title: str | None = None, comment: str |
None = None, icon: str="")

Base class for blob detection parameters

class cdl.core.computation.image.detection.BlobDOGParam(title: str | None = None, comment: str |
None = None, icon: str="")

Blob detection using Difference of Gaussian method

cdl.core.computation.image.detection.compute_blob_dog(image: ImageObj, p: BlobDOGParam) —
ndarray

Compute blobs using Difference of Gaussian method
Parameters
* imageOutput — input image
* p — parameters

Returns
Blobs coordinates

class cdl.core.computation.image.detection.BlobDOHParam(title: str | None = None, comment: str |
None = None, icon: str="")

Blob detection using Determinant of Hessian method
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cdl.core.computation.image.detection.compute_blob_doh(image: ImageObj, p: BlobDOHParam) —
ndarray

Compute blobs using Determinant of Hessian method
Parameters
* imageOutput — input image
* p — parameters

Returns
Blobs coordinates

class cdl.core.computation.image.detection.BlobLOGParam(title: str | None = None, comment: str |
None = None, icon: str="

Blob detection using Laplacian of Gaussian method

cdl.core.computation.image.detection.compute_blob_log(image: ImageObj, p: BlobLOGParam) —
ndarray

Compute blobs using Laplacian of Gaussian method
Parameters
* imageOutput — input image
* p — parameters

Returns
Blobs coordinates

class cdl.core.computation.image.detection.BlobOpenCVParam(ritle: str | None = None, comment: str |
None = None, icon: str="")

Blob detection using OpenCV

cdl.core.computation.image.detection.compute_blob_opencv(image: ImageObj, p:
BlobOpenCVParam) — ndarray

Compute blobs using OpenCV
Parameters
* imageOutput — input image
* p — parameters

Returns
Blobs coordinates

3.5 Proxy objects (cdl.proxy)

The cdl.proxy module provides a way to access DatalLab features from a proxy class.
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3.5.1 Remote proxy

The remote proxy is used when DataLab is started from a different process than the proxy. In this case, the proxy
connects to DatalLab XML-RPC server.

class cdl.proxy.RemoteProxy (autoconnect: bool = True)

DatalLab remote proxy class.

This class provides access to DatalLab features from a proxy class. This is the remote version of proxy, which is
used when Datalab is started from a different process than the proxy.

Parameters
autoconnect (bool) — Automatically connect to Datal.ab XML-RPC server.

Raises
¢ ConnectionRefusedError — Unable to connect to Datal.ab
e ValueError — Invalid timeout (must be >= 0.0)

e ValueError — Invalid number of retries (must be >= 1)

Examples

Here is a simple example of how to use RemoteProxy in a Python script or in a Jupyter notebook:

-

>>> from cdl.proxy import RemoteProxy

>>> proxy = RemoteProxy()

Connecting to Datalab XML-RPC server...OK (port: 28867)
>>> proxy.get_version()

'1.0.0'

>>> proxy.add_signal("toto", np.array([l., 2., 3.1), np.array([4., 5., -1.1))
True

>>> proxy.get_object_titles()

['toto']

>>> proxy["toto"] # from title
<cdl.core.model.signal.SignalObj at 0x7f7f1cOb4a90>
>>> proxy[l] # from number
<cdl.core.model.signal.SignalObj at 0x7£f7f1cOb4a90>
>>> proxy[1].data

array([1l., 2., 3.1)

>>> proxy.set_current_panel("'image")

L

add_annotations_from_items (items: list, refresh_plot: bool = True, panel: str | None = None) — None

Add object annotations (annotation plot items).
Parameters
e items (1ist)— annotation plot items
e refresh_plot (bool | None) - refresh plot. Defaults to True.

e panel (str | None) — panel name (valid values: “signal”, “image”). If None, current
panel is used.

add_image (title: str, data: ndarray, xunit: str | None = None, yunit: str | None = None, zunit: str | None =
None, xlabel: str | None = None, ylabel: str | None = None, zlabel: str | None = None) — bool

Add image data to DatalLab.
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Parameters

title (str) — Image title

data (numpy.ndarray) — Image data

xunit (str | None)— X unit. Defaults to None.
yunit (str | None)—Y unit. Defaults to None.
zunit (str | None) — Z unit. Defaults to None.
xlabel (str | None)— X label. Defaults to None.
ylabel (str | None)-Y label. Defaults to None.
zlabel (str | None)—Z label. Defaults to None.

Returns
True if image was added successfully, False otherwise

Return type
bool

Raises
ValueError — Invalid data dtype

add_label_with_title(title: str | None = None, panel: str | None = None) — None

Add a label with object title on the associated plot

Parameters

e title (str | None) - Label title. Defaults to None. If None, the title is the object title.

e panel (str | None) — panel name (valid values: “signal”, “image”). If None, current

panel is used.

add_object (obj: SignalObj | ImageObj) — None
Add object to DataLab.

Parameters
obj (SignalObj | ImageObj) - Signal or image object

add_signal (title: str, xdata: ndarray, ydata: ndarray, xunit: str | None = None, yunit: str | None = None,
xlabel: str | None = None, ylabel: str | None = None) — bool

Add signal data to DataLab.

Parameters

title (str) — Signal title

xdata (numpy.ndarray) — X data

ydata (numpy.ndarray) - Y data

xunit (str | None)— X unit. Defaults to None.
yunit (str | None)—Y unit. Defaults to None.
xlabel (str | None)— X label. Defaults to None.

ylabel (str | None)- Y label. Defaults to None.

Returns
True if signal was added successfully, False otherwise
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Return type
bool

Raises
e ValueError - Invalid xdata dtype
e ValueError — Invalid ydata dtype

calc(name: str, param: DataSet | None = None) — DataSet

Call compute function name in current panel’s processor.
Parameters
* name (str)— Compute function name

e param (guidata.dataset.DataSet | None)— Compute function parameter. Defaults
to None.

Returns
Compute function result

Return type
guidata.dataset.DataSet

close_application() — None
Close DataL.ab application

connect (port: str | None = None, timeout: float | None = None, retries: int | None = None) — None
Try to connect to DatalLab XML-RPC server.

Parameters

* port (str | None)—- XML-RPC port to connect to. If not specified, the port is automat-
ically retrieved from DatalLab configuration.

e timeout (float | None)— Timeout in seconds. Defaults to 5.0.

e retries (int | None)— Number of retries. Defaults to 10.
Raises

¢ ConnectionRefusedError — Unable to connect to DatalLab

e ValueError — Invalid timeout (must be >= 0.0)

e ValueError — Invalid number of retries (must be >= 1)

context_no_refresh() — Callable

Return a context manager to temporarily disable auto refresh.

Returns
Context manager
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Example

>>> with proxy.context_no_refresh():
proxy.add_image('imagel", datal)
proxy.compute_£f£ft ()
proxy.compute_wiener()
proxy.compute_ifft()
# Auto refresh is disabled during the above operations

delete_metadata(refresh_plot: bool = True, keep_roi: bool = False) — None

Delete metadata of selected objects
Parameters
e refresh_plot — Refresh plot. Defaults to True.
* keep_roi — Keep ROI. Defaults to False.

disconnect() — None
Disconnect from DatalLab XML-RPC server.

get_current_panel () — str

Return current panel name.

Returns
Panel name (valid values: “signal”, “image”, “macro”))

Return type
str

get_group_titles_with_object_infos() — tuple[list[str], list[list[str]], list[list[str]]]
Return groups titles and lists of inner objects uuids and titles.

Returns
groups titles, lists of inner objects uuids and titles

Return type
Tuple

get_method_list() — list[str]

Return list of available methods.

get_object(nb_id_title: int | str | None = None, panel: str | None = None) — SignalObj | ImageObj

Get object (signal/image) from index.
Parameters

e nb_id_title — Object number, or object id, or object title. Defaults to None (current
object).

¢ panel — Panel name. Defaults to None (current panel).

Returns
Object

Raises
KeyError — if object not found

get_object_shapes(nb_id_title: int | str | None = None, panel: str | None = None) — list

Get plot item shapes associated to object (signal/image).
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Parameters
e nb_id_title — Object number, or object id, or object title. Defaults to None (current
object).
¢ panel — Panel name. Defaults to None (current panel).

Returns
List of plot item shapes
get_object_titles(panel: str| None = None) — list[str]
Get object (signal/image) list for current panel. Objects are sorted by group number and object index in
group.

Parameters
panel (str | None) - panel name (valid values: “signal”, “image”). If None, current panel
is used.

Returns
list of object titles

Return type
list[str]
Raises
ValueError - if panel not found
get_object_uuids (panel: str | None = None) — list[str]
Get object (signal/image) uuid list for current panel. Objects are sorted by group number and object index
in group.

Parameters
panel (str | None) - panel name (valid values: “signal”, “image”). If None, current panel
is used.

Returns
list of object uuids

Return type
list[str]

Raises
ValueError - if panel not found

classmethod get_public_methods() — list[str]

Return all public methods of the class, except itself.

Returns
List of public methods

Return type
list[str]

get_sel_object_uuids (include_groups: bool = False) — list[str]

Return selected objects uuids.

Parameters
include_groups — If True, also return objects from selected groups.

Returns
List of selected objects uuids.
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get_version() — str

Return DatalLab version.

Returns
Datal.ab version

Return type
str

import_h5_file(filename: str, reset_all: bool | None = None) — None
Open DatalL.ab HDF5 browser to Import HDF? file.

Parameters
¢ filename (str)— HDFS5 file name
e reset_all (bool | None)— Reset all application data. Defaults to None.

is_connected() — bool
Return True if connected to DatalLab XML-RPC server.

open_h5_files (hSfiles: list[str] | None = None, import_all: bool | None = None, reset_all: bool | None =
None) — None

Open a DatalLab HDFS5 file or import from any other HDFS file.
Parameters
e h5files (list[str] | None) - List of HDFS files to open. Defaults to None.
e import_all (bool | None)— Import all objects from HDFS files. Defaults to None.
e reset_all (bool | None)— Reset all application data. Defaults to None.

open_object (filename: str) — None

Open object from file in current panel (signal/image).

Parameters
filename (str) — File name

raise_window() — None
Raise DatalLab window

reset_all() — None
Reset all application data

save_to_h5_file(filename: str) — None
Save to a DatalLab HDF?5 file.

Parameters
filename (str)— HDFS5 file name

select_groups (selection: list[int | str] | None = None, panel: str | None = None) — None

Select groups in current panel.
Parameters

¢ selection - List of group numbers (1 to N), or list of group uuids, or None to select all
groups. Defaults to None.

e panel (str | None) — panel name (valid values: “signal”, “image”). If None, current
panel is used. Defaults to None.
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select_objects(selection: list[int | str], panel: str | None = None) — None

Select objects in current panel.
Parameters
¢ selection — List of object numbers (1 to N) or uuids to select

e panel — panel name (valid values: “signal”, “image”). If None, current panel is used.
Defaults to None.

set_current_panel (panel: str) — None

Switch to panel.

Parameters
panel (str) — Panel name (valid values: “signal”, “image”, “macro”))

toggle_auto_refresh(srate: bool) — None
Toggle auto refresh state.

Parameters
state (bool) — Auto refresh state

toggle_show_titles(state: bool) — None
Toggle show titles state.

Parameters
state (bool) — Show titles state

3.5.2 Local proxy

The local proxy is used when Datalab is started from the same process as the proxy. In this case, the proxy is directly
connected to DatalLab main window instance. The typical use case is high-level scripting.

class cdl.proxy.LocalProxy(cdl: CDLMainWindow | ServerProxy | None = None)

DatalLab local proxy class.

This class provides access to Datalab features from a proxy class. This is the local version of proxy, which is
used when Datalab is started from the same process as the proxy.

Parameters
cdl (CDLMainWindow) — CDLMainWindow instance.

add_signal (title: str, xdata: ndarray, ydata: ndarray, xunit: str | None = None, yunit: str | None = None,
xlabel: str | None = None, ylabel: str | None = None) — bool

Add signal data to Datal.ab.
Parameters
e title (str) - Signal title
e xdata (numpy.ndarray) — X data
e ydata (numpy.ndarray) - Y data
e xunit (str | None)— X unit. Defaults to None.
e yunit (str | None)-Y unit. Defaults to None.
e xlabel (str | None)- X label. Defaults to None.

e ylabel (str | None)-Y label. Defaults to None.
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Returns
True if signal was added successfully, False otherwise

Return type
bool

Raises
¢ ValueError — Invalid xdata dtype
¢ ValueError — Invalid ydata dtype

add_image (title: str, data: ndarray, xunit: str | None = None, yunit: str | None = None, zunit: str | None =
None, xlabel: str | None = None, ylabel: str | None = None, zlabel: str | None = None) — bool

Add image data to DatalLab.
Parameters
e title (str)— Image title
e data (numpy.ndarray) — Image data
e xunit (str | None)— X unit. Defaults to None.
e yunit (str | None)—Y unit. Defaults to None.
e zunit (str | None)— Z unit. Defaults to None.
e xlabel (str | None) - X label. Defaults to None.
e ylabel (str | None)- Y label. Defaults to None.
e zlabel (str | None)—Z label. Defaults to None.

Returns
True if image was added successfully, False otherwise

Return type
bool

Raises
ValueError — Invalid data dtype

calc(name: str, param: DataSet | None = None) — DataSet

Call compute function name in current panel’s processor.
Parameters
* name (str)— Compute function name
e param (guidata.dataset.DataSet | None)— Compute function
e None. (parameter. Defaults to)-—

Returns
Compute function result

Return type
guidata.dataset.DataSet

get_object (nb_id_title: int | str | None = None, panel: str | None = None) — SignalObj | ImageObj

Get object (signal/image) from index.
Parameters

e nb_id_title — Object number, or object id, or object title. Defaults to None (current
object).
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¢ panel — Panel name. Defaults to None (current panel).

Returns
Object

Raises
KeyError - if object not found

get_object_shapes(nb_id_title: int | str | None = None, panel: str | None = None) — list
Get plot item shapes associated to object (signal/image).

Parameters

e nb_id_title — Object number, or object id, or object title. Defaults to None (current
object).

* panel — Panel name. Defaults to None (current panel).

Returns
List of plot item shapes

add_annotations_from_items (items: list, refresh_plot: bool = True, panel: str | None = None) — None

Add object annotations (annotation plot items).
Parameters
e items (1ist)— annotation plot items
e refresh_plot (bool | None) - refresh plot. Defaults to True.

e panel (str | None) — panel name (valid values: “signal”, “image”). If None, current
panel is used.

add_object (obj: SignalObj | ImageObj) — None
Add object to DataLab.

Parameters
obj (SignalObj | ImageObj) - Signal or image object

add_label_with_title(title: str | None = None, panel: str | None = None) — None
Add a label with object title on the associated plot
Parameters
e title (str | None)— Label title. Defaults to None. If None, the title is the object title.

¢ panel (str | None) — panel name (valid values: “signal”, “image”). If None, current
panel is used.

close_application() — None
Close DataLab application
context_no_refresh() — Callable

Return a context manager to temporarily disable auto refresh.

Returns
Context manager
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Example

>>> with proxy.context_no_refresh():
proxy.add_image('imagel", datal)
proxy.compute_£f£ft ()
proxy.compute_wiener()
proxy.compute_ifft()
# Auto refresh is disabled during the above operations

delete_metadata(refresh_plot: bool = True, keep_roi: bool = False) — None

Delete metadata of selected objects
Parameters
e refresh_plot — Refresh plot. Defaults to True.
* keep_roi — Keep ROI. Defaults to False.
get_current_panel () — str
Return current panel name.

Returns
Panel name (valid values: “signal”, “image”, “macro”))

Return type
str
get_group_titles_with_object_infos() — tuple[list[str], list[list[str]], list[list[str]]]
Return groups titles and lists of inner objects uuids and titles.

Returns
groups titles, lists of inner objects uuids and titles

Return type
Tuple
get_object_titles(panel: str | None = None) — list[str]
Get object (signal/image) list for current panel. Objects are sorted by group number and object index in
group.
Parameters

panel (str | None) - panel name (valid values: “signal”, “image”). If None, current panel
is used.

Returns
list of object titles

Return type
list[str]
Raises
ValueError - if panel not found
get_object_uuids (panel: str | None = None) — list[str]
Get object (signal/image) uuid list for current panel. Objects are sorted by group number and object index
in group.

Parameters
panel (str | None) - panel name (valid values: “signal”, “image”). If None, current panel
is used.
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Returns
list of object uuids

Return type
list[str]

Raises
ValueError — if panel not found

classmethod get_public_methods() — list[str]
Return all public methods of the class, except itself.

Returns
List of public methods

Return type
list[str]

get_sel_object_uuids (include_groups: bool = False) — list[str]
Return selected objects uuids.

Parameters
include_groups — If True, also return objects from selected groups.

Returns
List of selected objects uuids.

get_version() — str
Return DatalLab version.

Returns
DatalLab version

Return type
str

import_h5_file(filename: str, reset_all: bool | None = None) — None
Open DatalL.ab HDF5 browser to Import HDFS file.

Parameters
e filename (str) — HDFS5 file name
e reset_all (bool | None)— Reset all application data. Defaults to None.

open_h5_files (hSfiles: list[str] | None = None, import_all: bool | None = None, reset_all: bool | None =
None) — None

Open a DatalLab HDFS5 file or import from any other HDF? file.
Parameters
e h5files (list[str] | None) - List of HDFS files to open. Defaults to None.
e import_all (bool | None)— Import all objects from HDFS files. Defaults to None.
e reset_all (bool | None) - Reset all application data. Defaults to None.

open_object (filename: str) — None
Open object from file in current panel (signal/image).

Parameters
filename (str) — File name
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raise_window() — None

Raise DatalLab window

reset_all() — None
Reset all application data

save_to_h5_file(filename: str) — None
Save to a DatalLab HDFS5 file.

Parameters
filename (str)— HDFS5 file name

select_groups (selection: list[int | str] | None = None, panel: str | None = None) — None
Select groups in current panel.
Parameters

* selection — List of group numbers (1 to N), or list of group uuids, or None to select all
groups. Defaults to None.

e panel (str | None) — panel name (valid values: “signal”, “image”). If None, current
panel is used. Defaults to None.

select_objects(selection: list[int | str], panel: str | None = None) — None

Select objects in current panel.
Parameters
* selection - List of object numbers (1 to N) or uuids to select

¢ panel - panel name (valid values: “signal”, “image”). If None, current panel is used.
Defaults to None.

set_current_panel (panel: str) — None

Switch to panel.

Parameters
panel (str) — Panel name (valid values: “signal”, “image”, “macro”))

toggle_auto_refresh(state: bool) — None
Toggle auto refresh state.

Parameters
state (bool) — Auto refresh state

toggle_show_titles(state: bool) — None
Toggle show titles state.

Parameters
state (bool) — Show titles state
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3.5.3 Proxy context manager

The proxy context manager is a convenient way to handle proxy creation and destruction. It is used as follows:

with proxy_context("local") as proxy:
proxy.add_signal(...)

The proxy type can be “local” or “remote”. For remote proxy, the port can be specified as “remote:port”.

Note: The proxy context manager allows to use the proxy in various contexts (Python script, Jupyter notebook, etc.).
It also allows to switch seamlessly between local and remote proxy, keeping the same code inside the context.

cdl.proxy.proxy_context (what: str) — Generator[LocalProxy | RemoteProxy, None, None]
Context manager handling CDL proxy creation and destruction.
Parameters

what (str) — proxy type (“local” or “remote”) For remote proxy, the port can be specified as
“remote:port”

Yields
Generator[LocalProxy | RemoteProxy, None, None] —

Proxy
LocalProxy if what == “local” RemoteProxy if what == “remote” or “remote:port”

Example

with proxy_context(‘“local’’) as proxy:
proxy.add_signal(...)
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CHAPTER
FOUR

DEVELOPMENT

4.1 Roadmap

4.1.1 Future milestones

Features

¢ Add a Jupyter kernel interface to Datal.ab:

This would allow to use DatalLab from other software, such as Jupyter notebooks, Spyder or Visual Studio
Code

This would also allow to share data between DatalLab and other software (e.g. display DatalLab numerical
results in Jupyter notebooks or the other way around, display Jupyter results in Datalab, etc.)

* Create a Jupyter plugin for interactive data analysis with DatalLab:

Using DatalLab from a Jupyter notebook is already possible, thanks to the remote control features (see
Remote controlling), but it would be nice to have a dedicated plugin

This plugin would allow to use DatalLab as a Jupyter kernel, and to display Datal.ab numerical results in
Jupyter notebooks or the other way around (e.g. display Jupyter results in Datal.ab)

This plugin would also allow to use DatalLab’s processing features from Jupyter notebooks

A typical use case could also consist in using DatalLab for manipulating signals or images efficiently, and
using Jupyter for custom data analysis based on specific / home-made algorithms

This plugin could be implemented by using the Jupyter kernel interface (see above)

* Create a Spyder plugin for interactive data analysis connected with DataLab:

This is exactly the same use case as for the Jupyter plugin, but for Spyder

This plugin could also be implemented by using the Jupyter kernel interface (see above)

* Add support for time series (see Issue #27)
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Maintenance
e 2024: switch to gRPC for remote control (instead of XML-RPC), if there is a need for a more efficient commu-
nication protocol (see Issue #18)

e 2025: drop PyQt5 support (end-of-life: mid-2025), and switch to PyQt6 ; this should be straightforward, thanks
to the gzpy compatibility layer and to the fact that PlotPyStack is already compatible with PyQt6)

Other tasks

 Create a DatalLab plugin template (see Issue #26)

* Make tutorial videos: plugin system, remote control features, etc. (see Issue #25)

4.1.2 Past milestones

DatalLab 0.11
* Add a drag-and-drop feature to the signal and image panels, to allow reordering signals and images (see Issue
#17)

¢ Add “Move up” and “Move down” buttons to the signal and image panels, to allow reordering signals and images
(see Issue #22)

* Add 1D convolution, interpolation, resampling and detrending features

DatalLab 0.10

* Develop a very simple DatalLab plugin to demonstrate the plugin system
* Serialize curve and image styles in HDFS5 files

* Add an “Auto-refresh” global option, to be able to disable the automatic refresh of the main window when doing
multiple processing steps, thus improving performance

 Improve curve readability (e.g. avoid dashed lines, use contrasted colors, and use anti-aliasing)

DatalLab 0.9

¢ Python 3.11 is the new reference
* Run computations in a separate process:
— Execute a “computing server” in background, in another process
— For each computation, send serialized data and computing function to the server and wait for the result

— It is then possible to stop any computation at any time by killing the server process and restarting it (even-
tually after incrementing the communication port number)

* Optimize image displaying performance

* Add preferences dialog box

¢ Add new image processing features: denoising, ...

 Image processing results: added support for polygon shapes (e.g. for contour detection)

* New plugin system: API for third-party extensions
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— Objective #1: a plugin must be manageable using a single Python script, which includes an extension of
ImageProcessor, ActionHandler and new file format support

— Objective #2: plugins must be simply stored in a folder wich defaults to the user directory (same folder as
“Datal.ab.ini” configuration file)

¢ Add a macro-command system:
— New embedded Python editor
— Scripts using the same API as high-level applicative test scenarios
— Support for macro recording

* Add an xmlrpc server to allow DatalLab remote control:

— Controlling DatalLab main features (open a signal or an image, open a HDFS5 file, etc.) and processing
features (run a computation, etc.)

— Take control of DatalLab from a third-party software

— Run interactive calculations from an IDE (e.g. Spyder or Visual Studio Code)

4.2 How to contribute

4.2.1 Fork the project

The first step is to fork the project on GitHub. You can do that by visiting DatalLab project and clicking on the “Fork”
button on the top right corner of the page.

Once you have forked the project, you will have a copy of the project in your own GitHub account. Then you can clone
the project on your computer and start working on it.

4.2.2 Submit a pull request
Once you have made some changes, you can submit a pull request to the original project. To do that, go to your forked
project on GitHub and click on the “Pull request” button on the top right corner of the page.

Then you will have to fill a form to describe your pull request. Once you have submitted the pull request, the project
maintainers will review your changes and merge them if they are satisfied.

During the review process, the project maintainers will check that your code follows the coding guidelines and that it
does not break the existing tests. If your code does not follow the coding guidelines, you will have to fix it before your
pull request can be merged.

See also:

The Coding guidelines page presents the coding guidelines that you should follow when contributing to the project.
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4.3 Coding guidelines

4.3.1 Generic coding guidelines

We follow the PEP 8 coding style.
In particular, we are especially strict about the following guidelines:
* Limit all lines to a maximum of 79 characters.
» Respect the naming conventions (classes, functions, variables, etc.).
» Use specific exceptions instead of the generic Exception.
To enforce these guidelines, the following tools are mandatory:
* black for code formatting.
* isort for import sorting.

* pylint for static code analysis.

black

If you are using Visual Studio Code, the project settings will automatically format your code on save.

Or you may use black manually. To format your code, run the following command:

[black .

isort

Again, if you are using Visual Studio Code, the project settings will automatically sort your imports on save.

Or you may use isort manually. To sort your imports, run the following command:

[i sort .

pylint

To run pylint, run the following command:

[pylint datalab

If you are using Visual Studio Code on Windows, you may run the task “Run Pylint” to run pylint on the project.

Note: A pylint rating greater than 9/10 is required to merge a pull request.
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4.3.2 Specific coding guidelines

In addition to the generic coding guidelines, we have the following specific guidelines:

4.4

Write docstrings for all classes, methods and functions. The docstrings should follow the Google style.

Add typing annotations for all functions and methods. The annotations should use the future syntax (from
__future__ import annotations)

Try to keep the code as simple as possible. If you have to write a complex piece of code, try to split it into several
functions or classes.

Add as many comments as possible. The code should be self-explanatory, but it is always useful to add some
comments to explain the general idea of the code, or to explain some tricky parts.

%

Do not use from module import * statements, even in the __init__ module of a package.

Avoid using mixins (multiple inheritance) when possible. It is often possible to use composition instead of
inheritance.

Avoid using __getattr__ and __setattr__ methods. They are often used to implement lazy initialization,
but this can be done in a more explicit way.

Setting up Development Environment

Getting started with DatalLab development is easy.

Here is what you will need:

1.

A

An integrated development environment (IDE) for Python. We recommend Spyder or Visual Studio Code, but
any IDE will do.

A Python distribution. We recommend WinPython, on Windows, or Anaconda, on Linux or Mac. But, again,
any Python distribution will do.

A clean project structure (see below).
Test data (see below).
Environment variables (see below).

Third-party software (see below).

4.4.1 Development Environment

If you are using Spyder, thank you for supporting the scientific open-source Python community!

If you are using Visual Studio Code, that’s also an excellent choice (for other reasons). We recommend installing the
following extensions:
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Extension

Description

Black Formatter

gettext

isort

Pylance

Python

reStructuredText Syntax highlighting
Ruff

Todo Tree

Python code formatter

Gettext syntax highlighting

Python import sorter

Python language server

Python extension

reStructuredText syntax highlighting
Extremely fast Python linter and code formatter
Todo tree

4.4.2 Python Environment

DatalLab requires the following :
* Python (e.g. WinPython)
* Additional Python packages

Installing all required packages :

[pip install --upgrade -r dev\requirements.txt

See Installation for more details on reference Python and Qt versions.

If you are using WinPython, thank you for supporting the scientific open-source Python community!

The following table lists the currently officially used Python distributions:

Python version Status WinPython version
3.8 OK 3.8.10.0

3.9 OK 3.9.10.0

3.10 OK 3.10.11.1

3.11 OK 3.11.5.0

3.12 OK 3.12.0.1

We strongly recommend using the . dot versions of WinPython which are lightweight and can be customized to your
needs (using pip install -r requirements.txt).

We also recommend using a dedicated WinPython instance for DatalLab.

4.4.3 Test data

Datalab test data are located in different folders, depending on their nature or origin.

Required data for unit tests are located in “cdl\data\tests” (public data).

A second folder %CDL_DATAY% (optional) may be defined for additional tests which are still under development (or

for confidential data).
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4.4.4 Specific environment variables

Enable the “debug” mode (no stdin/stdout redirection towards internal console):

@REM Mode DEBUG
set DEBUG=1

Building PDF documentation requires LaTeX. On Windows, the following environment:

@REM LaTeX executable must be in Windows PATH, for mathematical equations rendering
@REM Example with MiKTeX :
set PATH=C:\\Apps\\miktex-portable\\texmfs\\install\\miktex\\bin\\x64 ;%PATH%

Visual Studio Code configuration used in launch. json and tasks. json (examples) :

@REM Development environment

set CDL_PYTHONEXE=C:\C20IQ-DevCDL\python-3.8.10.amd64\python.exe
@REM Folder containing additional working test data

set CDL_DATA=C:\Dev\Projets\CDL_data

Visual Studio Code . env file:
* This file is used to set environment variables for the application.
* Itis used to set the PYTHONPATH environment variable to the root of the project.
* This is required to be able to import the project modules from within VS Code.

* To create this file, copy the .env.template file to . env (and eventually add your own paths).

4.4.5 Third-party Software

The following software may be required for maintaining the project:

Software Description

gettext Translations

Git Version control system
ImageMagick Image manipulation utilities
Inkscape Vector graphics editor

MikTeX LaTeX distribution on Windows

4.5 Changelog

See DatalLab roadmap page for future and past milestones.

4.5. Changelog
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4.5.1 DatalLab Version 0.11.0

New features:

* Signals and images may now be reordered in the tree view:

Using the new “Move up” and “Move down” actions in the “Edit” menu (or using the corresponding toolbar
buttons):

This fixes Issue #22 - Add “move up/down” actions in “Edit” menu, for signals/images and groups

* Signals and images may also be reordered using drag and drop:

¢ New

Signals and images can be dragged and dropped inside their own panel to change their order
Groups can also be dragged and dropped inside their panel

The feature also supports multi-selection (using the standard Ctrl and Shift modifiers), so that multiple
signals/images/groups can be moved at once, not necessarily with contiguous positions

This fixes Issue #17 - Add Drag and Drop feature to Signals/Images tree views
1D interpolation features:

Added “Interpolation” feature to signal panel’s “Processing” menu

Methods available: linear, spline, quadratic, cubic, barycentric and PCHIP
Thanks to @marcel-goldschen-ohm for the contribution to spline interpolation
This fixes Issue #20 - Add 1D interpolation features

1D resampling feature:

Added “Resampling” feature to signal panel’s “Processing” menu

Same interpolation methods as for the “Interpolation” feature

Possibility to specify the resampling step or the number of points

This fixes Issue #21 - Add 1D resampling feature

1D convolution feature:

Added “Convolution” feature to signal panel’s “Operation” menu

This fixes Issue #23 - Add 1D convolution feature

1D detrending feature:

Added “Detrending” feature to signal panel’s “Processing” menu

Methods available: linear or constant

This fixes Issue #24 - Add 1D detrending feature

* 2D computing results:

Before this release, 2D computing results such as contours, blobs, etc. were stored in image metadata
dictionary as coordinates (x0, y0, x1, y1, ...) even for circles and ellipses (i.e. the coordinates of the
bounding rectangles).

For convenience, the circle and ellipse coordinates are now stored in image metadata dictionary as (x0, y0,
radius) and (x0, yO0, a, b, theta) respectively.

These results are also shown as such in the “Results” dialog box (either at the end of the computing process
or when clicking on the “Show results” button).
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— This fixes Issue #32 - Contour detection: show circle (x, y, r) and ellipse (x, y, a, b, theta)
instead of (x0, y®, x1, x1, ...)

* 1D and 2D computing results:

— Additionnaly to the previous enhancement, more computing results are now shown in the “Results” dialog
box

— This concerns both 1D (FHWM, ...) and 2D computing results (contours, blobs, ...):
% Segment results now also show length (L) and center coordinates (Xc, Yc¢)

% Circle and ellipse results now also show area (A)

Added “Plot results” entry in “Computing” menu:
— This feature allows to plot computing results (1D or 2D)

— It creates a new signal with X and Y axes corresponding to user-defined parameters (e.g. X = indexes and
Y = radius for circle results)

* Increased default width of the object selection dialog box:

— The object selection dialog box is now wider by default, so that the full signal/image/group titles may be
more easily readable

¢ Delete metadata feature:

— Before this release, the feature was deleting all metadata, including the Regions Of Interest (ROI) metadata,
if any.

— Now a confirmation dialog box is shown to the user before deleting all metadata if the signal/image has
ROI metadata: this allows to keep the ROI metadata if needed.

» Image profile extraction feature: added support for masked images (when defining regions of interest, the areas
outside the ROIs are masked, and the profile is extracted only on the unmasked areas, or averaged on the unmasked
areas in the case of average profile extraction)

¢ Curve style: added “Reset curve styles” in “View” menu. This feature allows to reset the curve style cycle to its
initial state.

* Plugin base classe PluginBase:

— Added edit_new_signal_parameters method for showing a dialog box to edit parameters for a new
signal

— Added edit_new_image_parameters method for showing a dialog box to edit parameters for a new
image (updated the cdl_testdata.py plugin accordingly)

 Signal and image computations API (cdl.core.computations):
— Added wrappers for signal and image 1 -> 1 computations

— These wrappers aim at simplifying the creation of a basic computation function operating on Datal.ab’s
native objects (SignalObj and ImageObj) from a function operating on NumPy arrays

— This simplifies DatalLab’s internals and makes it easier to create new computing features inside plugins
— See the cdl_custom_func.py example plugin for a practical use case
* Added “Radial profile extraction” feature to image panel’s “Operation” menu:
— This feature allows to extract a radially averaged profile from an image
— The profile is extracted around a user-defined center (x0, y0)

— The center may also be computed (centroid or image center)
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¢ Automated test suite:

— Since version 0.10, DatalLab’s proxy object has a toggle_auto_refresh method to toggle the “Auto-
refresh” feature. This feature may be useful to improve performance during the execution of test scripts

— Test scenarios on signals and images are now using this feature to improve performance
* Signal and image metadata:

— Added “source” entry to the metadata dictionary, to store the source file path when importing a signal or
an image from a file

— This field is kept while processing the signal/image, in order to keep track of the source file path
Documentation:
» New Tutorial section in the documentation: this section provides a set of tutorials to learn how to use Datal.ab
* New API section in the documentation:
— This section explains how to use DatalLab as a Python library, by covering the following topics:
% How to use DatalLab algorithms on NumPy arrays
# How to use DatalLab computation features on DatalLab objects (signals and images)
* How to use DatalLab I/O features
# How to use proxy objects to control DatalLab remotely
— This section also provides a complete API reference for DatalLab objects and features

— This fixes Issue #19 - Add API documentation (data model, functions on arrays or signal/image objects,

)
Bug fixes:

e Fixed Issue #29 - Polynomial fit error: QDialog [...] argument 1 has an unexpected type
'SignalProcessor’

* Image ROI extraction feature:

— Before this release, when extracting a single circular ROI from an image with the “Extract all regions of
interest into a single image object” option enabled, the result was a single image without the ROI mask (the
ROI mask was only available when extracting ROI with the option disabled)

— This was leading to an unexpected behavior, because one could interpret the result (a square image without
the ROI mask) as the result of a single rectangular ROI

— Now, when extracting a single circular ROI from an image with the “Extract all regions of interest into a
single image object” option enabled, the result is a single image with the ROI mask (as if the option was
disabled)

— This fixes Issue #31 - Single circular ROI extraction: automatically switch to extract_single_roi func-
tion

e Computing on circular ROI:

— Before this release, when running computations on a circular ROI, the results were unexpected in terms of
coordinates (results seemed to be computed in a region located above the actual ROI).

This was due to a regression introduced in an earlier release.

Now, when defining a circular ROI and running computations on it, the results are computed on the actual
ROI

This fixes Issue #33 - Computing on circular ROI: unexpected results
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¢ Contour detection on ROI:

— Before this release, when running contour detection on a ROI, some contours were detected outside the
ROI (it may be due to a limitation of the scikit-image find_contours function).

— Now, thanks a workaround, the erroneous contours are filtered out.

— A new test module cdl.tests.features.images.contour_fabryperot_app has been added to test
the contour detection feature on a Fabry-Perot image (thanks to @emarin2642 for the contribution)

— This fixes Issue #34 - Contour detection: unexpected results outside ROI
* Computing result merging:

— Before this release, when doing a 1->N computation (sum, average, product) on a group of signals/images,
the computing results associated to each signal/image were merged into a single result, but only the type of
result present in the first signal/image was kept.

— Now, the computing results associated to each signal/image are merged into a single result, whatever the
type of result is.

¢ Fixed Issue #36 - “Delete all” action enable state is sometimes not refreshed

* Image X/Y swap: when swapping X and Y axes, the regions of interest (ROI) were not removed and not swapped
either (ROI are now removed, until we implement the swap feature, if requested)

* “Properties” group box: the “Apply” button was enabled by default, even when no property was modified, which
was confusing for the user (the “Apply” button is now disabled by default, and is enabled only when a property
is modified)

* Fixed proxy get_object method when there is no object to return (None is returned instead of an exception)

* Fixed IndexError: 1list index out of range when performing some operations or computations on
groups of signals/images (e.g. “ROI extraction”, “Peak detection”, “Resize”, etc.)

* Drag and drop from a file manager: filenames are now sorted alphabetically

4.5.2 DatalLab Version 0.10.1

Note: V0.10.0 was almost immediately replaced by V0.10.1 due to a last minute bug fix
New features:
* Features common to signals and images:
— Added “Real part” and “Imaginary part” features to “Operation” menu
— Added “Convert data type” feature to “Operation” menu
* Features added following user requests (12/18/2023 meetup @ CEA):
— Curve and image styles are now saved in the HDFS file:

# Curve style covers the following properties: color, line style, line width, marker style, marker size,
marker edge color, marker face color, etc.

% Image style covers the following properties: colormap, interpolation, etc.

% Those properties were already persistent during the working session, but were lost when saving and
reloading the HDFS file

# Now, those properties are saved in the HDFS5 file and are restored when reloading the HDFS file

— New profile extraction features for images:
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# Added “Line profile extraction” to “Operations” menu, to extract a profile from an image along a row
or a column

% Added “Average profile extraction” to “Operations” menu, to extract the average profile on a rectangular
area of an image, along a row or a column

— Image LUT range (contrast/brightness settings) is now saved in the HDFS5 file:

% As for curve and image styles, the LUT range was already persistent during the working session, but
was lost when saving and reloading the HDFS file

* Now, the LUT range is saved in the HDFS5 file and is restored when reloading it
— Added “Auto-refresh” and “Refresh manually” actions in “View” menu (and main toolbar):

% When “Auto-refresh” is enabled (default), the plot view is automatically refreshed when a signal/image
is modified, added or removed. Even though the refresh is optimized, this may lead to performance
issues when working with large datasets.

# When disabled, the plot view is not automatically refreshed. The user must manually refresh the plot
view by clicking on the ‘“Refresh manually” button in the main toolbar or by pressing the standard
refresh key (e.g. “F5”).

— Added toggle_auto_refresh method to DatalLab proxy object:

# This method allows to toggle the “Auto-refresh” feature from a macro-command, a plugin or a remote
control client.

% A context manager context_no_refresh is also available to temporarily disable the “Auto-refresh”
feature from a macro-command, a plugin or a remote control client. Typical usage:

with proxy.context_no_refresh():
# Do something without refreshing the plot view
proxy.compute_£fft() # (...)

— Improved curve readability:
# Until this release, the curve style was automatically set by cycling through PlotPy predefined styles

% However, some styles are not suitable for curve readability (e.g. “cyan” and “yellow” colors are not
readable on a white background, especially when combined with a “dashed” line style)

* This release introduces a new curve style management with colors which are distinguishable and ac-
cessible, even to color vision deficiency people

* Added “Curve anti-aliasing” feature to “View” menu (and toolbar):
— This feature allows to enable/disable curve anti-aliasing (default: enabled)

— When enabled, the curve rendering is smoother but may lead to performance issues when working with
large datasets (that’s why it can be disabled)

* Added toggle_show_titles method to DataLab proxy object. This method allows to toggle the “Show graph-
ical object titles” feature from a macro-command, a plugin or a remote control client.

* Remote client is now checking the server version and shows a warning message if the server version may not be
fully compatible with the client version.

Bug fixes:
* Image contour detection feature (“Computing” menu):

— The contour detection feature was not taking into account the “shape” parameter (circle, ellipse, polygon)
when computing the contours. The parameter was stored but really used only when calling the feature a
second time.
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— This unintentional behavior led to an AssertionError when choosing “polygon” as the contour shape
and trying to compute the contours for the first time.

— This is now fixed (see Issue #9 - Image contour detection: AssertionError when choosing “polygon” as
the contour shape)

* Keyboard shortcuts:

— The keyboard shortcuts for “New”, “Open”, “Save”, “Duplicate”, “Remove”, “Delete all” and “Refresh
manually” actions were not working properly.

— Those shortcuts were specific to each signal/image panel, and were working only when the panel on which
the shortcut was pressed for the first time was active (when activated from another panel, the shortcut was
not working and a warning message was displayed in the console, e.g. QAction::event: Ambiguous
shortcut overload: Ctrl+(C)

— Besides, the shortcuts were not working at startup (when no panel had focus).

— This is now fixed: the shortcuts are now working whatever the active panel is, and even at startup
(see Issue #10 - Keyboard shortcuts not working properly: QAction: :event: Ambiguous shortcut
overload: Ctrl+C)

» “Show graphical object titles” and “Auto-refresh” actions were not working properly:

— The “Show graphical object titles” and “Auto-refresh” actions were only working on the active signal/image
panel, and not on all panels.

— This is now fixed (see Issue #11 - “Show graphical object titles” and “Auto-refresh” actions were working
only on current signal/image panel)

* Fixed Issue #14 - Saving/Reopening HDF5 project without cleaning-up leads to ValueError
* Fixed Issue #15 - MacOS: 1. pip install cdl error - 2. Missing menus:

— Part 1: pip install cdl error on MacOS was actually an issue from PlotPy (see this issue), and has
been fixed in PlotPy v2.0.3 with an additional compilation flag indicating to use C++11 standard

— Part 2: Missing menus on MacOS was due to a PyQt/MacOS bug regarding dynamic menus

* HDF5 file format: when importing an HDF5 dataset as a signal or an image, the dataset attributes were sys-
tematically copied to signal/image metadata: we now only copy the attributes which match standard data types
(integers, floats, strings) to avoid errors when serializing/deserializing the signal/image object

* Installation/configuration viewer: improved readability (removed syntax highlighting)

* Pylnstaller specification file: added missing skimage data files manually in order to continue supporting Python
3.8 (see Issue #12 - Stand-alone version on Windows 7: missing api-ms-win-core-path-11-1-0.d11)

¢ Fixed Issue #13 - ArchLinux: gt.gpa.plugin: Could not load the Qt platform plugin "xcb" in
"" even though it was found

4.5.3 DatalLab Version 0.9.2

Bug fixes:

* Region of interest (ROI) extraction feature for images:

— ROl extraction was not working properly when the “Extract all regions of interest into a single image object”
option was enabled if there was only one defined ROI. The result was an image positioned at the origin (0,
0) instead of the expected position (x0, y0) and the ROI rectangle itself was not removed as expected. This
is now fixed (see Issue #6 - ‘Extract multiple ROI” feature: unexpected result for a single ROI)
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— ROI rectangles with negative coordinates were not properly handled: ROI extraction was raising a
ValueError exception, and the image mask was not displayed properly. This is now fixed (see Issue
#7 - Image ROI extraction: ValueError: zero-size array to reduction operation minimum
which has no identity)

— ROI extraction was not taking into account the pixel size (dx, dy) and the origin (x0, y0) of the image. This
is now fixed (see Issue #8 - Image ROI extraction: take into account pixel size)

* Macro-command console is now read-only:

— The macro-command panel Python console is currently not supporting standard input stream (stdin) and
this is intended (at least for now)

— Set Python console read-only to avoid confusion

4.5.4 Datalab Version 0.9.1

Bug fixes:
¢ French translation is not available on Windows/Stand alone version:

— Locale was not properly detected on Windows for stand-alone version (frozen with pyinstaller) due to
an issue with locale.getlocale() (function returning None instead of the expected locale on frozen
applications)

— This is ultimately a pyinstaller issue, but a workaround has been implemented in guidata V3.2.2 (see
guidata issue #68 - Windows: gettext translation is not working on frozen applications)

— Issue #2 - French translation is not available on Windows Stand alone version
» Saving image to JPEG2000 fails for non integer data:
— JPEG2000 encoder does not support non integer data or signed integer data

— Before, DatalLab was showing an error message when trying to save incompatible data to JPEG2000: this
was not a consistent behavior with other standard image formats (e.g. PNG, JPG, etc.) for which DatalLab
was automatically converting data to the appropriate format (8-bit unsigned integer)

— Current behavior is now consistent with other standard image formats: when saving to JPEG2000, DataLab
automatically converts data to 8-bit unsigned integer or 16-bit unsigned integer (depending on the original
data type)

— Issue #3 - Save image to JPEG2000: ‘OSError: encoder error -2 when writing image file’

* Windows stand-alone version shortcuts not showing in current user start menu:

When installing Datal.ab on Windows from a non-administrator account, the shortcuts were not showing
in the current user start menu but in the administrator start menu instead (due to the elevated privileges of
the installer and the fact that the installer does not support installing shortcuts for all users)

— Now, the installer does not ask for elevated privileges anymore, and shortcuts are installed in the current
user start menu (this also means that the current user must have write access to the installation directory)

— In future releases, the installer will support installing shortcuts for all users if there is a demand for it (see
Issue #5)

— Issue #4 - Windows: stand-alone version shortcuts not showing in current user start menu
* Installation and configuration window for stand-alone version:
— Do not show ambiguous error message ‘Invalid dependencies’ anymore

— Dependencies are supposed to be checked when building the stand-alone version
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¢ Added PDF documentation to stand-alone version:
— The PDF documentation was missing in previous release

— Now, the PDF documentation (in English and French) is included in the stand-alone version

4.5.5 DatalLab Version 0.9.0

New dependencies:
» Datal.ab is now powered by PlotPyStack:
— PythonQwt
— guidata
— PlotPy
* opencv-python (algorithms for image processing)
New reference platform:
 DatalLab is validated on Windows 11 with Python 3.11 and PyQt 5.15

* Datalab is also compatible with other OS (Linux, MacOS) and other Python-Qt bindings and versions (Python
3.8-3.12, PyQt6, PySide6)

New features:
 Datal.ab is a platform:
— Added support for plugins
% Custom processing features available in the “Plugins” menu
% Custom I/O features: new file formats can be added to the standard I/O features for signals and images
% Custom HDFS5 features: new HDFS file formats can be added to the standard HDF5 import feature
* More features to come. ..

— Added remote control feature: DatalLab can be controlled remotely via a TCP/IP connection (see Remote
control)

— Added macro commands: DatalLab can be controlled via a macro file (see Macro commands)
* General features:
— Added settings dialog box (see “Settings” entry in “File” menu):
% General settings
% Visualization settings
% Processing settings
% Etc.

— New default layout: signal/image panels are on the right side of the main window, visualization panels are
on the left side with a vertical toolbar

 Signal/Image features:

— Added process isolation: each signal/image is processed in a separate process, so that DatalL.ab does not
freeze anymore when processing large signals/images

— Added support for groups: signals and images can be grouped together, and operations can be applied to
all objects in a group, or between groups
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— Added warning and error dialogs with detailed traceback links to the source code (warnings may be op-
tionally ignored)

— Drastically improved performance when selecting objects

— Optimized performance when showing large images

— Added support for dropping files on signal/image panel

— Added “Computing parameters” group box to show last result input parameters
— Added “Copy titles to clipboard” feature in “Edit” menu

— For every single processing feature (operation, processing and computing menus), the entered parameters
(dialog boxes) are stored in cache to be used as defaults the next time the feature is used

 Signal processing:
— Added support for optional FFT shift (see Settings dialog box)

* Image processing:

Added pixel binning operation (X/Y binning factors, operation: sum, mean, ...)

Added “Distribute on a grid” and “Reset image positions” in operation menu

Added Butterworth filter

Added exposure processing features:
# Gamma correction
% Logarithmic correction

% Sigmoid correction

Added restoration processing features:
% Total variation denoising filter (TV Chambolle)
* Bilateral filter (denoising)
% Wavelet denoising filter

# White Top-Hat denoising filter

Added morphological transforms (disk footprint):
% White Top-Hat
% Black Top-Hat
% Erosion
% Dilation
% Opening
% Closing
— Added edge detection features:
* Roberts filter
% Prewitt filter (vertical, horizontal, both)
* Sobel filter (vertical, horizontal, both)
% Scharr filter (vertical, horizontal, both)

% Farid filter (vertical, horizontal, both)
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% Laplace filter

% Canny filter
— Contour detection: added support for polygonal contours (in addition to circle and ellipse contours)
— Added circle Hough transform (circle detection)
— Added image intensity levels rescaling
— Added histogram equalization
— Added adaptative histogram equalization
— Added blob detection methods:

# Difference of Gaussian

% Determinant of Hessian method

* Laplacian of Gaussian

# Blob detection using OpenCV

— Result shapes and annotations are now transformed (instead of removed) when executing one of the follow-
ing operations:

* Rotation (arbitrary angle, +90°, -90°)

% Symetry (vertical/horizontal)

Added support for optional FFT shift (see Settings dialog box)

* Console: added configurable external editor (default: VSCode) to follow the traceback links to the source code

Note: DatalLab was created by Codra/Pierre Raybaut in 2023. It is developed and maintained by DatalLab open-source
project team with the support of Codra.
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